
致尊敬的顾客

关于产品目录等资料中的旧公司名称

        NEC电子公司与株式会社瑞萨科技于2010年4月1日进行业务整合（合并），整合后的

新公司暨“瑞萨电子公司”继承两家公司的所有业务。因此，本资料中虽还保留有旧公司

名称等标识，但是并不妨碍本资料的有效性，敬请谅解。

瑞萨电子公司网址：http://www.renesas.com

2010年4月1日
瑞萨电子公司

【业务咨询】http://www.renesas.com/inquiry

【发行】瑞萨电子公司（http://www.renesas.com）



Notice 
1. All information included in this document is current as of the date this document is issued. Such information, however, is 

subject to change without any prior notice. Before purchasing or using any Renesas Electronics products listed herein, please 
confirm the latest product information with a Renesas Electronics sales office. Also, please pay regular and careful attention to 
additional and different information to be disclosed by Renesas Electronics such as that disclosed through our website. 

2. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights 
of third parties by or arising from the use of Renesas Electronics products or technical information described in this document.  
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights 
of Renesas Electronics or others. 

3. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part. 
4. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of 

semiconductor products and application examples.  You are fully responsible for the incorporation of these circuits, software, 
and information in the design of your equipment.  Renesas Electronics assumes no responsibility for any losses incurred by 
you or third parties arising from the use of these circuits, software, or information. 

5. When exporting the products or technology described in this document, you should comply with the applicable export control 
laws and regulations and follow the procedures required by such laws and regulations.  You should not use Renesas 
Electronics products or the technology described in this document for any purpose relating to military applications or use by 
the military, including but not limited to the development of weapons of mass destruction.  Renesas Electronics products and 
technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited 
under any applicable domestic or foreign laws or regulations. 

6. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics 
does not warrant that such information is error free.  Renesas Electronics assumes no liability whatsoever for any damages 
incurred by you resulting from errors in or omissions from the information included herein. 

7. Renesas Electronics products are classified according to the following three quality grades:  “Standard”, “High Quality”, and 
“Specific”.  The recommended applications for each Renesas Electronics product depends on the product’s quality grade, as 
indicated below.  You must check the quality grade of each Renesas Electronics product before using it in a particular 
application.  You may not use any Renesas Electronics product for any application categorized as “Specific” without the prior 
written consent of Renesas Electronics.  Further, you may not use any Renesas Electronics product for any application for 
which it is not intended without the prior written consent of Renesas Electronics.  Renesas Electronics shall not be in any way 
liable for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for an 
application categorized as “Specific” or for which the product is not intended where you have failed to obtain the prior written 
consent of Renesas Electronics.  The quality grade of each Renesas Electronics product is “Standard” unless otherwise 
expressly specified in a Renesas Electronics data sheets or data books, etc. 

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual 
equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial robots. 

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-
crime systems; safety equipment; and medical equipment not specifically designed for life support. 

“Specific”:  Aircraft; aerospace equipment; submersible repeaters; nuclear reactor control systems; medical equipment or 
systems for life support (e.g. artificial life support devices or systems), surgical implantations, or healthcare 
intervention (e.g. excision, etc.), and any other applications or purposes that pose a direct threat to human life. 

8. You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics, 
especially with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation 
characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or 
damages arising out of the use of Renesas Electronics products beyond such specified ranges. 

9. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have 
specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further, 
Renesas Electronics products are not subject to radiation resistance design.  Please be sure to implement safety measures to 
guard them against the possibility of physical injury, and injury or damage caused by fire in the event of the failure of a 
Renesas Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire 
control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures.  Because 
the evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or system 
manufactured by you. 

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental 
compatibility of each Renesas Electronics product.  Please use Renesas Electronics products in compliance with all applicable 
laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS 
Directive.  Renesas Electronics assumes no liability for damages or losses occurring as a result of your noncompliance with 
applicable laws and regulations. 

11. This document may not be reproduced or duplicated, in any form, in whole or in part, without prior written consent of Renesas 
Electronics. 

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this 
document or Renesas Electronics products, or if you have any other inquiries. 

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its majority-
owned subsidiaries. 

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics. 
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Notes regarding these materials

1.   This document is provided for reference purposes only so that Renesas customers may select the appropriate
      Renesas products for their use. Renesas neither makes warranties or representations with respect to the
      accuracy or completeness of the information contained in this document nor grants any license to any 
      intellectual property rights or any other rights of Renesas or any third party with respect to the information in 
      this document. 
2.   Renesas shall have no liability  for damages or infringement of any intellectual property or other rights arising 
      out of the use of any information in this document, including, but not limited to, product data, diagrams, charts, 
      programs, algorithms, and application circuit examples.
3.   You should not use the products or the technology described in this document for the purpose of military
      applications such as the development of weapons of mass destruction or for the purpose of any other military 
      use. When exporting the products or technology described herein, you should follow the applicable export 
      control laws and regulations, and procedures required by such laws and regulations.
4.   All information included in this document such as product data, diagrams, charts, programs, algorithms, and 
      application circuit examples, is current as of the date this document is issued. Such information, however,  is 
      subject to change without any prior notice. Before purchasing or using any Renesas products listed in this 
      document, please confirm the latest product information  with a Renesas sales office. Also, please pay regular 
      and careful attention to additional and different information to be disclosed by Renesas such as that disclosed 
      through our website. (http://www.renesas.com )
5.   Renesas has used reasonable care in compiling the information included in this document, but Renesas 
      assumes no liability whatsoever for any damages incurred as a result of errors or omissions in the information 
      included in this document.
6.   When using or otherwise relying on the information in this document, you should evaluate the information in 
      light of the total system before deciding about the applicability of such information to the intended application.
      Renesas makes no representations, warranties or guaranties regarding the suitability of its products for any 
      particular application and specifically disclaims any liability arising out of the application and use of the 
      information in this document or Renesas products.
7.   With the exception of products specified by Renesas as suitable for automobile applications, Renesas 
      products are not designed, manufactured or tested for applications or otherwise in systems the failure or 
      malfunction of which may cause a direct threat to human life or create a risk of human injury or which require 
      especially high quality and reliability such as safety systems, or equipment or systems for transportation and 
      traffic, healthcare, combustion control, aerospace and aeronautics, nuclear power, or undersea communication 
      transmission. If you are considering the use of our products for such purposes, please contact a Renesas 
      sales office beforehand. Renesas shall have no liability for damages arising out of the uses set forth above.
8.   Notwithstanding the preceding paragraph, you should not use Renesas products for the purposes listed below:
        (1) artificial life support devices or systems
        (2) surgical implantations
        (3) healthcare intervention (e.g., excision, administration of medication, etc.)
        (4) any other purposes that pose a direct threat to human life
      Renesas shall have no liability for damages arising out of the uses set forth in the above and purchasers who
      elect to use Renesas products in any of the foregoing applications shall indemnify and hold harmless Renesas 
      Technology Corp., its affiliated companies and their officers, directors, and employees against any and all 
      damages arising out of such applications. 
9.   You should use the products described herein within the range specified by Renesas, especially with respect 
      to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation 
      characteristics, installation and other product characteristics. Renesas shall have no liability for malfunctions or 
      damages arising out of the use of Renesas products beyond such specified ranges.
10. Although Renesas endeavors to improve the quality and reliability of its products, IC products have specific 
      characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use 
      conditions. Please be sure to implement safety measures to guard against the possibility of physical injury, and 
      injury or damage caused by fire in the event of the failure of a Renesas product, such as safety design for 
      hardware and software including but not limited to redundancy, fire control and malfunction prevention, 
      appropriate treatment for aging degradation or any other applicable measures.  Among others, since the 
      evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or
      system manufactured by you.
11. In case Renesas products listed in this document are detached from the products to which the Renesas 
      products are attached or affixed, the risk of accident such as swallowing by infants and small children is very 
      high. You should implement safety measures so that Renesas products may not be easily detached from your 
      products. Renesas shall have no liability for damages arising out of such detachment.
12. This document may not be reproduced or duplicated, in any form, in  whole or in part, without prior written 
      approval from Renesas. 
13. Please contact a Renesas sales office if you have any questions regarding the information contained in this
      document, Renesas semiconductor products, or if you have any other inquiries.
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重要事项

用前必读

· 使用本仿真器产品前，请先阅读本用户手册。

· 请保管好本用户手册，以供将来参考。

未完全理解本仿真器产品的运行原理前，请勿尝试使用。

仿真器产品：

本文档所述之 “仿真器产品”仅指瑞萨科技公司和瑞萨解决方案公司生产的下列产品，所有附属产品均
不包括在内。

· E200F 主部件

· 外部总线跟踪单元

· EV 芯片单元

· 扩展剖析单元

· 仿真存储单元

· 用户系统接口板

· 跟踪电缆

“仿真器产品”不包含用户系统或主机。

仿真器产品的使用目的：

本仿真器产品是瑞萨单片机 SH-2A、 SH-2 系列 （下文称作 SH-2A、 SH-2）系统软硬件开发工具。本仿真
器产品不可用于除此之外的其他目的。

使用限制：

本仿真器产品不可用于运输、车辆、医疗 （涉及生命安全的情况）、航空航天、原子能控制或海底转播中
继等用途。买家如欲将本仿真器产品用于上述用途，则须事先通知瑞萨科技公司、瑞萨解决方案公司或经过授
权的瑞萨科技产品经销商。

产品改进政策：

瑞萨科技公司 （包括其下属机构，以下统称为 “瑞萨”）将不断改进本仿真器产品的设计、性能和安全
性。瑞萨有权随时完全或部分修改规格、设计、用户手册及其他文档，恕不另行通知。

本仿真器产品的目标用户：

使用本仿真器产品的用户必须仔细阅读并完全理解本用户手册中的信息和限制。未完全理解本仿真器产品
的运行原理前，请勿尝试使用。

强烈建议首次使用本仿真器产品的用户在资深用户的指导下进行操作。

用户需了解电子电路、逻辑电路以及单片机的基础知识。



产品使用注意事项：

1. 本仿真器是在程序开发和评估阶段使用的开发支持装置。批量生产所开发的程序时，用户必须事先进行全
面测试、评估或其他试验，以自行判断该程序是否适用。

2. 瑞萨解决方案公司不对使用本仿真器产生的任何后果负责。

3. 如有产品缺陷，瑞萨解决方案公司将努力改进产品或提供有偿或无偿的解决办法。但瑞萨解决方案公司不
保证在所有情况下都能改进产品或提供解决办法。

4. 本仿真器是为在实验室进行的程序开发和评估而设计的。因此，在日本使用时，本产品不在电气设备及材
料安全法 (Electrical Appliance and Material Safety Law) 管辖范围之内，也不保证能防电磁干扰。

5. 本仿真器没有严格遵守 UL 或 IEC 等安全标准。在将本产品带往别国时，请注意这一点。

6. 瑞萨无法预测可能造成危险的所有情况，因此，本用户手册和仿真器上的警告内容未包含所有危险情况。
请客户安全使用本仿真器产品，一切后果将由您自行承担。



联邦法规：

一些州或国家 / 地区不允许排除或限制默示担保或承担偶然或接二连三的损害，因此，上述限制或排除条

款可能对您不适用。本担保赋予您特定的法律权利，而您也可能拥有其他权利，不过会因所处的国家 / 地区或

州份不同而有所不同。

担保无效：

如因误用、滥用、不当用途、疏忽、操作不当、未经瑞萨事先书面许可即安装、修理或修改本仿真器产品

而引起任何问题，或因用户系统而引起任何问题，则瑞萨不承担任何与法律相关和无关的责任。

保留所有权利：

1. 本手册中的电路及其他示例仅用于说明瑞萨半导体产品的特性和性能。如果基于这些示例的应用引起任何

知识产权侵害或其他问题，瑞萨不承担任何责任。

2. 不以暗示或其他方式授予瑞萨或任何第三方的任何专利权或其他权利。

3. 本用户手册和仿真器产品享有著作权保护，瑞萨保留所有权利。未经瑞萨公司事先书面同意，不得以任何

形式复印或复制本用户手册的部分或全部内容，无论是复印件形式、机器可读形式或其他任何可能的方式

均不例外。

关于图：

本用户手册中的某些图可能与实物不同。

有限担保

瑞萨保证所生产的仿真器产品符合公布的规格，并保证所用材料和 / 或制造工艺

无任何缺陷。对于原样退回工厂，且运费已付的任意仿真器产品，经瑞萨检测确实存

在材料和 / 或制造工艺缺陷时，瑞萨将在其权力范围内更换该产品。这是违反瑞萨担

保条款的唯一补救措施。有关担保期限的详细信息，请参阅瑞萨担保手册。此担保条

款仅限于产品最初买家。不包括此后从您手中购买本仿真器产品的任何人。瑞萨不对

第三方或您代表第三方提出的任何索赔负责。

免责声明

除此申明外，瑞萨未做出任何明示或默示、口头或书面的担保，包括但不仅限于

有关销路、适销性、特定目的或用途的适用性，或侵犯任何专利权的担保。若因使用

有缺陷的仿真器产品、任何与仿真器相关产品或其文档而引起任何直接、间接、偶然

或者基于某种性质接二连三造成的损害及其相关费用，瑞萨一概不负责，即使瑞萨已

被告知有可能存在此类损失也不例外。除非在此担保中明确说明，否则此仿真器产品

按“原样”销售，您必须自行承担所有使用风险和本仿真器产品带来的后果。



安全事项

用前必读

· 使用本仿真器产品前，请先阅读本用户手册。

· 请保管好本用户手册，以供将来参考。

未完全理解本仿真器产品的运行原理前，请勿尝试使用。

图标的定义

用户手册或产品上的图标用于确保用户正确操作本产品，防止对您或他人造成伤害，或对您的财产造成损
失。本页介绍这些图像符号及其含义。使用本产品前，请务必阅读本章。

    这是安全警告符号。用于提醒您可能会造成人身伤害之危险。为避

免可能发生的伤害或死亡，必须完全根据此符号后的安全信息进行

操作。

    危险表示“如不避免则可能导致死亡或重伤的紧急危险情况”。

     警告表示“如不避免则可能导致死亡或重伤的潜在危险情况”。

    注意表示“如不避免则可能导致轻度或中度伤害的潜在危险情况”。

       不带安全警告符号的注意表示“如不避免则可能导致财产损失的潜在危险
情况”。

注意强调一些基本信息。

除上述四种符号外，本手册还会根据需要使用下列符号。



表示警告或注意。

示例：电击警告

表示禁止

示例：禁止拆卸

表示用力

示例：从插座上拔下电源电缆



有关 AC 电源的警告事项：

• 如果附送的 AC 电源电缆与插座不匹配，请勿改装 AC 电源电缆或强行插入。
   否则可能遭到电击和 / 或引发火灾。

• 请使用符合所在国家 / 地区安全标准的 AC 电源线。

• 请勿用湿手触摸 AC 电源线的插头。否则可能遭到电击。

• 本产品的信号接地与机架接地相连。若正在开发的产品不带变压器（不带 
AC 电源隔离变压器），则可能导致电击伤害。此外，还可能对本产品和您
正在开发的产品造成无可挽回的损害。

开发时，请使用隔离变压器将产品的 AC 电源连接到商用电源，以避免上述
危险。

• 如果有其他装置与本产品连接到同一线路，请注意勿使电路过载。有关电气
规格的信息，请参阅产品铭牌

• 安装本装置时，请务必使其正确接地。

•  如果闻到异味、听到异响或看到本产品冒烟，请立即从插座上拔下 AC 电源

   电缆，以断开电源。

这时存在电击和 / 或引发火灾的危险，请勿继续使用。如遭遇此情形，请联
系当地经销商。

• 安装本产品或将其连接至其他装置时，请关闭 AC 电源或断开装置的 AC 电
  源线连接，以避免造成人身伤害或装置损坏。

有关本产品的警告事项：

• 请勿拆卸或修改本产品。如果拆卸和修改本产品，则可能因电击而造成人身
   伤害。

• 请确保勿使任何物质 （特别是液体、金属物体或易燃物）落入产品顶部面
   板上的散热风扇内。

安装警告：

• 请勿将本产品安装在水中或高湿度区域。请确保勿使本产品受潮。如果水
   或某些其他液体溅入本产品，则可能导致无可挽回的损害。

有关使用环境的警告事项：

• 本装置可在最高 35 ºC 的环境温度下使用。请勿在超过该温度的环境中使用。



AC 适配器注意事项：

• 仅使用本产品包装内附送的 AC 适配器。

• 附送的 AC 适配器供该仿真器专用。请勿将其用于其他产品。

• 附送的 AC 适配器的 DC 插头有以下极性。

• 附送的 AC 适配器不带电源开关。连接 AC 电源电缆后，电源适配器一直处
于供电状态。

有关本产品的注意事项：

• 使用本产品的注意事项。请注意勿使本产品遭受机械震动。

• 拔下主部件时，切勿拉拽仿真器的探针或连接在本产品上的软性电缆。如果
过度弯折或过于用力地拉拽将本产品连接至仿真器探针的软性电缆，则可能
导致连接器损坏。

安装注意事项：

• 使用仿真器时请勿将其侧立。



产品介绍

高性能嵌入式工作区 （High-performance Embedded Workshop，简称 HEW）是一种高性能开发环境，专为
瑞萨单片机开发嵌入式应用程序。主要功能有：

• 可配置的创建引擎，让您能够通过简单易用的界面设置编译器、汇编器和连接器选项。

• 集成文本编辑器，用户可自定义语法着色，从而改善代码的可读性。

• 可配置环境，能够运行您自己的工具。

• 集成调试器，可让您在同一应用程序中进行创建和调试。

• 版本控制支持。

HEW 的主要设计目标有二：一是为用户提供一组高性能开发工具；二是使这些工具具备统一且简单的使
用方式。



关于本手册

本手册说明使用仿真器前的准备工作、仿真器的功能、仿真器特有的调试功能、教程及仿真器的软硬件
规格。

要详细了解 HEW 的基本用法、环境自定义、创建功能及各种 HEW 产品均具备的调试功能，请参阅 HEW 
用户手册。

本手册的目的不在于说明 C/C++ 语言或汇编语言的编程方法、特定操作系统的使用方法以及适合于各种设
备的编程方法。有关这些内容，请参阅相关手册。

Microsoft® 和 Windows® 是 Microsoft Corporation 的注册商标。

Visual SourceSafe 是 Microsoft Corporation 的商标。

IBM 是 International Business Machines Corporation 的注册商标。

本手册中使用的所有品牌或产品名称均为其各自所有者的商标或注册商标。

文档惯例

本手册使用下列印刷规范：

表 1   印刷规范

规范 含义

[Menu->Menu Option] “->”表示菜单选项（例如 [File->Save As...]）。

FILENAME.C 大写字母的名称表示文件名。

“输入该字符串” 表示必须输入的文本（不包括 “”）。

Key + Key 表示需要按下的键。例如， CTRL+N 表示按 CTRL 键
并在按住 CTRL 键的同时按 N 键。

（“操作方法”符号） 该符号通常位于页面左侧。表示其右侧文本为某种操作方法。
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第 1 章 产品概要

高性能嵌入式工作区 （High-performance Embedded Workshop，简称 HEW）是一种图形用户界面，使用它
可以轻松开发和调试以 C/C++ 编程语言和汇编语言编写的瑞萨单片机应用程序。它旨在提供一种高性能且直观
的方式来存取、测量和修改运行应用程序的调试平台。

E200F 仿真器 （下文统称为仿真器）是瑞萨单片机应用系统的软硬件开发支持工具。

仿真器主部件壳体通过专用调试接口与用户系统相连。此系统能够符合实际应用的条件来调试用户系统。
仿真器可实现调试功能；用于控制仿真器的主机必须是具有 USB 1.1/2.0 的 IBM PC 兼容机。

图 1.1 显示使用仿真器的系统配置。

图 1.1   使用仿真器的系统配置

注意：H-UDI 是一种与 JTAG (Joint Test Action Group) 规格兼容的接口。

仿真器具备下列功能：

· 各种调试功能

— 进行高效调试的各种暂停和跟踪功能。可通过特定窗口设置断点和暂停条件，并在窗口中显示跟

踪信息。此外，提供性能和剖析功能等各种仿真功能。

— 支持 USB 2.0，实现高速下载。

— 各个调试阶段均可更改仿真器功能。

— 可使用各种命令行功能。

· 实时仿真

可对 CPU 处于最高工作频率时的用户系统进行实时仿真。

· 优良的操作性

在 Microsoft® Windows® 2000 和 Microsoft® Windows® XP 操作系统上使用 HEW 时，可使用鼠标等点
击器件调试用户程序。 HEW 能够高速下载装入模块文件。
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· 在最后开发阶段调试用户系统

能够在与实际应用条件类似的条件下调试用户系统。

· 简洁调试环境

使用仿真器时，可将笔记本电子计算机用作主机，随时随地搭建调试环境。

1. 仿真器拆箱后，请对照部件列表检查所有部件。

2. 切勿在包装上放置重物。

3. 切勿使仿真器遭受碰撞或重压。有关详细信息，请参阅第 1.4 节 “环境条件”。

4. 请小心移动主机或用户系统，勿使其震动，以免损坏。

5. 连接电缆后，请检查连接是否正确。有关详细信息，请参阅第 2 章 “设置仿真器”。

6. 连接所有电缆后，为连接的仿真器通电。开启电源后，切勿连接或拔掉电缆。

1.1 部件

拆箱检查所有部件。有关仿真器部件的详细信息，请参阅补充文件 “有关使用 SHxxxx 的补充信息”的
第 1.1 节。如缺少部件，请联系瑞萨营业部。

1.2 仿真器硬件配置

仿真器包含主部件壳体、外部总线跟踪单元（可选）、仿真存储器单元（可选）、 EV 芯片单元（可选）、
扩展剖析单元（可选）、USB 电缆、AC 适配器和外部探头，如图 1.2 所示。仿真器通过 USB 2.0 与主机相连。

图 1.2   仿真器硬件配置

使用仿真器产品前，请阅读下列警告。操作不当会损坏用户系统和仿真器产品。用户程序将丢失。
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仿真器各部分名称说明如下。

仿真器前视图：

图 1.3   仿真器前视图

(a) 电源指示灯： 标志为“PWR”。仿真器通电后，该指示灯亮起。

(b) 运行指示灯： 标志为“RUN”。用户程序处于运行状态时，该指示灯亮起。

(c) 操作指示灯： 标志为“ACT”。仿真器处于运行状态时，该指示灯亮起。
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仿真器后视图：

图 1.4   仿真器后视图

(a) 电源开关： 标志为“POWER”。将该开关调到 I （通电）时开启仿真器；将该开关调到 O （断电）
时关闭仿真器。

(b) DC 插头： 标志为“DC IN”。此为 AC 适配器的输入 DC (+12 V) 连接器。请务必使用该插头连
接附送的 AC 适配器。

(c) 外部探针连接器： 标志为“EXT”。此为外部探针连接器。请务必使用该连接器连接附送的外部探针。

(d) 主机端连接器
（USB 连接器）：

标志为“ ”。主机连接器（USB 连接器）位于该标志旁边。请务必使用该连接
器连接附送的 USB 电缆。
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仿真器右视图：

图 1.5   仿真器右视图

(a) E200F 标志板： 仿真器专用的酒红色薄板 (R0E0200F1EMU00)，可轻易地与 E200F 主部件壳体的其
他部位区分开来。

(b) 分析器单元连接器： 标志为“ANALYZER I/F”。此为分析器单元连接器。请务必使用该连接器连接附送的
专用于分析器单元（可选）的分析器电缆。

(c) 外部总线跟踪单元连接器： 标志为“TRACE I/F”。此为外部总线跟踪单元连接器。请务必使用该连接器连接附送
的专用于外部总线跟踪单元（可选）的跟踪电缆。
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仿真器左视图：

图 1.6   仿真器左视图

(a) 产品管理标签： 记录仿真器的序列号、修订号和安全标准等信息。这些内容随产品购买时间的不同而
有所不同。
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探头顶视图：

图 1.7   探头顶视图

(a) 固定探头的螺钉： 这些螺钉用于固定用户系统和探头。
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探头前视图：

图 1.8   探头前视图

(a) 用户系统 H-UDI 端口连接器： 将仿真器用作 on-chip 调试器时，需使用该连接器（与 36 引脚的 E10A-USB 仿真器
相同）。
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存放探头：

图 1.9   存放探头

(a) 用于垂直放置仿真器的底座单元： 垂直放置仿真器的底座单元。仿真器不使用时，可用于存放探头。
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EV 芯片单元 （可选）顶视图：

图 1.10   EV 芯片单元 （可选）顶视图

(a) 外部总线跟踪单元连接器 1： 用于连接外部总线跟踪单元的连接器。仅使用 EV 芯片时，连接可选的跟踪电缆。

(b) 外部总线跟踪单元连接器 2： 用于连接外部总线跟踪单元的连接器。仅使用 EV 芯片时，不使用这些连接器。

(c) 探头连接器 2： 用于连接探头的连接器。
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EV 芯片单元 （可选）底视图：

图 1.11   EV 芯片单元 （可选）底视图

(a) 用户系统接口连接器： 用户系统接口连接器。这些连接器连接到用户系统接口板，该接口板支持用户系
统上的一组连接器或专用连接器。
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外部总线跟踪单元 （可选）顶视图：

图 1.12   外部总线跟踪单元 （可选）顶视图

(a) 跟踪电缆连接器： 用于连接外部总线跟踪单元跟踪电缆的连接器。请务必使用可选的跟踪电缆。
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外部总线跟踪单元 （可选）底视图：

图 1.13   外部总线跟踪单元 （可选）底视图

(a) 用于外部总线跟踪的用户系统接口
连接器：

用于外部总线跟踪的用户系统接口连接器。这些连接器连接到 EV 芯片单元或用
户系统上的专用连接器。

(b) EV 芯片单元接口连接器： EV 芯片单元接口连接器。这些连接器连接到 EV 芯片单元上的专用连接器。



SH-2A、 SH-2 E200F 仿真器 第 1 章   产品概要

Rev.1.00  2007.09.21  Page 14 of 279
RCJ10J0048-0100

仿真存储器单元 （可选）底视图：

图 1.14   仿真存储器单元 （可选）底视图

(a) 扩展剖析单元上的可选连接器： 用于连接扩展剖析单元和主部件壳体的接口连接器。这些连接器连接到主部件壳
体上的可选连接器。
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仿真器顶视图：

图 1.15   仿真器顶视图

注意：仿真存储器单元有两种类型：R0E0200F1MSR00 (8 MB) 和 R0E0200F1MSR01 (16 MB)。本手册以 
16-MB 仿真存储器单元为例进行说明。

(a) 外部总线跟踪单元连接器 1 [CN1]： 用于连接外部总线跟踪单元的连接器。不使用外部总线跟踪单元时，可连接可选
的跟踪电缆。

(b) 外部总线跟踪单元连接器 2 [CN4]： 用于连接外部总线跟踪单元的连接器。不使用外部跟踪单元时，则不使用这些连
接器。
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仿真存储器单元 （可选）底视图：

图 1.16   仿真存储器单元 （可选）底视图

(a) EV 芯片单元接口连接器 [CN2]： 用于连接 EV 芯片单元的连接器。这些连接器连接到 EV 芯片单元上的专用连
接器。

(b) 用于外部总线跟踪的用户系统接口
连接器 [CN5]：

用于外部总线跟踪的用户系统连接器。这些连接器连接到 EV 芯片单元或用户系
统上安装的专用连接器。
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1.3 仿真器的功能

本节说明仿真器的功能。仿真器的功能随仿真器支持器件的不同而有所差异。有关各种功能的使用方法，
请参阅第 5 章 “调试”或第 6 章 “教程”。

1.3.1 概要

表 1.1 列出了仿真器的整体功能。

有关各产品功能的详细信息，请参阅在线帮助。

表 1.1   仿真器的功能

编号 项目 功能

1 用户程序执行功能 • 以器件保证范围内的工作频率执行程序。

• 复位仿真

• 步进功能 (Step function)：
单步 （一步：一条指令）

源码级逐步 （一步：一行源代码）

跳过 （不会在子程序中暂停）

跳出 （当 PC 指向子程序内的位置时，继续执行直至返回到调用源函数）

2 复位功能 • 暂停期间从 HEW 向器件发送加电复位信号。

3 事件检测功能 • On-chip 事件检测功能

• AUD 事件检测功能

• 外部总线事件检测功能

• 其他事件检测功能

执行时间事件检测

外部探针事件检测

4 跟踪功能 • on-chip 事件检测时的内部跟踪功能

• AUD 事件检测时的 AUD 跟踪功能

• 外部总线事件检测时的外部总线跟踪功能

5 断点功能 • 满足软件断点条件时暂停

• on-chip 事件检测时暂停

• AUD 事件检测时暂停

• 外部总线事件检测时暂停

• 其他类型事件检测时暂停

• 跟踪缓冲器溢出时暂停

• 强制断点功能

6 性能测量功能 • 使用器件内部计数器测量点到点执行期间经过的周期数。

• 使用 AUD 事件通道测量点到点、点到范围或范围到范围执行的时间或计数。

• 测量执行单个函数所需的周期数，并在 “Go”命令执行结束后显示。

• 测量用户指定地址范围内函数的执行时间或执行计数，并在 “Go”命令执

行结束后显示。
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下节说明仿真器的特定功能。

1.3.2 事件检测功能

仿真器不仅具有 HEW 的标准软件断点功能，而且具备复杂的事件检测功能。

(1) 事件

在大多数实际调试应用中，您尝试调试的程序或硬件错误通常发生在某些限定条件下。例如，硬件错误可
能仅在存储器的特定区域进行存取后发生。使用简单的软件断点跟踪此类问题非常耗时。

仿真器可将地址或数据条件等特定条件的组合定义为事件点条件。满足事件点条件时，事件将发生。仿真
器的事件检测功能可用于检测生成的事件，并控制暂停操作、跟踪和性能测量的开始 / 结束。

(2) 事件类型

仿真器支持四种事件类型。

(a) 事件功能 (Onchip Event)

该功能使用 on-chip 断点控制器并根据 MCU 中的信息设置事件点。事件点可定义为下列一个或多个条件
的组合：

· 地址条件

· 数据条件

· 总线状态条件

· 事件计数条件

7 存储器存取功能 • 下载到 RAM
• 下载到闪存

• 单行汇编

• 反向汇编 （反汇编）

• 从存储器读取

• 写入到存储器

• 用户程序执行期间，自动更新选定变量的显示

• 填充

• 搜索

• 移动

• 复制

• 监控 （物理地址）

• 仿真存储器

8 通用 / 控制寄存器存
取功能

通用 / 控制寄存器的读写功能

9 内部 I/O 寄存器存取
功能

内部 I/O 寄存器的读写功能

10 源码级调试功能 各种源码级调试功能

11 命令行功能 支持命令输入。

按输入顺序排列命令，从而创建某个文件时，即可使用批处理功能。

12 帮助功能 说明各个功能或（从命令行窗口输入的）命令语法的用法。

表 1.1   仿真器的功能 （续）

编号 项目 功能
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对于检测到某事件后执行的操作，可指定暂停、内部跟踪截获 / 截获开始 / 截获停止或内部性能测量开始 /
结束。

该功能可在 [Event] （事件）窗口的 [Onchip Event] （Onchip 事件）页中设置。

仿真器用于在 [Onchip Event] （Onchip 事件）页中设置事件条件和软件跟踪。

表 1.2 列出了事件条件的类型。

注意：可为 on-chip 事件设置的内容随产品的不同而有所差异。有关各产品的规格，请参阅补充文件 “有关使
用 SHxxxx 的补充信息”或在线帮助。

(b) AUD 事件功能 (AUD Event)

该功能可根据 AUD 接口的输出信息设置事件点。共有八个事件检测通道。事件点可定义为下列一个或多
个条件的组合：

· 转移跟踪数据条件

· 窗口跟踪数据条件

· 软件跟踪数据条件

· 事件计数条件

· 发生某事件后的延迟条件

对于检测到某事件时执行的操作，可指定暂停、 AUD 跟踪截获 / 截获开始 / 截获停止或 AUD 性能测量开
始 / 结束。

该功能可在 [Event] （事件）窗口的 [AUD Event] （AUD 事件）页中设置。

注意：1. 因检测 AUD 事件而造成暂停时，从检测时间到暂停之间存在数个周期的延迟。如果从事件产生
到暂停之间的延迟会影响到用户系统，请使用 on-chip 事件功能 (Onchip event)。

2. 如果 AUD 跟踪的截获模式为 [Realtime trace] （实时跟踪），则无法比较未输出的数据。

3. 如果在未连接 EV 芯片单元的情况下执行调试，则无法在 AUD 事件中选择暂停功能。

4. 可为 AUD 事件设置的内容将随着产品的不同而有所差异。有关各产品的规格，请参阅在线帮助。

表 1.2   事件条件的类型

事件条件类型 说明

Address bus condition (Address)
（地址总线条件）

当 MCU 的地址总线值或程序计数器值等于指定值时暂停

Data bus condition (Data)
（数据总线条件）

当 MCU 的数据总线值等于指定值时暂停。存取数据长度可指定为字节、字或
长字。

Bus state condition (Bus State)
（总线状态条件）

总线状态条件设置有两种：

总线状态条件：总线值匹配指定值时暂停跟踪或截获跟踪。

读 / 写条件：满足指定的读 / 写条件时暂停跟踪或截获跟踪。

Count （计数） 满足条件设置达到指定次数时暂停。

Action （操作） 选择条件（如设置暂停、跟踪或性能测量开始 / 结束）匹配时执行的操作。
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[ 补充信息 ]：AUD 功能

使用 AUD 跟踪、 AUD 事件和 AUD 性能功能时，必须按照下列步骤允许 AUD。

· 不连接 EV 芯片单元执行调试

1. 设置 [Configuration] （配置）对话框的 [General] （常规）页面上的 [AUD pin Select] （AUD 引脚选择）。

2. 设置 [Configuration] （配置）对话框的 [General] （常规）页面上的 [AUD clock] （AUD 时钟）。

3. 设置 [Internal/AUD] （内部 /AUD）跟踪的 AUD 跟踪信息截获条件。

· 连接 EV 芯片单元执行调试

1. 设置 [Configuration] （配置）对话框的 [General] （常规）页面上的 [AUD clock] （AUD 时钟）。

2. 设置 [Internal/AUD] （内部 /AUD）跟踪的 AUD 跟踪信息截获条件。

有关 [Configuration] （配置）对话框和 [Internal/AUD] （内部 /AUD）跟踪的设置信息，请参阅第 5.1 节
“设置仿真环境”和第 6.19 节 “跟踪功能”。

(c) 外部总线事件功能 (BUS Event)

该功能可根据 MCU 的外部总线或中断引脚之类的引脚信息设置事件点。共有六个事件检测通道。事件点
可定义为下列一个或多个条件的组合：

· 外部地址总线条件

· 外部数据总线条件

· 中断信号条件

· 事件计数条件

· 发生某事件后的延迟条件

对于检测到事件时执行的操作，可指定暂停或外部总线跟踪截获 / 截获开始 / 截获停止。

该功能可在 [Event] （事件）窗口的 [BUS Event] （BUS 事件）页中设置。

注意：1. 因检测外部总线事件而造成暂停时，从检测时间到暂停之间存在数个周期的延迟。

2. 该功能为可选功能；购买外部总线跟踪单元后方可使用。

3. 可为外部总线事件设置的内容随产品的不同而有所差异。有关各产品的规格，请参阅在线帮助。

(d) 其他事件 (Other Event)

该功能可在 [Event] （事件）窗口的 [Other Event] （其他事件）页中设置。

· 执行时间事件

到达指定执行时间后产生暂停。只有一个事件检测通道。

· 外部探针事件

只有一个事件检测通道。通过将经过探针电缆的四个外部探针信号指定为条件，可定义事件点。

对于检测到事件时执+行的操作，可指定暂停或 AUD 跟踪截获 /截获开始 /截获停止。

注意：从检测时间到暂停之间存在数个周期的延迟。
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1.3.3 跟踪功能

(1) 跟踪功能

仿真器主要有两种跟踪功能：

· 跟踪截获 MCU 外部信息 （如外部总线）的功能

(a) 跟踪截获 MCU 内部信息的功能

截获的跟踪信息在 [Internal/AUD] （内部 /AUD）窗口中显示。

要通过跟踪截获的信息是一个事件，该事件的跟踪截获被选作 [Event] （事件）窗口的 [Onchip Event]
（Onchip 事件）页上通道中的操作条件。要存储此类信息，可使用下列三种方式：

— 将信息存储在 MCU 专用跟踪存储器中的功能

可存储的跟踪截获信息的最大量为 1024。
该功能在 AUD 引脚未连接到仿真器时可用，否则无法使用存储器进行跟踪。

在下文中，该功能称作内部跟踪功能或内部跟踪。

— 实时输出 AUD 引脚信息的功能

根据 AUD 引脚输出的信息产生暂停。

在下文中，该功能称作 AUD 跟踪功能。

如果将一组转移源和转移目标指令看作是一个转移，则跟踪可截获的最大信息量为 262,144。

注意：可跟踪截获的内容随产品的不同而有所差异。有关各产品规格的详细信息，请参阅在线帮助。

— 软件跟踪功能

注意：SHC/C++ 编译器（瑞萨科技公司制造；包括 OEM 和套装产品）V7.0 或以后版本支持该功能。

执行特定指令时，可通过跟踪截获执行时的 PC 值和一个通用寄存器的内容。请事先说明要编译

和连接的 Trace(x) 函数 （x 为变量名称）。有关详细信息，请参阅 SuperHTM RISC engine C/C++ 
编译器、汇编器、优化连接编辑器用户手册。

当装入模块下载到仿真器上且在软件跟踪功能有效的情况下执行时，会显示执行 Trace(x) 函数后

的 PC 值、 x 的通用寄存器值和源代码行。

要允许软件跟踪功能，请双击 [Event] （事件）窗口中 [AUD Event] （AUD 事件）页上的事件通

道，然后选中 [General] （常规）页上的 [Software trace data] （软件跟踪数据）单选按钮。

(b) 跟踪截获 MCU 内部信息的功能

截获的跟踪信息在 [BUS trace] （BUS 跟踪）窗口中显示。

外部总线跟踪功能 (BUS trace)：
这是一种大范围存储区域跟踪功能，在 MCU 外部总线引脚连接到仿真器时非常有用。读写外部

存储器时，会从外部总线引脚实时输出跟踪信息。

根据指定的外部总线事件点条件，可控制外部总线跟踪截获、截获开始和截获结束。有关设置事

件点的详细信息，请参阅第 5.8 节 “使用事件点”。

该功能在每个总线周期可截获最多 262,144 个周期的信息。

注意：1. 该功能为可选功能；购买外部总线跟踪单元后方可使用。

2. 可跟踪截获的内容随产品的不同而有所差异。有关各产品规格的详细信息，请参阅在线帮助。
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(2) [Trace] （跟踪）窗口的有用功能

[Trace] （跟踪）窗口提供下列有用功能。

(a) 搜索指定数据。

(b) 提取指定数据。

(c) 过滤并再次显示指定数据。

(d) 补充从转移目标地址到下一转移源地址的信息。

有关这些功能的用法，请参阅第 5.9 节 “查看跟踪信息”。

(e) 在用户程序执行期间更改跟踪设置。

可在用户程序执行期间更改跟踪设置。

1.3.4 断点功能

仿真器具备下列七种断点功能。

(a) 软件断点功能 (BREAKPOINT)

将程序指定位置的原始指令更换为专用指令，以便在该位置暂停程序运行。由于会出现存储器写操
作，因此无法在 RAM 以外的位置设置该功能。

该功能可在 [Event] （事件）窗口的 [Breakpoint] （断点）页中设置。也可通过双击 [Editor] （编辑
器）列中要设置的行，在 [Editor] （编辑器）或 [Disassembly] （反汇编）窗口中设置该功能。

(b) On-chip 事件断点功能

在 on-chip 事件检测功能检测到特定事件时暂停。

在 [Event] （事件）窗口的 [Onchip Event] （Onchip 事件）页中将检测到事件后执行的操作设置为
“break”时，该功能才可用。

也可通过双击 [Onchip event] （Onchip 事件）列中要设置的行，在 [Editor] （编辑器）或 [Disassembly]
（反汇编）窗口中设置该功能。

注意：On-chip 事件断点设置可在用户程序执行期间更改。

(c) AUD 事件断点功能

在 AUD 事件检测功能检测到特定事件时暂停。

在 [Event] （事件）窗口的 [AUD Event] （AUD 事件）页中将检测到事件后执行的操作设置为
“break”时，该功能才可用。

也可通过双击 [AUD Event] （AUD 事件）列中要设置的行，在 [Editor] （编辑器）或 [Disassembly]
（反汇编）窗口中设置该功能。
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(d) 外部总线事件断点功能

在外部总线事件检测功能检测到特定事件时暂停。

在 [Event] （事件）窗口的 [BUS Event] （BUS 事件）页中将检测到事件后执行的操作设置为“break”
时，该功能才可用。

也可通过双击 [BUS Event] （BUS 事件）列中要设置的行，在 [Editor] （编辑器）或 [Disassembly]
（反汇编）窗口中设置该功能。

注意：1. 因检测外部总线事件而造成暂停时，从检测时间到暂停之间存在数个周期的延迟。

2. 该功能为可选功能；购买外部总线跟踪单元后方可使用。

3. 可为外部总线事件设置的内容随产品的不同而有所差异。有关各产品的规格，请参阅在线帮助。

(e) 其他事件断点功能

— 执行时间事件检测功能

— 外部探针事件检测功能

在其他事件检测功能检测到特定事件时暂停。

在 [Event] （事件）窗口的 [Other Event] （其他事件）页中将检测到事件后执行的操作设置为“break”
时，该功能才可用。

(f) 跟踪缓冲器溢出产生的跟踪断点功能

在仿真器的 AUD 跟踪缓冲器和外部总线跟踪缓冲器满载时暂停。

该功能可在 [I-Trace/AUD-Trace acquisition] （I 跟踪 /AUD 跟踪截获）对话框和 [BUS acquisition] （BUS 
截获）对话框中设置。

(g) 强制断点功能

强制暂停用户程序。

1.3.5 探针功能

可在仿真器上放置六枚外部探针。

(1) 四枚输入探针

监测输入信号、暂停用户程序和满足特定条件时开始或结束 AUD 跟踪。该功能可在 [Event] （事件）
窗口的 [Other Event] （其他事件）页上设置。

(2) 一枚事件输出探针

检测到事件时输出事件信号。该功能可在事件点设置对话框的 [Action] （操作）页中设置。

注意：可输出事件信号的事件随产品的不同而有所差异。有关各产品的规格，请参阅在线帮助。

(3) 一枚接地探针

该探针用于接地。
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1.3.6 性能测量功能

仿真器具备三种类型的性能测量功能。

(1) On-chip 性能分析功能 (Onchip Performance Analysis)

该功能使用器件内部计数器测量从满足一个特定条件到满足下一个特定条件之间经历的周期数。

该功能不仅可以测量周期数，还可测量高速缓存缺失等各种项目，视支持的器件而定。

注意：要测量的项目会随产品的不同而有所差异。有关各产品规格的详细信息，请参阅补充文件 “有关
使用 SHxxxx 的补充信息”或在线帮助。

(a) 设置性能测量条件

如果要设置性能测量条件，请使用 [Performance Analysis] （性能分析）对话框和 PERFORMANCE_SET 
命令。鼠标右键单击 [Performance Analysis] （性能分析）窗口上的通道行会显示弹出菜单，然后选择 
[Setting] （设置），此时显示 [Performance Analysis] （性能分析）对话框。

注意：有关命令行语法的详细信息，请参阅在线帮助。

(b) 指定测量开始 / 结束条件

要设置测量开始/结束条件，请首先以右键单击 [Event] （事件）窗口的 [Event Condition] （事件条件）页
上的 [Combination action] （组合操作），在打开的 [Combination action] （组合操作）对话框的 [Ch1, 2, 3]
（通道1、 2、 3）列表中选择 [Ch1 to Ch2 PA] （通道1 至通道2 性能分析）或 [Ch2 to Ch1 PA] （通道2 至
通道1 性能分析）。然后，为事件条件的 Ch1 和 Ch2 指定测量开始/结束条件。

注意：1. 如果未指定测量开始 / 结束条件，则测量从执行程序开始，至满足断点条件时结束。

2. 如果仅指定测量开始或测量结束条件，则无法测量性能。请务必同时指定测量开始和测量结束
条件。

3. 如果指定了测量开始 / 结束条件，则无法执行逐步操作。

· 测量容差

— 测量值包含容差。

— 容差会在暂停前 /后产生。

· 测量项目

在从 Ch1 到 Ch4 的每个通道的 [Performance Analysis]（性能分析）对话框中测量项目。最多可同时指定
四个条件。

注意：要测量的项目会随产品的不同而有所差异。有关各产品规格的详细信息，请参阅补充文件 “有关
使用 SHxxxx 的补充信息”或在线帮助。

表 1.3 中的条件产生时，每个测量条件都将计算在内。

注意：1. 在 AUD 跟踪和存储器输出跟踪的非实时跟踪模式中，闲置周期或执行周期的生成状态会发生更改，
因此无法执行正常计数。

2. 计数器使用 CPU 时钟作为时钟源，因此，当时钟在休眠模式中暂停时，计数亦随之停止。

表 1.3   要计数的性能测量条件

测量条件 说明

高速缓存计数 (Cache-on counting) 存取不可缓存区域的计数少于实际周期数和计数。存取可缓存区域和 U-RAM 
区域的计数多于实际周期数和计数。

转移计数 (Branch count)） 计数器的值以 2 递增。即一个转移有两个有效周期。
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· 性能结果存储计数器的扩展设置

由 32 位计数器存放性能的测量结果，两个 32 位计数器可作为 64 位计数器使用。

如要设置 64 位计数器，请选中 Ch1 的 [Performance Analysis] （性能分析）对话框的 [Extend counter]
（扩展计数器）组框的 [Enable] （允许）复选框。

(c) 显示性能测量结果

性能测量结果以十六进制（32 位）形式在 [Performance Analysis] （性能分析）窗口或 
PERFORMANCE_ANALYSIS 命令中显示。

但是，如果允许了扩展计数器，则性能测量结果以十六进制（64 位）形式显示。

注意：如果测量结果为性能计数器溢出，则显示 “********”。

(d) 初始化测量结果

要初始化测量结果，请选择 [Performance Analysis] （性能分析）窗口弹出菜单中的 [Initialize] （初始
化），或使用 PERFORMANCE_ANALYSIS 命令指定 INIT。

(2) AUD 性能分析功能 (AUD Performance Analysis)

仿真器可以让您测量 AUD 事件检测系统中指定事件间的执行时间或执行次数。可将定时器分辨率设置为
下列任意值：

20 ns、 100 ns、 400 ns 或 1.6 µs。

如设为 20 ns，则可测量的最大时长约为 6 个小时，而设为 1.6 µs 时，可测量的最大时长约为 20 天。

(3) 剖析功能 (Profile)

剖析功能用于测量各个函数的性能。

如果能够获得每个函数执行时间的统计信息，就能轻松找到性能低下的函数。

可测量的项目与 on-chip 性能测量功能的可测量项目相同。

注意：1. 不可同时使用剖析功能和 on-chip 性能分析功能。如果尝试同时使用，则会显示 [Can not use 
this function] （无法使用该功能）的错误信息对话框。

2. 在该功能中，每次产生转移时均会导致程序运行暂停，并收集信息以便再次执行用户程序。因
此，该功能无法进行用户程序的实时仿真。

(4) 实时剖析功能 (Realtime Profile)

可在指定地址范围内测量每个函数的性能。

如果能够监测每个函数执行时间的统计信息，就能轻松找到性能低下的函数。

该功能无需中断程序运行，即可收集性能信息。因此，可进行用户程序的实时仿真。

可指定的地址范围有：

· 未连接扩展剖析单元时：512 kB 至 4 MB （8 个 512 kB 块）

· 连接扩展剖析单元时：512 kB 至 12 MB （24 个 512 kB 块）
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1.3.7 覆盖率功能

仿真器可显示已执行过的 C/C++ 和汇编语言级指令的相关信息，以测量 C0 覆盖率。

1.3.8 存储器存取功能

仿真器具备下列存储器存取功能。

(1) 存储器读 / 写功能

(2) 用户程序下载功能

已在工作区中注册的装入模块可以下载。可在 [Debug] （调试）菜单的 [Download Module] （下载模块）
中选择此类模块。也可在工作区的装入模块上单击鼠标右键，并通过打开的弹出菜单下载。用户程序可下载至 
RAM 或闪存。

如果要下载到闪存上，请选择 [Options] （选项）菜单的 [Emulator] （仿真器），打开 [Configuration] （配
置）窗口，然后在 [Loading flash memory] （装入闪存）页上进行所需的设置。

该功能也可下载调试信息等进行源码级调试所需的信息。

(3) 存储器数据上载功能

可将从指定地址开始的指定大小的存储区域保存到一个文件中。

(4) 存储器数据下载功能

保存在文件中的存储器内容可供下载。从 [Memory] （存储器）窗口的弹出菜单中选择 [Load] （装入）。

(5) 显示变量内容

显示用户程序中指定的变量内容。

(6) 监控功能

仿真器可以在不暂停程序执行的情况下监控已存取区域中的值，并在窗口中显示。

(7) 仿真存储器功能

仿真器在 CS 区域分配仿真存储器。

(8) 其他存储器操作功能

其他功能如下：

· 存储器填充

· 存储器复制

· 存储器保存

· 存储器检验

[Memory] （存储器）窗口： 该窗口显示存储器的内容。开启 [Memory] （存储器）窗口时，只能读取指
定数量的存储器内容。仿真器中没有高速缓存，因此总会产生读周期。如果
在 [Memory] （存储器）窗口中执行存储器写操作，则 [Memory] （存储器）
窗口显示的存储区域将出现读周期，以更新窗口。如果无需更新 [Memory]
（存储器）窗口，则请更改弹出菜单中 [Lock Refresh] （锁定刷新）的设置。

me command： 一种命令行功能，可对指定地址处指定数量的存储区域进行读写。
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· 存储器搜索

· 内部 I/O 显示

· 高速缓存表显示和编辑 （仅限器件合并高速缓存）

· 显示标号和变量名称及其内容

有关详细信息，请参阅在线帮助。

注意：1. 用户程序执行期间的存储器存取：
在用户程序执行期间，从存储器窗口存取存储器等操作会停止程序的执行，并在存储器存取操
作完成后恢复程序的执行。因此，无法进行实时仿真。

2. 用户程序暂停期间的存储器存取：
仿真器还可将程序下载到闪存区域。其他存储器写操作仅适用于 RAM 区域。因此，只应对 RAM 
区域设置存储器写入或 BREAKPOINT 之类的操作。

1.3.9 堆栈跟踪功能

仿真器使用堆栈信息显示调用源函数（当前程序计数器指向的函数）的名称。仅当装入模块已装入 Dwarf2 
类型的调试信息后，才可使用该功能。

1.3.10 用户程序暂停期间的用户中断开启功能

要调试的某些器件允许用户在执行仿真期间开启所有中断。用户程序暂停期间，可指定执行或不执行中断
处理的模式。

1.3.11 在线帮助

在线帮助说明每个功能或 （可从命令行窗口输入的）命令语法的用法。

选择 [Help] （帮助）菜单中的 [Emulator Help] （仿真器帮助）可查看仿真器帮助。

1.4 环境条件

使用仿真器时，请遵循表 1.4 和表 1.5 中所列条件。否则会导致用户系统、仿真器产品和用户程序非法操作。
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表 1.5 列出了适合的操作环境。

表 1.4   环境条件

项目 规格

温度 操作时：+10 °C 至 +35 °C
存放时：–10 °C 至 +50 °C

湿度 操作时：35% RH 至 80% RH，无冷凝
存放时：35% RH 至 80% RH，无冷凝

震动 操作时：最大 2.45 m/s2。
存放时：最大 4.9 m/s2。
运输时：最大 14.7 m/s2。

周围气体 不存在腐蚀性气体

表 1.5      操作环境

项目 说明

主机 内置 Pentium® III 或更高性能的 CPU （推荐 1 GHz 或更高频率）；配备 USB 1.1/2.0
（全速）的 IBM PC 或兼容机。

操作系统 Windows® 2000 或 Windows® XP

最小存储器容量 128 MB 或更高（推荐 512 MB 或更高）

硬盘容量 安装磁盘容量：100 MB 或更高。（请预留至少双倍于存储器容量的空间（推荐四倍或
更高容量）作为交换区域。）

鼠标等点击器件 可与主机连接；与 Windows® 2000 或 Windows® XP 兼容。

显示器 显示器分辨率：1024 x 768 或更高

AC 输入电源 电压：AC 100 V ± 10% 
频率：50/60 Hz 
功耗：48 W

CD-ROM 驱动器 用于安装仿真器的 HEW 或参阅仿真器用户手册。
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第 2 章 设置仿真器

2.1 使用仿真器前的准备工作流程图

拆开仿真器包装并按照下列说明完成使用前的准备工作：

 

图 2.1   使用仿真器前的准备工作流程图

使用仿真器产品前，请先阅读图 2.1 中涉及的参考章节。操作不当会损坏用户系统和仿真器产品。用户程序

将丢失。

 2 

 4 

 HEW

 HEW
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2.2 安装调试器

2.2.1 CD-R

CD-R 的根目录中包括仿真器软件的安装程序。此文件夹包含下列文件和程序。

执行 CD-R 根目录中的 Setup.exe，启动安装向导。

按照安装向导给出的提示安装软件。

注意：在 Windows® XP 中安装驱动程序后，可能会显示一条有关 Windows® 徽标测试的警告信息，这不是
什么问题。选择 [Continue Anyway] （继续安装），继续安装驱动程序即可。

表 2.1   CD-R 目录内容

目录名称 内容 说明

Dlls Microsoft® 运行时库 HEW 运行时库。安装时会检查版本并在安装过程中将此库复制到硬盘上。

Drivers E200F 仿真器驱动程序 E200F 仿真器的 USB 驱动程序。

Help E200F 仿真器的在线帮助 在线帮助文件。这些文件在安装过程中被复制到硬盘上。

Manual E200F 仿真器手册 E200F 仿真器用户手册。 PDF 格式文件。
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2.3 将可选单元连接到仿真器主部件壳体

仿真器包含可选单元。本节说明如何连接主要用于 E200F 主部件壳体的可选单元。

使用外部总线跟踪单元、 EV 芯片单元或仿真存储器单元时，需要跟踪电缆 （需另购）。

可选单元的连接方式随所支持的 MCU 的不同而不同。有关详细信息，请参阅各 MCU 的补充文件 “有关
使用 SHxxxx 的补充信息”。

2.3.1 将 E200F 外部总线跟踪单元连接至用户系统

· 打开主部件壳体侧面的 TRACE I/F 盖。

· 将外部总线跟踪单元附送的跟踪电缆连接至仿真器，如图2.2 所示。

 

图 2.2   将跟踪电缆连接至 E200F
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· 将外部总线跟踪单元连接至跟踪电缆 （CN1 侧）。

 

图 2.3   将跟踪电缆连接至外部总线跟踪单元
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· 检查第 1 引脚的位置后，将用户系统连接至外部总线跟踪单元。

 

图 2.4   将用户系统连接至外部总线跟踪单元

注意：1. 信号连接随使用的 MCU 的不同而有所差异。

2. 要将信号连接至用户系统，请参阅补充文件 “有关使用 SHxxxx 的补充信息”。

连接前，请检查第 1 引脚的位置。
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2.3.2 将 E200F 仿真存储器单元连接至仿真器主部件

· 打开主部件壳体侧面的 TRACE I/F 盖。

· 将外部总线跟踪单元附送的跟踪电缆连接至仿真器，如图2.5 所示。

 

图 2.5   将跟踪电缆连接至 E200F
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· 将仿真存储器单元连接至跟踪电缆 （CN1 侧）。

 

图 2.6   将跟踪电缆连接至仿真存储器单元
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2.3.3 将仿真存储器单元连接至用户系统

· 检查第 1 引脚的位置后，将用户系统连接至仿真存储器单元。

 

图 2.7   将用户系统连接至仿真存储器单元

注意：1. 信号连接随使用的 MCU 的不同而有所差异。

2. 有关信号连接的详细信息，请参阅补充文件 “有关使用 SHxxxx 的补充信息”。

连接前，请检查第 1 引脚的位置。
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2.3.4 连接 E200F 外部总线跟踪单元、仿真存储器单元和用户系统

· 将外部总线跟踪单元与仿真存储器单元一同使用时，请先将外部总线跟踪单元连接至仿真存储器单元
（图2.8），然后再连接到用户系统 （图2.10）。

 

图 2.8   将外部总线跟踪单元连接至仿真存储器单元
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· 检查第 1 引脚的位置后，连接外部总线跟踪单元、仿真存储器单元和跟踪电缆。

 

图 2.9   连接外部总线跟踪单元、仿真存储器单元和跟踪电缆

· 检查第 1 引脚的位置后，连接外部总线跟踪单元、仿真存储器单元和用户系统。

 

图 2.10   连接外部总线跟踪单元、仿真存储器单元和用户系统

注意：1. 信号连接随使用的 MCU 的不同而有所差异。

2. 有关信号连接的详细信息，请参阅补充文件 “有关使用 SHxxxx 的补充信息”。

连接前，请检查第 1 引脚的位置。
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2.3.5 将 EV 芯片单元连接至用户系统

· 打开主部件壳体侧面的 TRACE I/F 盖。

· 将跟踪电缆连接至 EV 芯片单元，如图2.11 所示。

 

图 2.11   使用 EV 芯片单元时，将跟踪电缆连接至 E200F
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· 将 EV 芯片单元连接至跟踪电缆 （CN1 侧）。

 

图 2.12   将跟踪电缆连接至 EV 芯片单元

连接前，请检查第 1 引脚的位置。
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2.3.6 将 E200F 外部总线跟踪单元连接至 EV 芯片单元

· 外部总线跟踪单元与 EV 芯片单元一同使用时，将外部总线跟踪单元连接至 EV 芯片单元，如图2.13 
所示。

 

图 2.13   将外部总线跟踪单元连接至 EV 芯片单元

· 检查第 1 引脚的位置后，将用户系统连接至外部总线跟踪单元。

 

图 2.14   将用户系统连接至外部总线跟踪单元

连接前，请检查第 1 引脚的位置。
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2.3.7 将 E200F 仿真存储器单元连接至 EV 芯片单元

· 仿真存储器单元与 EV 芯片单元一同使用时，将仿真存储器单元连接至 EV 芯片单元（如图2.15 所示）。

 

图 2.15   将仿真存储器单元连接至 EV 芯片单元
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· 检查第 1 引脚的位置后，连接 EV 芯片单元、仿真存储器单元和跟踪电缆。

 

图 2.16   连接仿真存储器单元、 EV 芯片单元和跟踪电缆

连接前，请检查第 1 引脚的位置。
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2.3.8 连接 E200F 外部总线跟踪单元、仿真存储器单元和 EV 芯片单元

· 将外部总线跟踪单元与仿真存储器单元和 EV 芯片单元一同使用时，请按照图2.17 所示进行连接，
(a)、 (b)、 (c) 位置分别对应外部总线跟踪单元、仿真存储器单元和 EV 芯片单元。

· 检查第 1 引脚的位置后，连接外部总线跟踪单元、仿真存储器单元和 EV 芯片单元。

 

图 2.17   连接外部总线跟踪单元、仿真存储器单元和 EV 芯片单元

连接前，请检查第 1 引脚的位置和各单元的位置。
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2.3.9 将探头连接至 EV 芯片单元

· 将探头连接至 EV 芯片单元，如图2.18 所示。

 

图 2.18   将探头连接至 EV 芯片单元

连接前，请检查第 1 引脚的位置。
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2.3.10 将 E200F 扩展剖析单元连接至主部件壳体

· 取下固定底座单元的螺钉。

 

图 2.19   用于垂直放置仿真器的底座单元的螺钉

 

图 2.20   取下用于垂直放置仿真器的底座单元
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· 取下主部件壳体后部的两个螺钉。

 

图 2.21　主部件壳体螺钉

· 取下主部件壳体，如图2.22 所示。

 

图 2.22   取下主部件壳体
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· 检查第 1 引脚的位置后，将扩展剖析单元连接至主部件壳体。

 

图 2.23   将扩展剖析单元连接至主部件壳体
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· 使用附送的螺钉固定扩展剖析单元。

 

图 2.24   将扩展剖析单元固定至主部件壳体

· 合上主部件壳体盖，并用两个螺钉固定。

· 拧紧底座单元的螺钉。
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2.3.11 将 AC 适配器连接至仿真器主部件壳体

· 将附送的 AC 适配器连接至主部件壳体。

 

图 2.25   将 AC 适配器连接至主部件壳体

将附送的 AC 适配器连接至标记有 “DC IN”的 AC 适配器输入 DC (+12 V) 连接器。

请务必使用 E200F 专用的 AC 适配器。否则会引发火灾并损坏用户系统或仿真器产品。
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2.3.12 将仿真器连接至主机

本节说明如何将仿真器连接到主机。有关仿真器各连接器位置的详细信息，请参阅第 1.2 节 “仿真器硬件
配置”。

注意：1. 屏幕显示 [Add New Hardware Wizard] （添加硬件向导）时，选择 [Search for the best driver 
for your device.(Recommended)] （搜索适合器件的最佳驱动程序 （推荐））单选按钮，然后
选中 [Specify a location] （指定位置）复选框，选择搜索驱动程序的路径。位置必须指定为 
<Drive>:\DRIVERS。（<Drive> 是 CD 驱动器的盘符。）

2. 在 Windows® XP 中安装驱动程序后，可能会显示一条有关 Windows® 徽标测试的警告信息，
这不是什么问题。选择 [Continue Anyway] （继续安装），继续安装驱动程序即可。

3. 连接仿真器前，请务必安装仿真器软件。

仿真器通过 USB 1.1/2.0 与主机相连。图 2.26 显示了系统配置。
 

图 2.26   将仿真器连接到主机时的系统配置

除 USB 接口电缆外，在连接或断开任何电缆前，请务必让仿真器产品和用户系统断电。否则会引发火灾并

损坏用户系统和仿真器产品，或造成人身伤害。

用户程序将丢失。
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2.4 将仿真器连接至用户系统

要将仿真器连接至用户系统，或在移动仿真器或用户系统时断开它们之间的连接，请按照下列步骤操作。

1. 检查仿真器是否已断电。

2. 将探头连接器连接至用户系统。

3. 使用螺钉将探头固定至用户系统。

(1) 必须将连接器安装到用户系统上。表 2.2 显示了推荐的仿真器 H-UDI 端口连接器。

(2) 补充文件 “有关使用 SHxxxx 的补充信息”第 2 章中显示了连接器的引脚排列。

(3) 将 H-UDI 端口连接器的引脚 2、4、6、8、10、12、14、16、18、20、22、24、26、28、30、32、
33、 34 和 36 （使用 36 引脚用户系统接口电缆时）连接至 PCB 上的 GND。这些引脚用作电接地，并
监测 H-UDI 端口连接器的连接。请注意 H-UDI 端口连接器的引脚排列。

表 2.2      推荐的连接器

连接器 类型编号 制造商 规格

36 引脚连接器 DX10M-36S Hirose Electric Co., Ltd. 螺钉类型

DX10M-36SE、
DX10G1M-36SE

锁定引脚 (Lock-pin) 类型
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2.4.1 将 E200F H-UDI 探针连接至用户系统

· 将 H-UDI 探针连接至用户系统，如图2.27 所示。

 

图 2.27   将 H-UDI 探针连接至用户系统
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· 使用螺钉固定用户系统和 H-UDI 探针，如图2.28 所示。

 

图 2.28   固定用户系统和 H-UDI 探针

注意：1. 信号连接随封装的不同而有所差异。有关详细信息，请参阅 MCU 的引脚顺序排列。

2. 仿真器工作的通信范围随所使用的 MCU 的不同而有所差异。

3. 要连接来自连接器的信号，请参阅补充文件 “有关使用 SHxxxx 的补充信息”的第 2 章。

注意：连接器的引脚编号顺序排列随连接器制造商的不同而有所差异。
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4 开发用户系统时，请勿将器件的 TDI 和 TDO 信号连接至边界扫描环路，或使用开关将它们分离
（图 2.29）。

 

图 2.29   用户系统示例

SHxxxx

H-UDI

TDI TDO TDI TDOTDI TDO

H-UDI

JTAG

TDI
TDO
TAP

IC

TAP

IC

TAP

IC

TAP

TDI

TDO
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2.4.2 连接系统接地

仿真器的信号接地与用户系统的信号接地相连。仿真器的信号接地和机架接地相连。用户系统只需机架接
地；切勿将信号接地连接到机架接地 （图 2.30）。
 

图 2.30   连接系统接地

分离用户系统的机架接地和信号接地。否则会引发火灾并损坏用户系统和仿真器产品，或造成人身伤害。

E200F 

GND
GND
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2.5 更改设置

在仿真器中，用户可根据调试的需要灵活地更改仿真器的功能。

HEW 启用且连接至仿真器时，可以选择需要的功能。此时显示以下对话框。
 

图 2.31   [Function select] （功能选择）对话框

下面几节说明可在该对话框中选择的内容。

注意：有关各功能的详细信息，请参阅第 1.3 节 “仿真器的功能”。
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2.5.1 在使用 E200F 主部件时更改功能

选择 [Function select] （功能选择）对话框的 [Main board mode setting] （主板模式设置）组合框中的项目。
 

图 2.32   [Function select] （功能选择）对话框

· [RealProfile Area1 (function mode)] （RealProfile 区域1 （功能模式））：测量各功能执行时间的积累值；
不包括子程序的执行时间。

· [RealProfile Area1 (nest mode)] （RealProfile 区域1 （嵌套模式））：测量各功能执行时间的积累值；
包括子程序的执行时间。

· [Coverage (4M)] （覆盖率 (4M)）：获取 4-MB 区域内的 C0 覆盖率信息。

注意：使用实时剖析和覆盖率功能可增加扩展剖析单元能够设置的范围。
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2.5.2 在使用外部总线跟踪单元时更改功能

选择 [Function select] （功能选择）对话框的 [Bus board mode setting] （总线板模式设置）组合框中的项目。
 

图 2.33　[Function select] （功能选择）对话框

· [Trace/break 6ch (Trace 242144 cycles)] （跟踪 /暂停通道6 （跟踪 242144 个周期））：将检测外部总线
事件的通道用作断点。

· [Emulation memory (4M, Trace 8192 cycles)] （仿真存储器（4M，跟踪 8192 个周期））：使用外部仿真
存储器功能 （4 MB x 1 块）。

注意：外部总线跟踪单元未连接至仿真器时，该组合框显示为灰色。
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2.5.3 在使用扩展剖析单元时更改功能

选择 [Function select] （功能选择）对话框的 [Option board mode setting] （可选板模式设置）组合框中的项目。
 

图 2.34　[Function select] （功能选择）对话框

· [RealProfile Area2 (function mode)] （RealProfile 区域2 （功能模式））：测量各功能执行时间的积累值；
不包括子程序的执行时间。

· [RealProfile Area2 (nest mode)] （RealProfile 区域2 （嵌套模式））：测量各功能执行时间的积累值；
包括子程序的执行时间。

· [Coverage (8M)] （覆盖率 (8M)）：获取 8-MB 区域内的 C0 覆盖率信息。

注意：扩展剖析单元未连接至仿真器时，该组合框显示为灰色。
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第 3 章 硬件规格

3.1 规格列表

表 3.1 列出了仿真器主部件和可选单元的外部尺寸和重量。

图 3.1 显示了仿真器主部件的探头的外部尺寸。
   

表 3.1   仿真器的功能

编号 项目 规格

1 E200F 主部件壳体的外部尺寸 195 x 130 x 45 (mm)

E200F 主部件壳体的重量 490 (g)

2 E200F 外部总线跟踪单元的外部尺寸 90 x 125 x 15.2 (mm)

E200F 外部总线跟踪单元的重量 83 (g)

3 E200F 扩展剖析单元的外部尺寸 98 x 115 x 15.2 (mm)

E200F 扩展剖析单元的重量 52 (g)

4 E200F EV 芯片单元的外部尺寸 110 x 125 x 15.2 (mm)

E200F EV 芯片单元的重量 110 (g)

5 用户系统接口板的外部尺寸 60 x 90 x 26 (mm)

用户系统接口板的重量 45 (g)

6 E200F 仿真存储器单元的外部尺寸 90 x 125 x 15.2 (mm)

E200F 仿真存储器单元的重量 R0E0200F1MSR00：81 (g)

R0E0200F1MSR01：85 (g)
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图 3.1   探头的外部尺寸
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3.2 用户系统接口电路

图 3.2 和 3.2 显示了用户系统接口电路。可以参考这些图来确定上拉电阻的值。

注意：带有 UVCC 电源的 IC 在 3.3 V 电压或来自 H-UDI 端口连接器的 VCC （3.3 至 5.0 V）电压下操作。

图 3.2   用户系统接口电路 (H-UDI)
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图 3.3   用户系统接口电路 (AUD)
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3.3 减少 EMI 噪声

为了防止 EMI 噪声，请在使用时将 EV 芯片单元装在盒子中，如图 3.4 所示。

建议盒子使用镀镍的铁或内部镀镍的树脂做材料。

盒子必须有足够的空间，可以容纳 EV 芯片单元、外部总线跟踪单元、仿真存储器单元、探头和用户系统。

图 3.4   减少 EMI 噪声的对策

注意：EMI 指电磁干扰 (Electrical Magnetic Interference)。
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3.4 诊断过程

本节说明如何设置和执行诊断程序并输出结果。

对于 SH-2A、SH-2 E200F 仿真器，如果产品管理封条上显示的序列号在 0001 至 0103 之间，则安装诊断程
序之后，请务必在首次执行时更新该程序的版本。该更新将一次性完成。如果产品序列号为 0104 或 0104 以上，
则无需更新诊断程序。

3.4.1 安装诊断程序

(1) 打开 \SOT\Setup.exe

从 CD-R 的 sot 目录执行 Setup.exe。将显示如图3.5 所示的、用于选择器件的屏幕。

(2) 选择器件序列

从组合框中选择所用的器件序列，然后单击 [NEXT] （下一步）按钮。

(3) 按照安装向导的指示安装诊断程序

所选器件序列的诊断程序的安装程序启动。

按照安装向导给出的提示安装软件。

(4) 添加器件序列

向诊断程序中添加若干器件序列后，请在程序安装结束后再次执行 Setup.exe，以选择新的器件序列。

此时，选择与初始安装相同的文件夹作为安装目录。

图 3.5   执行 Setup.exe 后用于选择器件序列的屏幕

 
选择当前启用的器件序列。

 
单击 [NEXT] （下一步）按钮。
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3.4.2 执行诊断程序

以下说明如何执行诊断程序。

1. 将仿真器连接到主机。

注意：使用诊断程序时，请勿将用户系统或用户系统接口板连接到仿真器。

2. 开启仿真器。

3. 从 [Start] （中文系统：[开始 ]）菜单的 [Programs] （中文系统：[程序 ]）中选择 [E200F TM] -> 
[E200F TM]。

4. 此时启动仿真器的诊断程序并显示初始屏幕 （图3.6）。

图 3.6   E200F 系统操作测试的初始屏幕

 
 

 

选择已连接的部件。

选择存储器容量。

选择目标器件序列。
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5. 选择 [COMPONENT] （部件）。要选择的部件必须连接到仿真器。 [COMPONENT] （部件）的复选

框所指的内容如下：

[Main] （主）：仿真器主部件 
[OPTION] （选项）：扩展剖析单元 
[TRC]：外部总线跟踪单元 
[EVA]：EV 芯片单元 
[Memory] （存储器）：仿真存储器单元

注意：不要选择 [TARGET] （目标）（[TARGET] （目标）用作发货测试的夹具 (jig)）。

6. 如果已连接了 EV 芯片单元，请在 [Select Cpu] （选择 Cpu）中选择目标器件序列。

7. 如果已连接仿真存储器单元，请在 [Select Memory Type] （选择存储器类型）中选择相应的存储器容

量。该组合框的项目所指的产品如下：

[8Mbyte] （8 MB）：8 MB 仿真存储器单元 

[16Mbyte] （16 MB）：16 MB 仿真存储器单元

8. 单击 [USER TEST MODE] （用户测试模式）按钮。请勿选择 [QA TEST MODE] （QA 测试模式）。

9. 仿真器进入 USER TEST MODE （用户测试模式）时，会显示如图3.7 所示的屏幕。

10. 单击 [UNIT ONLY] （仅单元）时，将选中可以测试的项目。

11. 单击 [START] （开始）按钮。

12. FPGA 装入完毕后，测试将开始。
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图 3.7   选择测试的屏幕

注意：请勿在测试过程中断开 USB 电缆。

 

选择 [UNIT ONLY] （[ 仅单元 ]）。
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13. 执行测试时， [STATUS] （状态）的左边会显示 “Testing”（正在测试）。

14. 测试成功完成以后，会显示 “Test OK!”（测试成功 !）。

15. 选择 [BACK] （返回）退出诊断程序。

图 3.8   显示 “Testing”（正在测试）的屏幕

 

表示测试正在执行。

 

测试正常完成以后，选择 [BACK]
（[ 返回 ]）退出程序。



SH-2A、 SH-2 E200F 仿真器 第 3 章   硬件规格

Rev.1.00  2007.09.21  Page 71 of 279
RCJ10J0048-0100

3.4.3 创建日志文件

图 3.9   显示测试失败的屏幕 (1)

如果测试失败，会显示“Test NG!”（测试失败 !） （图 3.9）或“Status = xxxx xxxx Error”（状态 = xxxx 
xxxx 错误）（图 3.10）。在这种情况下，仿真器可能有故障。将按照下列过程创建的日志文件和故障内容发送
给营业部。

· 如何创建日志文件

1. 单击 [FILE LOG] （创建日志文件）按钮。

2. 在用于安装诊断程序的目录 （如果未指定目录，则为 C:\Program Files\E200F F1 TM）下会创建日志

文件 “F001_SHxxxx.log”。

3. 将日志文件发送给营业部。

 

表示测试失败。
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图 3.10   显示测试失败的屏幕 (2)

E200F TM 错误日志示例

*** E200F Emulator T/M ERROR LOG ***

TM Version 2.0.00

ICE CODE F001

Board Number 0001

Device SH7200

Date 2007/01/01

No.   STATUS          NG Address               NG Data
03   0318               A8000004                    00000040             NG

表示问题发生在诊断程序的
起始处，以致测试不会进行。 
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3.4.4 更新诊断程序

以下说明如何更新诊断程序。

1. 将仿真器连接到主机。

2. 开启仿真器。

3. 从 [Start] （中文系统：[开始 ]）菜单的 [Programs] （中文系统：[程序 ]）中选择 [E200F TM] -> 
[E200F TM]。

4. 此时启动仿真器的诊断程序并显示初始屏幕 （图3.11）。

5. 选择 [TM Version Up] （TM 版本更新）。

图 3.11   E200F 诊断程序的初始屏幕

6. [TM Version Up] （TM 版本更新）启动后，会显示如图3.12 所示的屏幕。

7. 选择 [VER UP] （版本更新）。

8. 执行并完成程序更新后，会显示如图3.13 所示的屏幕。

（如果显示如图3.14 所示的屏幕，则说明已更新到最新的诊断程序。在这种情况下，选择 [CLOSE]
（关闭）并执行 E200F 诊断程序。）

9. 选择 [CLOSE] （关闭）。

10. 此时显示 E200F 诊断程序的初始屏幕 （图3.11）。

11. 按照第 3.4.2 节 “执行诊断程序”所述的过程执行诊断程序。

选择 [TM Version Up] （[TM 版本更新 ]）。 
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图 3.12   选择 [VER UP] （版本更新）之后的屏幕

图 3.13   完成更新以后的屏幕

 
 

选择 [VER UP] （[ 版本更新 ]）。

 

 
选择 [CLOSE] （[ 关闭 ]）。
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图 3.14   已更新到最新版本时显示的屏幕

 
 

选择 [CLOSE] （[ 关闭 ]）。
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第 4 章 调试的准备工作

4.1 系统检查

执行软件时，请使用以下过程来检查是否已正确连接了仿真器。在这里，请使用产品所提供教程中的工
作区。

· 连接仿真器

1. 将仿真器连接到主机。

2. 将用户系统接口电缆连接到仿真器的连接器上。

3. 将用户系统接口电缆连接到用户系统的连接器上。

4. 开启用户系统。

5. 开启仿真器。

6. 从 [Start] （中文系统：[开始]）菜单的 [Programs] （中文系统：[程序]）中选择 [Renesas] （瑞萨） -> 
[High-performance Embedded Workshop] （高性能嵌入式工作区） -> [High-performance Embedded Workshop]
（高性能嵌入式工作区）。

图 4.1   [Start] （中文系统：[ 开始 ]）菜单

注意： [High-performance Embedded Workshop] （高性能嵌入式工作区） -> [Tools] （工具）可能不会显
示，这取决于用户环境。
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7. 此时显示 [Welcome!] （欢迎!）对话框。

图 4.2   [Welcome!] （欢迎 !）对话框

若要使用教程工作区，请选择 [Browse to another project workspace] （浏览到另一个工程工作区）单选按钮
并单击 [OK] （确定）按钮。

[Open workspace] （打开工作区）对话框打开时，请指定以下目录：
<Directory where the OS has been installed>\WorkSpace\Tutorial\E200\xxxx\Tutorial

在这里，“xxxx”表示目标 MCU 的名称。

指定目录以后，请选择以下文件并单击 [Open] （打开）按钮。

图 4.3   [Open Workspace] （打开工作区）对话框

[Create a new project workspace]
（创建新的工程工作区）单选按钮：

创建新的工作区。

[Open a recent project workspace]
（打开最近的工程工作区）单选按钮：

使用现有工作区并显示所打开工作区的历史记录。

[Browse to another project workspace]
（浏览到另一个工程工作区）单选按钮：

使用现有工作区；在所打开的工作区未保留历史记录时，使用该单选
按钮。
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8. 此时显示 [CPU Select] （CPU 选择）对话框。

图 4.4   [CPU Select] （CPU 选择）对话框

从下拉式列表中选择 CPU 并单击 [OK] （确定）按钮。

9. 此时会根据使用的 MCU 显示 [Select Emulator mode] （选择仿真器模式）对话框。

图 4.5   [Select Emulator mode] （选择仿真器模式）对话框

从 [Device] （器件）下拉式列表框中选择正在使用的 MCU 名称。在 [Mode] （模式）分组框中选择下列
项目。

— E200F Emulator （E200F 仿真器）
激活指定 MCU 的 E200F 仿真器。允许对程序进行调试。

— Writing Flash memory （写入闪存）
将用户程序编写到闪存。禁止对程序进行调试。若要下载装入模块，请在工作区中注册该模块。
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10. 此时显示 [Function select] （功能选择）对话框。

图 4.6   [Function select] （功能选择）对话框

选择要使用的仿真器功能。有关可供选择的项目，请参阅第 2.5 节 “更改设置”。

11. 此时显示 [Connecting] （连接）对话框并启动仿真器连接。

图 4.7   [Connecting] （连接）对话框

仿真器支持下列两种调试模式：

— 连接 EV 芯片单元执行调试，该连接将仿真器主部件和 H-UDI 端口连接器连接到 EV 芯片单元

— 不连接 EV 芯片单元执行调试， H-UDI 端口连接器直接连接到用户系统
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使用上述不同模式时，下面显示的系统检查过程会有所不同。

· 不连接 EV 芯片单元执行调试

(1) 此时显示如图4.8 所示的对话框。

图 4.8   复位信号输入请求消息对话框

(2) 输入用户系统的复位信号并单击 [OK] （确定）按钮。
如果没有检测到复位信号，会显示以下对话框。

图 4.9   [Can not find /RESET signal] （找不到 /RESET 信号）对话

单击 [Ignore] （忽略）按钮后，仿真器会在 CPU 中发出复位信号，以进行启动。不过，某些产品无法使用
该方法。有关详细信息，请参阅补充文件 “有关使用 SHxxxx 的补充信息”中的第 3 章 “使用 SHxxxx 时的软
件规格”。

(3) 当 HEW 的 [Output] （输出）窗口中显示 “Connected”（已连接）时，表示仿真器启动已完成。

图 4.10   [Output] （输出）窗口
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· 连接 EV 芯片单元执行调试

(1) 此时显示如图4.11 所示的对话框。

图 4.11   [Select Emulation] （选择仿真）对话框

对 EV 芯片单元进行必要的设置。选择要使用的设置并单击 [OK] （确定）按钮。

注意：可以在该对话框中设置的项目取决于所使用的仿真器。有关详细信息，请参阅在线帮助。

(2) 当 HEW 的 [Output] （输出）窗口中显示 “Connected”（已连接）时，表示仿真器启动已完成。

图 4.12   [Output] （输出）窗口
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注意：1. 如果使用带有闪存的 MCU，会打开如图 4.13 所示的对话框。输入时钟值。
时钟值是连接到目标 MCU 的晶体振荡器的频率或已输入到该 MCU 的外部时钟的频率。

图 4.13   [Clock] （时钟）对话框

2. 显示以下对话框后，请输入 ID 码作为闪存的安全代码。不过，禁止将 H'FFFFFFFF 作为 ID 码。
如果选择 [E200F Emulator]（E200F 仿真器）并且在激活仿真器时取消选择 [New ID code]（新的 
ID 码）复选框，请输入该 ID 码。如果 ID 码不符或选择了 [New ID code] （新的 ID 码）复选框，
闪存内容则被擦除。

图 4.14   [ID Code] （ID 码）对话框

注意：要在 [ID Code] （ID 码）对话框中设置的 ID 码以及 ID 码的设置因产品不同而有所不同。有关各产
品规格的详细信息，请参阅补充文件 “有关使用 SHxxxx 的补充信息”或在线帮助。
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3. 如果仿真器未启动，将显示如图 4.15 至 4.18 所示的下列对话框。

(a) 如果显示以下对话框，并且无法使用上述的第 2 种方法－ “不连接 EV 芯片单元执行调试”，
则说明可能没有给用户系统供电或复位信号可能没有输入器件。请检查用户系统电源的输入电
路和复位引脚。

图 4.15   [Can not find /RESET signal] （找不到 /RESET 信号）对话框

(b) 如果显示以下对话框，则说明用户系统可能已关闭或 H-UDI 端口连接器可能没有正确连接。请
检查用户系统是否已开启、 H-UDI 端口连接器是否已连接。

图 4.16   [Check the connection] （检查连接）对话框

(c) 如果显示以下对话框，则说明器件可能没有正常操作。请检查是否存在非法器件操作的原因。

图 4.17   [COMMUNICATION TIMEOUT ERROR] （通信超时错误）对话框

图 4.18   [Error JTAG boot] （错误 JTAG 引导）对话框

4. 如果仿真器由于其他原因而没有激活，会显示与该状态相对应的信息框。可以参考该信息来检查
板上的线路。
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4.2 激活 HEW 的方法

若要激活 HEW，请按照以下过程操作。

1. 将仿真器连接到主机和用户系统，然后开启用户系统。

2. 从 [Start] （中文系统：[开始]）菜单的 [Programs] （中文系统：[程序]）的 [Renesas High-performance 
Embedded Workshop] （瑞萨高性能嵌入式工作区）中选择 [High-performance Embedded Workshop] （高性
能嵌入式工作区）。

3. 此时显示 [Welcome!] （欢迎!）对话框。

图 4.19   [Welcome!] （欢迎 !）对话框

在本节中，我们将说明下列三种启动 HEW 的方式：

· [Create a new project workspace] （创建新的工程工作区）— 未使用工具链

· [Create a new project workspace] （创建新的工程工作区）— 正在使用工具链

· [Browse to another project workspace] （浏览到另一个工程工作区）

创建新工作区的方法取决于是否正在使用工具链。请注意，仿真器产品不包括工具链。在已安装 H8S、
H8/300 系列 C/C   编译器套件或 SuperH™ RISC engine C/C   编译器套件的环境中，可以使用工具链。有关这
一点的详细信息，请参阅 H8S、H8/300 系列 C/C   编译器套件或 SuperH™ RISC engine C/C   编译器套件附带
的手册。

[Create a new project workspace]
（创建新的工程工作区）单选按钮：

创建新的工作区。

[Open a recent project workspace]
（打开最近的工程工作区）单选按钮：

使用现有工作区并显示所打开工作区的历史记录。

[Browse to another project workspace]
（浏览到另一个工程工作区）单选按钮：

使用现有工作区；在所打开的工作区未保留历史记录时，使用该单选
按钮
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4.2.1 创建新的工作区（未使用工具链）

1. 在激活 HEW 时显示的 [Welcome!] （欢迎 !）对话框中，选择 [Create a new project workspace] （创建新
的工程工作区）单选按钮并单击 [OK] （确定）按钮。享有收费修理。

图 4.20   [Welcome!] （欢迎 !）对话框

2. 此时启动 Project Generator （工程生成器）。在本节中，我们将不对工具链的设置进行说明。
如果未购买工具链，会显示以下对话框。

图 4.21   [New Project Workspace] （新建工程工作区）对话框

[Workspace Name] （工作区名称）编辑框： 输入新的工作区名称。

[Project Name] （工程名称）编辑框： 输入工程名称。如果工程名称与工作区名称相同，则无需输入。

[Directory] （目录）编辑框： 输入将在其中创建工作区的目录名称。单击 [Browse...] （浏览…）
按钮可以选择目录。
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其他列表框用于设置工具链；如果未安装工具链，则显示固定信息。

单击 [OK] （确定）按钮。

3. 选择会话文件的目标平台。此时显示以下对话框。

图 4.22   [Setting the Target System for Debugging] （设置调试的目标系统）对话框

必须在这里选择激活 HEW 时使用的会话文件的目标。选择目标平台所对应的框，然后单击 [Next]
（下一步）按钮。
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4. 设置配置文件名。配置文件保存 HEW 的状态（仿真器除外）。

图 4.23   [Setting the Debugger Options] （设置调试程序选项）对话框

如果在如图4.22 所示的 [Setting the Target System for Debugging] （设置调试的目标系统）对话框中选择
了多个目标平台，请为每个平台设置配置文件的名称（每次都要单击 [Next] （下一个）按钮进行到下
一个目标）。

设置配置文件名是仿真器设置的最后一步。

单击 [Finish] （完成）按钮以显示 [Summary] （摘要）对话框。按 [OK] （确定）按钮会激活 HEW。

5. 激活 HEW 以后，会自动连接仿真器。此时在 [Output] （输出）窗口的 [Debug] （调试）选项卡上显示
消息“Connected”（已连接），表示已完成连接。
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4.2.2 创建新的工作区（使用工具链）

1. 在激活 HEW 时显示的 [Welcome!] （欢迎 !）对话框中，选择 [Create a new project workspace] （创建新
的工程工作区）单选按钮并单击 [OK] （确定）按钮。

图 4.24   [Welcome!] （欢迎 !）对话框

2. 此时开始创建新工作区。如果已购买工具链，会显示以下对话框。

图 4.25   [New Project Workspace] （新建工程工作区）对话框

[Workspace Name] （工作区名称）编辑框： 输入新的工作区名称。

[Project Name] （工程名称）编辑框： 输入工程名称。如果工程名称与工作区名称相同，则无需输入。

[Directory] （目录）编辑框： 输入将在其中创建工作区的目录名称。单击 [Browse...] （浏览…）
按钮可以选择目录。

[CPU family] （CPU 族）下拉式列表框： 选择目标 CPU 族。

[Tool chain] （工具链）下拉式列表框： 选择目标工具链名称（如果使用工具链）。否则，选择 [None] （无）。

[Project type] （工程类型）列表框： 选择要使用的工程类型。
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注意：如果在仿真器中选择了 [Demonstration] （演示），请注意以下内容：
[Demonstration] （演示）是一个用于仿真器的程序。在使用要生成的程序时，请删除 Printf 语句。

3. 对工具链进行必要的设置。设置完成以后，会显示以下对话框。

图 4.26   [New Project -7/9- Setting the Target System for Debugging]
（新建工程 -7/9- 设置调试的目标系统）对话框

必须在这里选择激活 HEW 时使用的会话文件的目标平台。选择目标平台所对应的框，然后单击 
[Next] （下一步）按钮。
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4. 设置配置文件名。配置保存 HEW 的状态（仿真器除外）。

图 4.27   [New Project -8/9- Setting the Debugger Options]
（新建工程 -8/9- 设置调试程序选项）对话框

仿真器设置到此结束。

按照屏幕上的指示退出工程生成器 (Project Generator)。此时激活 HEW。

5. 激活 HEW 以后，连接仿真器。不过，激活 HEW 以后，不需要立即连接仿真器。
若要连接仿真器，请使用以下方法 (a) 和 (b) 之一。有关连接过程中的操作，请参阅第 4.1 节 “系统
检查”。

(a) 在仿真器激活时进行设置以后连接仿真器

从 [Options] （选项）菜单中选择 [Debug settings] （调试设置），以打开 [Debug Settings] （调试设置）
对话框。可以注册下载模块或激活时自动执行的命令链。有关 [Debug Settings] （调试设置）对话框
的详细信息，请参阅第 4.3 节 “在仿真器激活时进行设置”。

设置 [Debug Settings] （调试设置）对话框并关闭该对话框以后，会连接仿真器。

(b) 在仿真器激活时不进行设置的情况下连接仿真器

通过转换已注册仿真器使用设置的会话文件，可以轻松连接仿真器。
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图 4.28   选择会话文件

在图4.28 上圈起的列表框中，选择会话文件名（包括在图4.27 “[New Project -8/9- Setting the Debugger 
Options] （新建工程 -8/9- 设置调试程序选项）对话框”的 [Target name] （目标名称）文本框中设置的
字符串）。该会话文件中已注册仿真器的使用设置。

选择以后，会自动连接仿真器。
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4.2.3 选择现有工作区

1. 在激活 HEW 时显示的 [Welcome!] （欢迎 !）对话框中，选择 [Browse to another project workspace]
（浏览到另一个工程工作区）单选按钮并单击 [OK] （确定）按钮。

图 4.29   [Welcome!] （欢迎 !）对话框

2. 此时显示 [Open Workspace] （打开工作区）对话框。选择已在其中创建了工作区的目录。

然后，选择工作区文件 (.hws) 并按 [Open] （打开）按钮。

图 4.30   [Open Workspace] （打开工作区）对话框

3. 这样就会激活 HEW 并恢复所选工作区在保存时的状态。

如果保存的所选工作区状态信息包括与仿真器的连接，则会自动连接仿真器。若要在保存的状态信息
不包括与仿真器的连接时连接仿真器，请参阅第 4.5 节 “连接仿真器”。
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4.3 在仿真器激活时进行设置

仿真器激活时，命令链可以自动执行。还可以注册多个要下载的装入模块。注册的装入模块会显示在工作
区窗口上。

1. 从 [Options] （选项）菜单中选择 [Debug settings] （调试设置），以打开 [Debug Settings] （调试设置）
对话框。

图 4.31   [Debug Settings] （调试设置）对话框 （[Target] （目标）页面）

2. 在 [Target] （目标）下拉式列表框中选择要连接的产品名称。

3. 在 [Default Debug Format] （默认调试格式）下拉式列表框中选择要下载的装入模块的格式，然后注册 
[Download Modules] （下载模块）列表框中相应的下载模块。

注意：此时尚未下载任何程序。有关下载的信息，请参阅第 5.2 节 “下载程序”。
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4. 单击 [Options] （选项）选项卡。

图 4.32   [Debug Settings] （调试设置）对话框 （Options] （选项）页面）

此时会注册在指定时间自动执行的命令链。可以指定下列三种时间：

· 在连接仿真器时

· 就在下载之前

· 紧接在下载之后

在 [Command batch file load timing] （命令批文件装入时间）下拉式列表框中指定执行命令链的时间。此外，
请在 [Command Line Batch Processing] （命令行批处理）列表框中，注册在指定时间执行的命令链文件。
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4.4 调试会话

HEW 将所有创建程序选项存储到配置中。类似地，HEW 将调试程序选项存储到会话中。可以将调试平台、
要下载的程序和每个调试平台的选项存储到会话中。

会话不是直接与配置相关。这意味着多个会话可以共享同一个下载模块，从而避免不必要的程序重建工作。

每个会话的数据应存储到 HEW 工程的单独文件中。下面对调试会话进行详细说明。

4.4.1 选择会话

可以通过以下两种方式选择当前会话：

· 通过工具栏

从工具栏的下拉式列表框 （图4.33）中选择会话。

图 4.33   工具栏选择

· 通过对话框

1. 选择 [Options -> Debug Sessions...] （选项 -> 调试会话…）。这样会打开 [Debug Sessions] （调试会话）
对话框 （图4.34）。

图 4.34   [Debug Sessions] （调试会话）对话框

2. 从 [Current session] （当前会话）下拉式列表中选择要使用的会话。

3. 单击 [OK] （确定）按钮设置会话。
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4.4.2 添加和移除会话

可以通过从另一个会话复制设置来添加新的会话，也可以移除会话。

· 添加新的空会话

1. 选择 [Options -> Debug Sessions...] （选项 -> 调试会话…），以显示 [Debug Sessions] （调试会话）对
话框 （图4.34）。

2. 单击 [Add...] （添加…）按钮，以显示 [Add new session] （添加新的会话）对话框（图4.35）。
3. 选择 [Add new session] （添加新的会话）单选按钮。

4. 输入会话的名称。

5. 单击 [OK] （确定）按钮，以关闭 [Debug Sessions] （调试会话）对话框。

6. 这样就会创建一个具有第 4 步中所输入名称的文件。如果已经存在一个具有该名称的文件，则显示错误
信息。

图 4.35   [Add new session] （添加新的会话）对话框

· 将现有会话导入到新的会话文件

1. 选择 [Options -> Debug Sessions...] （选项 -> 调试会话…），以显示 [Debug Sessions] （调试会话）对
话框 （图4.34）。

2. 单击 [Add...] （添加…）按钮，以显示 [Add new session] （添加新的会话）对话框（图4.35）。
3. 选择 [Use an existing session file] （使用现有会话文件）单选按钮。

4. 输入会话的名称。
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5. 输入您想要导入到现有工程的现有会话文件的名称，或者单击 [Browse] （浏览）按钮来选择文件位置。

如果未选择 [Open and maintain link to session file] （打开并维持会话文件链接）复选框，则会在工程目
录中生成导入的新会话文件。

如果选择了 [Open and maintain link to session file] （打开并维持会话文件链接）复选框，则新的会话文
件不会在工程目录中生成，而是链接到当前会话文件。

如果选择了 [Make session file link read only] （使会话文件链接具有只读属性）复选框，则链接的会话
文件将作为只读文件使用。

6. 单击 [OK] （确定）按钮，以关闭 [Debug Sessions] （调试会话）对话框。

· 移除会话

1. 选择 [Options -> Debug Sessions...] （选项 -> 调试会话…），以显示 [Debug Sessions] （调试会话）对
话框 （图4.34）。

2. 选择您想要移除的会话。

3. 单击 [Remove] （移除）按钮。

请注意，无法移除当前会话。

4. 单击 [OK] （确定）按钮，以关闭 [Debug Sessions] （调试会话）对话框。

· 查看会话属性

1. 选择 [Options -> Debug Sessions...] （选项 -> 调试会话…），以显示 [Debug Sessions] （调试会话）对
话框 （图4.34）。

2. 选择您想要查看其属性的会话。

3. 单击 [Properties] （属性）按钮，以显示 [Session Properties] （会话属性）对话框（图4.36）。

图 4.36   [Session Properties] （会话属性）对话框

· 使会话具有只读属性

1. 选择 [Options -> Debug Sessions...] （选项 -> 调试会话…），以显示 [Debug Sessions] （调试会话）对
话框 （图4.34）。

2. 选择您想要使其具有只读属性的会话。

3. 单击 [Properties] （属性）按钮，以显示 [Session Properties] （会话属性）对话框（图4.36）。
4. 选择 [Read only] （只读）复选框，使链接具有只读属性。如果要共享调试程序设置文件，并且不希望数

据被意外修改，这样做就很有用。

5. 单击 [OK] （确定）按钮。
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· 使用其他名称保存会话

1. 选择 [Options -> Debug Sessions...] （选项 -> 调试会话…），以显示 [Debug Sessions] （调试会话）对
话框 （图4.34）。

2. 选择您想要保存的会话。

3. 单击 [Save as...] （另存为…）按钮，以显示 [Save Session] （保存会话）对话框（图4.37）。
4. 浏览到新的文件位置。

5. 如果要将会话文件导出到另一个位置，请勿选择 [Maintain link] （维持链接）复选框。如果希望 HEW 
使用该位置而不是当前会话位置，请选择 [Maintain link] （维持链接）复选框。

6. 单击 [Save] （保存）按钮。

图 4.37   [Save Session] （保存会话）对话框

4.4.3 保存会话信息

· 保存会话

选择 [File -> Save Session] （文件 -> 保存会话）。
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4.5 连接仿真器

选择以下两种方式中的任意一种方式来连接仿真器：

(a) 在仿真器激活时进行设置以后连接仿真器

从 [Options] （选项）菜单中选择 [Debug settings] （调试设置），以打开 [Debug Settings] （调试设置）
对话框。可以注册下载模块或激活时自动执行的命令链。有关 [Debug Settings] （调试设置）对话框的
详细信息，请参阅第 4.3 节 “在仿真器激活时进行设置”。

设置 [Debug Settings] （调试设置）对话框并关闭该对话框以后，会自动连接仿真器。

(b) 在仿真器激活时不进行设置的情况下连接仿真器

只需将会话文件转换为已在其中注册仿真器使用设置的文件，即可连接仿真器。

图 4.38   选择会话文件

在图 4.38 上圈起的列表框中，选择会话文件名 （包括在图 4.27 “[New Project -8/9- Setting the Debugger 
Options] （新建工程 -8/9- 设置调试程序选项）对话框”的 [Target name] （目标名称）文本框中设置的字符串）。
该会话文件中已注册仿真器的使用设置。

选择会话文件名以后，会自动连接仿真器。有关会话文件的详细信息，请参阅第 4.4 节 “调试会话”。
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4.6 重新连接仿真器

仿真器断开以后，可以使用以下方式来重新连接：

选择 [Build -> Debug -> Connect] （创建 -> 调试 -> 连接）或单击 [Connect] （连接）工具栏按钮 ( )。
此时会连接仿真器。

注意：必须在 [Debug Settings] （调试设置）对话框的 [Target] （目标）下拉式列表框中选择仿真器 （请
参阅图 4.32 “[Debug Settings] （调试设置）对话框 （Options] （选项）页面）”），该对话框是
通过从 [Options] （选项）菜单中选择 [Debug settings] （调试设置）打开的。

4.7 终止仿真器

如果使用工具链，则可以使用以下两种方法来退出仿真器调试：

· 取消已激活仿真器的连接

· 退出 HEW

(1) 取消已激活仿真器的连接

从 [Debug] （调试）菜单中选择 [Disconnect] （断开）或单击 [Disconnect] （断开）工具栏按钮 

( )。

(2) 退出 HEW
从 [File] （文件）菜单中选择 [Exit] （退出）。

此时显示一个信息框。如果需要，请单击 [Yes] （是）按钮来保存会话。保存会话以后， HEW 会退出。
如果不需保存，请单击 [No] （否）按钮退出 HEW。

图 4.39   信息框
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4.8 保存会话信息

请按照以下过程从用户的主机中移除已安装的仿真器软件。由于安装的产品是在 HEW 中注册的，因此可以
在 HEW 屏幕上卸载该产品。

也可以使用 Control Panel （中文系统：控制面板）中的 [Add/Remove Programs] （中文系统：[ 添加 / 删除
程序 ]）来卸载仿真器的软件。不过，在这种情况下请注意， HEW 中的所有工具（包括编译器）都将被移除。

1. 激活 HEW。

2. 单击 [Welcome!] （欢迎!）对话框中的 [Administration...] （管理…）按钮。

图 4.40   [Welcome!] （欢迎 !）对话框

3. 此时打开 [Tools Administration] （工具管理）对话框。

图 4.41   [Tools Administration] （工具管理）对话框
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4. 单击 [Registered components]（已注册部件）列表框中 [Debugger Components]（调试程序部件）左边的 [+] 
标记，列出安装的部件。然后，突出显示要卸载的产品名称。

图 4.42   突出显示要卸载的产品

5. 单击 [Unregister] （取消注册）按钮。以下信息框显示以后，单击 [Yes] （是）按钮。

图 4.43   [Unregistering this tool] （取消注册此工具）信息框

取消 HEW 注册到此结束。然后，从主机移除仿真器文件。
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6. 单击 [Tools Administration] （工具管理）对话框中的 [Uninstaller...] （卸载程序…）按钮，打开 [Uninstall 
HEW Tool] （卸载 HEW 工具）对话框。

图 4.44   [Uninstall HEW Tool] （卸载 HEW 工具）对话框
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7. 单击 [Start] （开始）按钮，列出已安装的部件。

图 4.45   突出显示要卸载的产品

突出显示要卸载的产品名称并单击 [Uninstall] （卸载）按钮。卸载到此结束。

移除程序时，可能会检测到共享文件。如果另一个产品可能正在使用该共享文件，请勿移除该文件。如果另

一个产品在移除过程之后无法启动，请重新安装该产品。
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第 5 章 调试

本章介绍了调试操作及其相关的窗口和对话框。

5.1 设置仿真环境

下面介绍了设置仿真环境的方法。在开始调试之前，必须先正确设置此环境。

5.1.1 打开 [Configuration] （配置）对话框

选择 [Setup -> Emulator -> System...] （设置 -> 仿真器 -> 系统…）或者单击 [Emulator System] （仿真器系

统）工具栏按钮 (  ) 打开 [Configuration] （配置）对话框。
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5.1.2 [General] （常规）页连接仿真器

设置仿真器操作条件。

图 5.1   [Configuration] （配置）对话框 （[General] （常规）页面）



SH-2A、 SH-2 E200F 仿真器 第 5 章   调试

Rev.1.00  2007.09.21  Page 107 of 279
RCJ10J0048-0100

下面列出了此页面中可以显示的项目。

注意：1. 暂停中包含中断。

2. 可以在该对话框中设置的项目取决于所使用的仿真器。有关详细信息，请参阅在线帮助。

[Mode] （模式） 显示 MCU 名称。

[Emulation mode] （仿真模式） 选择执行用户程序时的仿真模式。

[Step option] （步进选项） 设置步进中断选项。

[Disable interrupts during single step execution]
（在单步执行过程中禁止断）：

在单步执行过程中禁止中断 *1。

[Enable interrupts during single step execution]
（在单步执行过程中允许中断）：

在单步执行过程中允许中断 *1。

[Read/Write on the fly] （即时读 / 写） 仿真过程中允许或禁止从存储器读取或写入到存储器。

[Disable] （禁止）：

仿真过程中禁止从存储器读取或写入到存储器。

[H-UDI Read/Write] （H-UDI 读 / 写）：

仿真过程中使用 H-UDI 从存储器读取或写入到存储器。
实时仿真会稍受影响。

[Short Break Read/Write] （短时暂停读 / 写）：

只要从存储器读取或向其写入数据便会发生暂停。实时仿
真会受影响。

[AUD clock] （AUD 时钟） 截获 AUD 跟踪时使用的时钟。如果它的频率设置过低，则
在实时跟踪过程中可能无法截获完整的数据。不要将频率
设置为超出 MCU 的 AUD 时钟的上限。只有在使用具有 
AUD 跟踪功能的仿真器时，才需要 AUD 时钟。有关 AUD 
时钟的上限，请参阅补充文件 “有关使用 SHxxxx 的补充
信息”中的第 3.2.3 节 “关于使用 JTAG (H-UDI) 时钟 
(TCK) 和 AUD 时钟 (AUDCK) 的说明”。

[AUD pin Select] （AUD 引脚选择） 设置与 AUD 引脚共享的引脚。

[JTAG clock] （JTAG 时钟） 作为通信时钟使用，但不能用来截获 AUD 跟踪。如果它
的频率设置得过低，则下载速度将降低。不要将频率设置
为超出 MCU 的可保证 TCK 范围的上限。有关 TCK 的上
限，请参阅补充文件 “有关使用 SHxxxx 的补充信息”中
的第 3.2.3 节 “关于使用 JTAG (H-UDI) 时钟 (TCK) 和 
AUD 时钟 (AUDCK) 的说明”。
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5.1.3 [Main Board] （主板）页面

设置主部件壳体操作条件。

图 5.2   [Configuration] （配置）对话框 （[Main Board] （主板）页面）
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下面列出了此页面中可以显示的项目。

注意：1. 在有些产品中，总线宽度是固定的。有关各产品的规格，请参阅在线帮助。

2. 可以在该对话框中设置的项目取决于所使用的仿真器。有关详细信息，请参阅在线帮助。

5.1.4 [EVA Board] （EVA 板）页面

设置 EV 芯片单元操作条件。

注意：当 EV 芯片单元未连接至仿真器时，该页面不会显示。

下面列出了此页面中可以显示的项目。

注意：可以在该对话框中设置的项目取决于所使用的仿真器。有关详细信息，请参阅在线帮助。

[Multi analysis mode setting]
（多重分析模式设置）

显示仿真器功能。

不能更改设置；如果要更改设置，必须再次激活仿真器。

[RealProfile Area 1 (function mode)]
（RealProfile 区域 1 （功能模式））：

选择了实时剖析功能 （测量模式：功能模式）。

[RealProfile Area 1 (nest mode)]
（RealProfile 区域 1 （嵌套模式））：

选择了实时剖析功能 （测量模式：嵌套模式）。

[Coverage (4M)] （覆盖率 (4M)）：

选择了覆盖率功能。

[AUD data bus width] （AUD 数据总线宽度） 设置 AUD 数据总线宽度。 *1

总线宽度可以选择为 4 位或 8 位。

[Change Emulation in start up]
（启动时更改仿真）

当通过连接 EV 芯片单元激活仿真器时，会显示 [Select 
Emulation] （选择仿真）对话框。

[User Signals] （用户信号） 允许从用户系统输出复位、 NMI、等待和总线请求信号。

[Multiplexed pins setting...]
（多路复用引脚设置…）

设置已由引脚功能控制器 (PFC) 设置的引脚。通过正确地
设置与信号对应的引脚可以实现下列功能：

• 监控功能

• 存储器映像功能

• 通过检测外部总线事件而执行的外部总线跟踪功能

• 通过检测外部总线事件而执行的外部总线暂停功能

选择 PFC 设置的引脚。
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5.1.5 [Bus Board] （总线板）页面

设置外部总线跟踪单元操作条件。

注意：当外部总线跟踪单元未连接至仿真器时，该页面不会显示。

图 5.3   [Configuration] （配置）对话框 （[Bus Board] （总线板）页面）
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下面列出了此页面中可以显示的项目。

注意：1. 可以在该对话框中设置的项目取决于所使用的仿真器。有关详细信息，请参阅在线帮助。

2. 当外部总线跟踪单元未连接至仿真器时，该页面不会显示。

单击 [Multiplexed pins setting...] （多路复用引脚设置…）按钮会打开 [Multiplexed pins setting] （多路复用
引脚设置）对话框。根据多路复用引脚的状态选择引脚名称。

图 5.4   [Multiplexed pins setting] （多路复用引脚设置）对话框

注意：可以在该对话框中设置的项目取决于所使用的仿真器。有关详细信息，请参阅在线帮助。

[Bus board mode setting]
（总线板模式设置）

显示外部总线跟踪单元上的调试功能。

不能更改设置；如果要更改设置，必须再次激活仿真器。

[Trace/break 6ch (Trace 262144 cycles)] （6 个跟踪 / 暂停通道
（跟踪 262144 个周期））：

已选择外部总线跟踪或暂停功能 （6 个事件检测通道）。

[Use emulation memory (4M, Trace 8192 cycles)] （使用仿真存储
器 （4M，跟踪 8192 个周期））：

已选择外部仿真存储器功能 （4 MB x 1 块）。通过跟踪可截获 
8192 个总线周期。

[Multiplexed pins setting...]
（多路复用引脚设置…）

选择多路复用的引脚的状态。

[Memory type setting...]
（存储器类型设置…）

为每个区域选择存储器类型。对于具有字节控制的 SRAM 以外
的其他区域，请选择 [Normal] （普通）。
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单击 [Memory type setting...] （存储器类型设置…）按钮会打开 [Memory type setting] （存储器类型设置）
对话框。设置板上的存储器类型。

图 5.5   [Memory type setting] （存储器类型设置）对话框

注意：此对话框因具体的产品而异。有关详细信息，请参阅在线帮助。
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5.1.6 [Option Board] （可选板）页面

设置扩展剖析单元操作条件。

注意：当扩展剖析单元未连接至仿真器时，该页面不会显示。

图 5.6   [Configuration] （配置）对话框 （[Option Board] （可选板）页面）

下面列出了此页面中可以显示的项目。

[Option board mode setting]
（可选板模式设置）

显示扩展剖析单元的功能。不能更改设置；如果要更改设置，必须再
次激活仿真器。

[RealProfile Area 2 (function mode)] （RealProfile 区域 2 （功能模式））：

选择了实时剖析功能 （测量模式：功能模式）。

[RealProfile Area 2 (nest mode)] （RealProfile 区域 2 （嵌套模式））：

选择了实时剖析功能 （测量模式：嵌套模式）。

[Coverage (8M)] （覆盖率 (8M)）：

选择了覆盖率功能。可以测量 8 MB 区域。
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5.1.7 下载到闪存

设置下载外部闪存的仿真器操作条件。

有关详细信息，请参阅第 6.21 节 “程序下载至闪存区域的功能”。

图 5.7   [Configuration] （配置）对话框 （[Loading flash memory] （装入闪存）页面）
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下面列出了此页面中可以显示的项目。

[Loading flash memory] （装入闪存） 若要进行闪存下载，需设置为 Enable （允许）。如果设置
为 Enable （允许），则在 HEW 上下载闪存时，总是会调用
写入模块。

[Disable] （禁止）：不下载到闪存

[Enable] （允许）：下载到闪存

[Erasing flash memory] （擦除闪存） 若要在写入闪存前先擦除，需设置为 Enable （允许）。如
果设置为 Enable （允许），则在调用写入模块之前先调用
擦除模块。

[Disable] （禁止）：不擦除闪存

[Enable] （允许）：擦除闪存

[File name] （文件名） 设置写入 / 擦除模块名称。已设置的文件在装入到闪存中之
前会先装入到 RAM 中。

[Bus width of flash memory]
（闪存的总线宽度）

设置闪存的总线宽度。

[Flash memory erasing time]
（闪存擦除时间）

设置闪存擦除的 TIMEOUT 值。默认时间为三分钟，如果
擦除操作需要更多时间，请增加该值。可设置的值如下：
D'0 （最小值）和 D'65535 （最大值）。只能输入正整数。

[Entry point] （进入点） 设置写入 / 擦除模块的调用目标地址 
（它必须是 RAM 地址）。

[All erasing module address] （所有擦除模块地址）：
输入擦除模块的调用目标地址。

[Writing module address] （写入模块地址）：
输入写入模块的调用目标地址。

[Access size] （存取大小）：
选择 RAM 区域的存取大小以装入可执行写入 / 擦除的模块。
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5.1.8 打开 [Memory Mapping] （存储器映像）对话框

选择 [Setup -> Emulator -> Memory Resource...] （设置 -> 仿真器 -> 存储器资源…）或者单击 [Emulator 

Memory Resource] （仿真器存储器资源）工具栏按钮 (  ) 打开 [Memory Mapping] （存储器映像）对话框。

图 5.8   [Memory Mapping] （存储器映像）对话框

此对话框显示仿真存储器的当前存储器映像和状态。

所仿真的器件的存储器配置显示在 [Status] （状态）窗口的 [Memory] （存储器）页。

注意：1. 当外部总线跟踪单元或仿真存储器单元未连接至仿真器时，该页面不会显示。

2. 可以在该对话框中设置的项目取决于所使用的仿真器。有关详细信息，请参阅在线帮助。

3. 将在该对话框中显示的项目取决于所使用的仿真器。有关详细信息，请参阅在线帮助。

[Edit...] （编辑…）： 显示 [Edit Memory Mapping] （编辑存储器映像）对话框，使用户可以修
改存储器映像的地址范围和属性。

[Reset] （复位）： 将映像存储器复位为其默认设置。

[Reset All] （全部复位）： 将所有存储器映像复位为其默认设置。

[Close] （关闭）： 关闭对话框。
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5.1.9 更改存储器映像设置

选择要更改的存储器映像设置的相关信息后，单击 [Memory Mapping] （存储器映像）对话框上的 [Edit...]
（编辑…）按钮会打开 [Edit Memory Mapping] （编辑存储器映像）对话框。

图 5.9   [Edit Memory Mapping] （编辑存储器映像）对话框

使用此对话框可以更改存储器映像的地址范围和属性。

[From] （从）： 输入映像范围的起始地址。

[Setting] （设置）： 输入存储器映像设置。

下面列出了给出的选项。

• EMULATION AREA - 32 bit （仿真区域 — 32 位）：数据总线宽度为 32 位。

• EMULATION AREA - 32 bit Read-Only （仿真区域 — 32 位只读）：

此区域具备只读属性和 32 位的数据总线宽度。

• EMULATION AREA -16 bit（仿真区域 — 16 位）：数据总线宽度为 16 位。

• EMULATION AREA -16 bit Read-Only （仿真区域 — 16 位只读）：

此区域具备只读属性和 16 位的数据总线宽度。

• EMULATION AREA -8 bit （仿真区域 — 8 位）：数据总线宽度为 8 位。

• EMULATION AREA -8 bit Read Only （仿真区域 — 8 位只读）：

此区域具备只读属性和 8 位的数据总线宽度。

• USER AREA （用户区域）：此区域指定为用户区域。

[Multiplexed Address pins 
setting] （多路复用地址引脚
设置）按钮：

• 打开 [Multiplexed Address pins setting] （多路复用地址引脚设置）对话

框，以设置多路复用地址引脚使用的状态。

• 选择 [Memory Mapping] （存储器映像）对话框中的 [- Emulation 
memory unit MAP n -]（- 仿真存储器单元映像 n -）可激活 [Multiplexed 
Address pins setting] （多路复用地址引脚设置）按钮。

• 必须为已在仿真存储器单元上安装的每个 4 MB 仿真存储器设置多路复

用地址引脚的使用状态。
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注意：1. 用于存储器映像的最小单元固定为 4 MB。
2. 当外部总线跟踪单元连接至仿真器时， 4 MB 存储器只能分配给一个区域。

当 8 MB 仿真存储器单元连接至仿真器时， 4 MB 存储器可以分配给两个区域。

当 16 MB 仿真存储器单元连接至仿真器时， 4 MB 存储器可以分配给四个区域。

因此， 4 MB 存储器最多可以分配给五个区域 （其中一个区域对应外部总线跟踪单元，而另外
四个区域将对应仿真存储器单元）。

3. 当使用安装在仿真存储器单元上的仿真存储器时，请务必设置多路复用地址引脚的使用状态。

4. 仿真存储器的性能会随着安装配置 （在外部总线跟踪单元上或是在仿真存储器单元上）的不同
而有所不同。请留意总线状态控制器 (BSC) 的设置。

5. 外部总线跟踪单元和仿真存储器单元是可选的。

6. 此对话框因具体的产品而异。有关详细信息，请参阅在线帮助。

5.1.10 [Multiplexed Address pins setting] （多路复用地址引脚设置）对话框

根据多路复用地址引脚的使用状态设置此对话框。

注意：要设置已安装在仿真存储器单元上的仿真存储器，应使用此设置的内容。如果非法设置了 
[Address pins] （地址引脚）分组框，则不会正确分配仿真存储器。

[Address pins] （地址引脚）
分组框：

根据目标 MCU 来选择地址总线引脚的使用状态。为不用作地址总线引脚
的多路复用引脚设置 [MASK] （屏蔽）。
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5.2 下载程序

本节介绍如何下载程序，以及如何查看其源代码或汇编语言助记符。

注意：发生暂停后，HEW 会显示程序计数器 (PC) 的位置。例如，在大多数情况下，如果基于 Elf/Dwarf2 
的工程移出它的原始路径，则可能无法自动找到源文件。在这种情况下， HEW 会打开一个源文件
浏览对话框，使您可以手动找到该文件。

5.2.1 下载程序

必须下载要调试的装入模块。

要下载程序，请从 [Debug -> Download] （调试 -> 下载）中选择装入模块，或者从弹出菜单中选择 
[Download] （下载）。要打开弹出菜单，请在 [Workspace] （工作区）窗口的 [Download modules] （下载模块）
中用鼠标右键单击该装入模块。

注意： 1. 在下载程序之前，必须先将该程序作为装入模块注册到 HEW 中。有关注册说明，请参阅第 4.3 节
“在仿真器激活时进行设置”。

2. 要将程序下载到外部 RAM 或仿真存储器中，必须先在下载区域中设置总线控制器和端口。
尤其应检查 SDRAM 的初始化或总线宽度的设置是否适合于用户系统。
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5.3 查看源代码

选择您的源文件，并单击 [Open] （打开）按钮，使 HEW 在集成编辑器中打开该文件。也可以通过在 
[Workspace] （工作区）窗口中双击源文件来显示它们。

图 5.10   [Editor] （编辑器）窗口

在此窗口中，下列项目作为行信息显示在左侧。

第一列 （行号列）： 行号信息

第二列 （源地址列）： 地址信息

第三列 （Onchip 事件列）： On-chip 事件信息

第四列 （AUD 事件列）： AUD 事件信息

第五列 （BUS 事件列）： 外部总线事件信息

第六列 （CodeCoverage 列）： 覆盖率信息

第七列 （软件断点列）： PC、书签和断点信息

注意：当外部总线跟踪单元未连接至仿真器时， BUS 事件列不显示。
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• 源地址列

程序下载后，当前源文件的地址会显示在源地址列上。设置 PC 值或断点时，这些地址会很有用。

• Onchip 事件列

Onchip 事件列显示以下项目：

 : 已设置 on-chip 事件的地址条件。可以设置的地址条件的数量等于 on-chip 事件通道 （可在其中设置

地址条件）的数量。

双击 Onchip 事件列会显示上面的位图符号。还可以使用弹出菜单设置此项。

图 5.11   Onchip 事件列的弹出菜单

注意：使用 [Edit] （编辑）菜单或在 [Event] （事件）窗口中向每一通道添加地址条件以外的条件时，会
擦除 Onchip 事件列的内容。

• AUD 事件列

AUD 事件列显示以下项目：

 : 已设置 AUD 断点。

 : 已设置 AUD 顺序断点。

 : 已设置 AUD 跟踪截获。

 : 已设置 AUD 跟踪开始。

 : 已设置 AUD 跟踪停止。

 : 已设置 AUD 跟踪顺序停止。

 : 已设置 AUD 性能测试开始。

 : 已设置 AUD 性能测试停止。



SH-2A、 SH-2 E200F 仿真器 第 5 章   调试

Rev.1.00  2007.09.21  Page 122 of 279
RCJ10J0048-0100

双击 AUD 事件列会显示上面的断点位图符号。还可以使用弹出菜单设置上述各项。

图 5.12   AUD 事件列的弹出菜单

注意：使用 [Edit] （编辑）菜单或在 [Event] （事件）窗口中向每一通道添加地址条件以外的条件时，会
擦除 AUD 事件列的内容。

• BUS 事件列

BUS 事件列显示下列项目：

 : 已设置外部总线断点。

 : 已设置外部总线顺序断点。

 : 已设置外部总线跟踪截获。

 : 已设置外部总线跟踪开始。

 : 已设置外部总线跟踪停止。

 : 已设置外部总线跟踪顺序停止。

双击 BUS 事件列会显示上面的断点位图符号。还可以使用弹出菜单设置上述各项。

图 5.13   BUS 事件列的弹出菜单

注意：使用 [Edit] （编辑）菜单或在 [Event] （事件）窗口中向每一通道添加地址条件以外的条件时，会
擦除 BUS 事件列的内容。

• 软件断点列

软件断点列显示以下项目：

: 已设置书签。

:  已设置软件断点。

 :  PC 位置
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 在所有源文件中关闭列

1. 在 [Editor] （编辑器）窗口上单击鼠标右键。

2. 单击 [Define Column Format...] （定义列格式…）菜单项。

3. 会显示 [Global Editor Column States] （全局编辑器列状态）对话框。

4. 复选框指示该列是否被允许。如果选中，则表示该列被允许。如果复选框为灰色，则说明该列在
某些文件中被允许，在其他文件中禁止使用。对于您要关闭的列，请取消选中其复选框。

5. 单击 [OK] （确定）按钮使新的列设置生效。

图 5.14   [Global Editor Column States] （全局编辑器列状态）对话框

在一个源文件中关闭列

1. 打开您要移除的列所在的源文件，在 [Editor] （编辑器）窗口上单击鼠标右键。

2. 单击 [Columns] （列）菜单项以显示级联菜单项。这些列将显示在此弹出菜单中。如果某个列处
于被允许状态，则在其名称旁应当有一个对勾。单击此项将会在列显示与不显示之间切换。
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5.4 查看汇编语言代码

在 [Editor] （编辑器）窗口上单击鼠标右键以打开弹出菜单，选择 [Go to Disassembly] （转至反汇编），在
当前源文件对应的地址处打开 [Disassembly] （反汇编）窗口。

如果您没有源文件，但希望查看汇编语言级的代码，则可以选择 [View -> Disassembly...] （视图 -> 反汇

编…）或单击 [Disassembly] （反汇编）工具栏按钮 (  )。 [Disassembly] （反汇编）窗口将在当前 PC 位

置处打开，并显示 [Address] （地址）和 [Code] （代码）（可选）以显示反汇编的助记符 （当有标签时还会

显示标签）。

图 5.15   [Disassembly] （反汇编）窗口

在此窗口中，下列项目作为行信息显示在左侧。

第一列 （On Chip 断点列）： On-chip 断点

第二列 （AUD 事件列）： AUD 事件信息

第三列 （BUS 事件列）： BUS 事件信息

第四列 （软件断点列）： PC 和软件断点

第五列 （反汇编地址列）： 地址信息

第六列 （目标码列）： 目标码信息

第七列 （标签列）： 标签信息

上述列的使用方法与显示源代码的窗口中列的使用方法相同。



SH-2A、 SH-2 E200F 仿真器 第 5 章   调试

Rev.1.00  2007.09.21  Page 125 of 279
RCJ10J0048-0100

5.4.1 修改汇编语言代码

双击要更改的指令打开 [Assembler] （汇编程序）对话框。您可以修改汇编语言代码。

图 5.16   [Assembler] （汇编程序）对话框

对话框上显示地址、指令代码和助记符。在 [Mnemonics] （助记符）字段中输入新指令或编辑旧指令。按 
[Enter] （回车）键将会以新指令替换存储器内容，并移至下一行指令。单击 [OK] （确定）按钮将以新指令替
换存储器内容，并关闭此对话框。单击 [Cancel] （取消）按钮或按 [Esc] 键将关闭该对话框。

注意：汇编语言显示可以从存储器中的实际机器码进行反汇编。如果存储器内容被更改，则该对话框
（及 [Disassembly] （反汇编）窗口）将显示新的汇编语言代码，但 [Editor] （编辑器）窗口的显
示内容不会更改。即使源文件包含汇编代码也是如此。

5.4.2 查看特定地址

当在 [Disassembly] （反汇编）窗口中查看程序时，您可能希望查看程序代码的其他区域。您可以直接转至
特定地址，而无需滚动查看程序中的大量代码。从弹出菜单中选择 [Set Address...] （设置地址…），将显示如
图 5.17 所示的对话框。

图 5.17   [Set Address] （设置地址）对话框

在 [Address] （地址）编辑框中输入地址或标签名称，然后单击 [OK] （确定）按钮或按 Enter 键。也可以
指定标签名称作为地址。 [Disassembly] （反汇编）窗口将会更新，以显示新地址处的代码。当输入重载函数或
类名时， [Select Function] （选择函数）对话框将打开，您可以从中选择函数。

5.4.3 查看当前程序计数器地址

在可以向 HEW 中输入地址或值的任意界面，也可以输入表达式。如果输入以 # 字符为前缀的寄存器名称，
则该寄存器的内容将用作表达式中的值。因此，如果打开 [Set Address] （设置地址）对话框并输入表达式 #pc，
则 [Editor] （编辑器）或 [Disassembly] （反汇编）窗口将显示当前 PC 地址。它还允许您输入 PC 寄存器加偏
移量形式的表达式 （如 #PC+0x100），从而显示当前 PC 的偏移量。
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5.5 实时显示存储器内容

使用 [Monitor] （监控器）窗口可以在用户程序执行期间监控存储器内容。

5.5.1 打开 [Monitor] （监控器）窗口

要打开 [Monitor] （监控器）窗口，请选择 [View -> CPU -> Monitor -> Monitor Setting...] （视图 -> CPU -> 

监控器 -> 监控器设置…）或单击 [Monitor] （监控器）工具栏按钮 ( ) 显示 [Monitor Setting] （监控器设置）

对话框。

图 5.18   [Monitor Setting] （监控器设置）对话框
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注意：也许不能选择前景色或背景色，具体取决于使用的操作系统。

设置后，单击 [OK] （确定）按钮将显示 [Monitor] （监控器）窗口。

图 5.19   [Monitor] （监控器）窗口

在用户程序执行期间，显示内容将按照自动更新间隔的设置值更新。

注意：更改地址或存储器内容后，如果数据未正确显示，请从弹出的菜单中选择 [Refresh] （刷新）。

[Name] （名称）： 指定监控器窗口的名称。

[Options] （选项）：

[Address] （地址）：

[Size] （大小）：

[Access] （存取）：

[Auto-Refresh at rate] （自动刷新速率）：

[Reading the Initial Value]
（读取初始值）：

设置监控器条件。

设置监控的起始地址。

设置监控的范围。

设置要在监控器窗口中显示的存取大小。

设置监控截获的间隔。

选择在打开监控器窗口时，读取被监控区域中的值。

[Color] （颜色）：

[Change Indicator] （变更指示符）：

[Foreground] （前景）：

[Background] （背景）：

[Mayfly]：

设置用于更新监控的方法以及颜色属性。

选择如何显示监控期间已变更的值 （选择 [Reading the 
Initial Value] （读取初始值）后可用）。

No change （无变更）：无颜色变更。

Change （变更）：颜色根据 [Foreground] （前景）和 
[Background] （背景）选项相应变更。

Gray （灰色）： 具有未变更值的数据将以灰色显示。

Appear （显示）：值只有在发生变更后才会显示。

设置显示的颜色 （选择 [Change] （变更）后可用）。

设置背景色 （选择 [Change] （变更）后可用）。

选中此框后，在指定间隔中未更新的数据的颜色将还原

为 [Background] （背景）选项中选定的颜色。指定的间

隔是指监控器截获的间隔 （选择 [Change] （变更）、

[Gray] （灰色）或 [Appear] （显示）后可用）。

[Detail] （详细信息）： 仿真器不支持。

[History] （历史记录）： 显示先前的设置。
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5.5.2 更改监控器设置

从 [Monitor] （监控器）窗口的弹出菜单中选择 [Monitor Settings...] （监控器设置…）将会显示 [Monitor Setting]
（监控器设置）对话框，使用此对话框可以对设置进行更改。通过弹出菜单的 [Color] （颜色）或 [Access] （存
取）可轻松更改颜色、存取大小和显示格式。

5.5.3 临时停止监控器更新

在用户程序执行期间， [Monitor] （监控器）窗口的显示内容将按照自动更新间隔自动更新。从 [Monitor]
（监控器）窗口的弹出菜单中选择 [Lock Refresh] （锁定刷新）将停止显示内容的更新。此时地址区段中的字
符将以黑色显示，且显示内容停止更新。

从弹出菜单中再次选择 [Lock Refresh] （锁定刷新）将取消停止状态。

5.5.4 删除监控器设置

从要删除的 [Monitor] （监控器）窗口的弹出菜单中选择 [Close] （关闭）将会关闭该 [Monitor] （监控器）
窗口，并删除监控器设置。

5.5.5 监控变量

使用 [Watch] （监视）窗口可以引用任意变量的值。

当在 [Watch] （监视）窗口中注册的变量的地址在监控功能设置的监视范围之内时，该变量的值可以更新
和显示。

此功能可在不影响实时操作的情况下检查变量的内容。

5.5.6 隐藏 [Monitor] （监控器）窗口

当使用监控功能从 [Watch] （监视）窗口中监视变量的值时，请隐藏 [Monitor] （监控器）窗口以更有效地
利用屏幕。

当选择 [Display -> CPU -> Monitor] （显示 -> CPU -> 监控器）时，当前监控信息将作为子菜单列出。该列
表由 [Monitor] （监控器）窗口的名称和起始监控地址组成。

选中列表的左侧后，将显示 [Monitor] （监控器）窗口。

如果从监控器设置列表中选中要隐藏的 [Monitor] （监控器）窗口项，则不显示 [Monitor] （监控器）窗口
并移除列表左侧的复选标记。

要再次显示 [Monitor] （监控器）窗口，请选择隐藏的 [Monitor] （监控器）窗口。

图 5.20   监控器设置列表
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5.5.7 管理 [Monitor] （监控器）窗口

选择 [Display -> CPU -> Monitor -> Windows Select...] （显示 -> CPU -> 监控器 -> 窗口选择…）后，将显示 
[Windows Select] （窗口选择）对话框。在此窗口中，当前监控条件处于选中状态，可以连续添加、编辑和删除
新的监控条件。

选择多个监控条件可临时停止更新、隐藏和删除。

图 5.21   [Windows Select] （窗口选择）对话框

[Add] （添加）： 添加新监控条件。

[Edit] （编辑）： 更改所选 [Monitor] （监控器）窗口的设置 （当选择多个项目时处于
禁止状态）。

[Lock Refresh/Unlock Refresh]
（锁定刷新 / 解除刷新锁定）：

自动更新或停止更新所选 [Monitor] （监控器）窗口的显示。

[Hide/UnHide] （隐藏 / 取消隐藏）： 显示或隐藏所选的 [Monitor] （监控器）窗口。

[Remove] （移除）： 移除所选监控条件。

[Close] （关闭）： 关闭此对话框。
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5.6 查看当前状态

选择 [View -> CPU -> Status] （视图 -> CPU -> 状态）或单击 [View Status] （查看状态）工具栏按钮 (  )，
将打开 [Status] （状态）窗口，您可看到调试平台的当前状态。

图 5.22   [Status] （状态）窗口

[Status] （状态）窗口包含三个页面：

· [Memory] （存储器）页

包含当前存储器状态的相关信息，包括存储器映像资源和当前装入的目标文件所用的区域。

· [Platform] （平台）页

包含调试平台当前状态的相关信息，通常包括 MCU 类型和仿真模式以及执行状态。

· [Events] （事件）页

包含当前事件 （断点）的状态信息，包括资源信息。
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5.7 定期读取和显示仿真器信息

使用 [Extended Monitor] （扩展监控器）窗口可以了解仿真器的变更信息 （不论用户程序是正在运行还是
已暂停）。

注意：因为扩展监控器功能会监控来自用户系统或 MCU 的信号输出，所以不影响用户程序的执行。

5.7.1 打开 [Extended Monitor] （扩展监控器）窗口

选择 [View -> CPU -> Extended Monitor] （视图 -> CPU -> 扩展监控器）或单击 [Extended Monitor] （扩展

监控器）工具栏按钮 (  ) 显示此窗口。

图 5.23   [Extended Monitor] （扩展监控器）窗口

注意：可以在此窗口中设置的项目取决于所使用的仿真器。有关详细信息，请参阅在线帮助。
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5.7.2 选择要显示的项目

从弹出菜单中选择 [Properties...] （属性…）会显示 [Extended Monitor Configuration] （扩展监控器配置）对
话框。

图 5.24   [Extended Monitor Configuration] （扩展监控器配置）对话框

用户使用此对话框可以设置要在 [Extended Monitor] （扩展监控器）窗口中显示的项目。
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5.8 使用事件点

仿真器具有事件点功能，此功能通过同时为 HEW 指定软件断点标准和更复杂的条件，来进行暂停、跟踪
和执行时间测量。

5.8.1 软件断点

获取指定地址的指令时，用户程序停止。最多可以设置 1000 个点。

5.8.2 事件点

事件点可用于更高级的条件，例如，数据条件以及指定单个地址。仿真器中最多可以设置四个事件点。

(1) Onchip Eventpoint （Onchip 事件点）

这是根据 MCU 中的信息设置事件点的功能。

对于检测到某事件后执行的操作，可指定暂停、内部跟踪截获 / 截获开始 / 截获停止或内部性能测量开始 /
结束。

通过一个或多个 Onchip 事件点的组合，可以指定更复杂的顺序条件。

该功能可在 [Event] （事件）窗口的 [Onchip Event] （Onchip 事件）页中设置。

注意：要设置的内容随产品的不同而有所差异。有关详细信息，请参阅各产品的在线帮助。

(2) AUD Eventpoint （AUD 事件点）

该功能可根据 AUD 接口的输出信息设置事件点。共有八个事件检测通道。

对于检测到某事件时执行的操作，可指定暂停、 AUD 跟踪截获 / 截获开始 / 截获停止或 AUD 性能测量开
始 / 结束。

通过一个或多个 AUD 事件点的组合，可以指定更复杂的顺序条件。

该功能可在 [Event] （事件）窗口的 [AUD Event] （AUD 事件）页中设置。

(3) BUS Eventpoint （BUS 事件点）

该功能可根据 MCU 的外部总线或中断引脚之类的引脚信息来设置事件点。共有六个事件检测通道。

对于检测到事件时执行的操作，可指定暂停或外部总线跟踪截获 / 截获开始 / 截获停止。

通过一个或多个 BUS 事件点的组合，可以指定更复杂的顺序条件。

该功能可在 [Event] （事件）窗口的 [BUS Event] （BUS 事件）页中设置。

注意：1. 外部总线跟踪单元未连接至仿真器时，不支持该功能。

2. 外部总线跟踪单元的功能变化时，事件检测通道的数目也会相应变化。有关详细信息，请参阅
第 5.1.5 节 “[Bus Board] （总线板）页面”。
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(4) Other Eventpoint （其他事件点）

该功能可在 [Event] （事件）窗口的 [Other Event] （其他事件）页中设置。

(a) Execution time eventpoint （执行时间事件点）

通过将程序执行时间指定为条件，可以定义事件点。只有一个事件检测通道。

对于检测到事件时执行的操作，可以指定暂停。

(b) External probe eventpoint （外部探针事件点）

通过将经过探针电缆的四个外部探针信号指定为条件，可定义事件点。只有一个事件检测通道。

对于检测到事件时执行的操作，可指定暂停或 AUD 跟踪截获 / 截获开始 / 截获停止。

5.8.3 打开 [Event] （事件）窗口

选择 [View -> Code -> Eventpoints] （视图 -> 代码 -> 事件点）或单击 [Eventpoints] （事件点）工具栏按钮 

(  ) 打开 [Event] （事件）窗口。

[Event] （事件）窗口具有下面五页：

[Breakpoint] （断点）页： 显示为软件断点进行的设置。还可以设置、修改和取消软件断点。

[Onchip Event] （Onchip 事件）页： 显示或设置为 on-chip 事件通道进行的设置。

[AUD Event] （AUD 事件）页： 显示或设置为 AUD 事件通道进行的设置。

[BUS Event] （BUS 事件）页： 显示或设置为外部总线事件通道进行的设置。

[Other Event] （其他事件）页： 显示或设置为其他事件通道进行的设置。
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5.8.4 设置软件断点

可以在 [Breakpoint] （断点）页上显示、修改和添加软件断点。

图 5.25   [Event] （事件）窗口 （[Breakpoint] （断点）页）

下面列出了此页中可以显示的项目。

[Type] （类型） 断点

[State] （状态） 允许还是禁止断点

[Condition] （条件） 设置了断点的地址

地址 = 程序计数器 （对应的文件名、行号和符号名）

[Action] （操作） 满足断点条件时仿真器执行的操作

暂停：暂停程序执行
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在此窗口中选择 [Add...] （添加…）或显示的软件断点，然后从弹出菜单中选择 [Edit...] （编辑），将显示 
[Breakpoint] （断点）对话框。

图 5.26   [Breakpoint] （断点）对话框

此对话框指定软件断点的地址条件。

在 [Value] （值）编辑框中指定要设置的断点地址。还可以指定 PC 寄存器，例如 #PC。最多可以指定 
1000 个断点。

要设置的内容随产品的不同而有所差异。有关详细信息，请参阅各产品的在线帮助。

选择 [Value] （值）后，如果在地址中指定包括成员函数的重载函数或类名，则会打开 [Select Function]
（选择函数）对话框。

单击 [OK] （确定）按钮会设置指定的断点条件。单击 [Cancel] （取消）按钮会关闭此对话框，而不设置
断点条件。
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5.8.5 设置 Onchip 事件点

在 [Onchip Event] （Onchip 事件）页上，可显示和修改 Onchip 事件点的设置。

图 5.27   [Event] （事件）窗口 （[Onchip Event] （Onchip 事件）页）

由于事件检测通道的数量和要设置的内容因具体的产品而异，因此请参考各产品的在线帮助。

下面列出了此页中可以显示的项目。

[Type] （类型） On-chip 事件通道编号和类型

[State] （状态） 允许还是禁止事件点

[Condition] （条件） 满足事件点的条件。显示的内容因具体的通道而异。

[Action] （操作） 满足事件点条件时仿真器执行的操作。显示的内容因具体的通道而异。
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在此窗口中双击或选择事件通道并从弹出菜单中选择 [Edit...] （编辑…）后，会打开 [Event condition x]
（事件条件 x）对话框，可以在其中修改事件点条件。

图 5.28   [Event condition x] （事件条件 x）对话框 （[Address] （地址）页）

有关 [Event condition x] （事件条件 x）对话框的详细信息，请参阅各产品的在线帮助。

在 [Combination action] （组合操作）上设置条件：

用户可以设置一个顺序条件使多个通道满足其条件的顺序。从 [Onchip Event] （Onchip 事件）页的弹出菜
单中选择 [Combination action] （组合操作）会打开 [Combination action] （组合操作）对话框，用户可以在
该对话框中指定条件的顺序。
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如何设置 [Combination action] （组合操作）：

图 5.29   [Combination action] （组合操作）对话框 （[Ch 1,2,3] （通道 1、 2、 3）组合框）

图 5.30   [Combination action] （组合操作）对话框 （[Ch 4,5] （通道 4、 5）组合框）

(a) 指示要设置条件的通道名称。

(b) 从以下选项中选择一个条件。

[Don't care] （忽略）： 不设置条件。

[Break:Ch 3-2-1]
（暂停：通道 3-2-1）：

按此顺序满足通道 3、 2、 1 上的条件时，发生暂停。

[Break:Ch 3-2-1, Reset point]
（暂停：通道 3-2-1，复位点）：

按此顺序满足通道 3、 2、 1 上的条件时，发生暂停。满足复位点条
件时，此条件复位。

[Break:Ch 2-1] （暂停：通道 2-1） 按此顺序满足通道 2 和 1 上的条件时，发生暂停。

[Break:Ch 2-1, Reset point]
（暂停：通道 2-1，复位点）：

按此顺序满足通道 2 和 1 上的条件时，发生暂停。满足复位点条件
时，此条件复位。

[I-Trace stop: Ch 3-2-1]
（I 跟踪停止：通道 3-2-1）：

按此顺序满足通道 3、 2、 1 上的条件时，跟踪截获停止。
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在 [Event Condition] （事件条件）对话框中为每个通道设置事件条件。

顺序断点扩展设置的使用示例：以产品提供的教程程序作为一个示例。有关教程程序，请参阅第 6 章
“教程”。

事件条件的条件按如下所述设置：

1. Ch1

满足条件 [Prefetch address break after executing] （执行后预取地址断点）时，中断地址 H'00001086。
2. Ch2

满足条件 [Prefetch address break after executing] （执行后预取地址断点）时，中断地址 H'00001068。
3. Ch3

满足条件 [Prefetch address break after executing] （执行后预取地址断点）时，中断地址 H'00001058。

注意：不要设置其他通道。

4. 为 [Combination action] （组合操作）对话框上的 [Break: Ch 3-2-1] （暂停：通道 3-2-1）设置 [Ch1, 2, 3]
（通道1、 2、 3）的内容。

5. 从弹出菜单中允许 Event Condition 1 （事件条件 1）的条件，弹出菜单通过在 [Event Condition] （事件
条件）页上单击鼠标右键打开。

然后，在 [Registers]（寄存器）窗口中设置程序计数器和堆栈指针（PC = H'00000800，R15 = H'FFF9F000），
再单击 [Go] （转到）按钮。如果无法正常执行，则请发出复位信号，然后再执行上述过程。

[I-Trace stop: Ch 3-2-1, Reset point]
（I 跟踪停止：通道 3-2-1，复位点）：

按此顺序满足通道 3、 2、 1 上的条件时，跟踪截获停止。满足复位
点条件时，此条件复位。

[I-Trace stop: Ch 2-1]
（I 跟踪停止：通道 2-1）：

按此顺序满足通道 2 和 1 上的条件时，跟踪截获停止。

[I-Trace stop: Ch 2-1, Reset point]
（I 跟踪停止：通道 2-1，复位点）：

按此顺序满足通道 2 和 1 上的条件时，跟踪截获停止。满足复位点
条件时，此条件复位。

[Ch 2 to Ch 1 PA]
（通道 2 到通道 1 性能分析）：

在满足通道 2 上的条件后，仿真器对性能进行分析，直到满足通道 1 
上的条件。

[Ch 1 to Ch 2 PA]
（通道 1 到通道 2 性能分析）：

在满足通道 1 上的条件后，仿真器对性能进行分析，直到满足通道 2 
上的条件。

[I-Trace: Ch 4 to Ch 5 PtoP]
（I 跟踪：通道 4 到通道 5 PtoP）：

在满足通道 4 上的条件后，仿真器截获跟踪信息，直到满足通道 5 
上的条件。

[I-Trace: Ch 4 to Ch 5 PtoP, Power on 
reset] （I 跟踪：通道 4 到通道 5 
PtoP，加电复位）：

在满足通道 4 上的条件后，仿真器截获跟踪信息，直到满足通道 5 
上的条件。加电复位验证此条件。
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执行程序直至满足通道 1 的条件，然后暂停。这里，按通道 3 -> 2 -> 1 的顺序满足条件。

图 5.31   执行暂停时的 [Editor] （编辑器）窗口 （顺序断点）

注意：可以在 [Combination action] （组合操作）对话框中设置的项目取决于所使用的仿真器。有关详细
信息，请参阅在线帮助。

5.8.6 设置 AUD 事件点

在 [AUD Event] （AUD 事件）页上，可显示和修改 AUD 事件点的设置。

图 5.32   [Event] （事件）窗口 （[AUD Event] （AUD 事件）页）

使用八个事件检测通道可设置八个事件点。

注意：1. 因为 AUD 事件点条件是根据从 MCU 的 AUD 引脚输出的信息来设置的，所以必须设置 AUD 跟
踪信息截获条件。为 AUD 事件点条件设置 AUD 跟踪信息截获条件。

2. 如果在未连接 EV 芯片单元的情况下执行调试，则无法在 AUD 事件中选择暂停功能。
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下面列出了此页中可以显示的项目。

在此窗口中双击或选择事件通道并从弹出菜单中选择 [Edit...] （编辑…）后，会显示 [Chx] （通道 x）对话框。

[Chx] （通道 x）对话框包含 [General] （常规）、 [Branch] （转移）、 [Window] （窗口）、 [Software] （软
件）、 [SystemBus] （系统总线）、 [Count] （计数）、 [Delay] （延迟）和 [Action] （操作）页。

在每页中设置的条件的组合被设置为事件点的检测条件。

[Type] （类型） AUD 事件通道编号和类型

Normal （普通）：标准事件通道

Delay （延迟）：可以设置延迟条件的事件通道

Reset （复位）：可以设置为 AUD 顺序事件的复位点的事件通道

[State] （状态） 允许还是禁止事件点

Enable （允许）：有效

Disable （禁止）：无效

[Condition] （条件） 满足事件点的条件。显示的内容因具体的通道而异。

[Action] （操作） 满足事件点条件时仿真器执行的操作。显示的内容因具体的通道而异。
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(1) [General] （常规）页

指定用于设置 AUD 事件点条件的 AUD 跟踪信息。

图 5.33   [Chx (Delay)] （通道 x （延迟））对话框 （[General] （常规）页）

[Branch trace data] （转移跟踪数据）： 根据转移跟踪信息设置事件点条件。

[Window trace data] （窗口跟踪数据）： 根据窗口跟踪信息设置事件点条件。

[Software trace data] （软件跟踪数据）： 根据软件跟踪信息设置事件点条件。
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(2) [Branch] （转移）页

指定转移跟踪的类型和地址条件。

图 5.34   [Chx (Delay)] （通道 x （延迟））对话框 （[Branch] （转移）页）

注意：1. 只有在 [General] （常规）页上指定 [Branch trace data] （转移跟踪数据）后才会显示此页。

2. 只能为 AUD 事件通道 1 和 2 指定地址范围。

3. 指定单个地址后，可以为 [Start] （起始）输入屏蔽地址。

4. 指定地址范围后，不能为 [Start] （起始）和 [End] （结束）输入屏蔽地址。

[Branch type] （转移类型）：

[Source/Destination]
（源 /目标）：

[Source] （源）：

[Destination] （目标）：

设置转移类型。

不设置转移类型。

设置转移 -源地址条件。

设置转移 -目标地址条件。

[Address] （地址）：

[Don't care] （忽略）：

[Address] （地址）：

[Range] （范围）：

[Start] （起始）：

[End] （结束）：

[Outside] （外部）：

设置地址条件。

不设置地址条件。

设置单个地址。

设置地址范围。

设置单个地址或者地址范围的起始地址。

设置地址范围的结束地址。

将单个地址或地址范围以外的值设置为条件。
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(3) [Window] （窗口）页

指定窗口跟踪的地址和数据条件。

图 5.35   [Chx (Delay)] （通道 x （延迟））对话框 （[Window] （窗口）页）

[Address] （地址）：

[Don't care] （忽略）：

[Address] （地址）：

[Range] （范围）：

[Start] （起始）：

[End] （结束）：

[Outside] （外部）：

设置地址条件。

不设置地址条件。

设置单个地址。

设置地址范围。

设置单个地址或者地址范围的起始地址。

设置地址范围的结束地址。

将单个地址或地址范围以外的值设置为条件。
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注意：1. 只有在 [General] （常规）页上指定 [Window trace data] （窗口跟踪数据）后才会显示此页。

2. 只能为 AUD 事件通道 1 和 2 指定地址范围。

3. 指定单个地址后，可以为 [Start] （起始）输入屏蔽地址。

4. 指定地址范围后，不能为 [Start] （起始）和 [End] （结束）输入屏蔽地址。

[Data] （数据）：

[Don't care] （忽略）：

[Read/Write] （读 /写）：

[Read] （读）：

[Write] （写）：

[Value] （值）：

[Byte] （字节）：

[Word] （字）：

[32 bit] （32 位）：

[64 bit] （64 位）：

[Outside] （外部）：

设置数据条件。

不设置数据条件。

将读 /写周期设置为条件。

将读周期设置为条件。

将写周期设置为条件。

设置数据总线值 （可以输入屏蔽数据）。

将字节存取设置为条件。

将字存取设置为条件。

将 32 位存取设置为条件。

将 64 位存取设置为条件。

将 [Value] （值）中已设置的值以外的值设置为条件。
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(4) [Software] （软件）页

指定软件跟踪的地址和数据条件。

图 5.36   [Chx (Delay)] （通道 x （延迟））对话框 （[Software] （软件）页）

[Address] （地址）：

[Don't care] （忽略）：

[Address] （地址）：

[Range] （范围）：

[Start] （起始）：

[End] （结束）：

[Outside] （外部）：

设置地址条件。

不设置地址条件。

设置单个地址。

设置地址范围。

设置单个地址或者地址范围的起始地址。

设置地址范围的结束地址。

将单个地址或地址范围以外的值设置为条件。

[Data] （数据）：

[Don't care] （忽略）：

[Value] （值）：

[Outside] （外部）：

设置数据条件。

不设置数据条件。

设置数据总线值 （可以输入屏蔽数据）。

将 [Value] （值）中已设置的值以外的值设置为条件。
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注意：1. 只有在 [General] （常规）页上指定 [Software trace data] （软件跟踪数据）后才会显示此页。

2. 只能为 AUD 事件通道 1 和 2 指定地址范围。

3. 指定单个地址后，可以为 [Start] （起始）输入屏蔽地址。

4. 指定地址范围后，不能为 [Start] （起始）和 [End] （结束）输入屏蔽地址。

(5) [Count] （计数）页

指定满足计数条件。

图 5.37   [Chx (Delay)] （通道 x （延迟））对话框 （[Count] （计数）页）

注意：如果在 [Action] （操作）页上选择 [Trace get] （跟踪获取），则不会显示此页。

[Don't care] （忽略）： 不设置满足计数。

[numbers] （数字）： 设置一个值作为满足计数条件；可以指定 D'1 到 D'65535 之间的值。
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(6) [Delay] （延迟）页

设置从事件检测到 AUD 跟踪停止之间的延迟周期。

图 5.38   [Chx (Delay)] （通道 x （延迟））对话框 （[Delay] （延迟）页）

注意：只有在 [Action] （操作）页上选择 AUD 事件通道 2 并指定 [Trace stop] （跟踪停止）后，才会显
示此页。

[Don't care] （忽略）： 不设置延迟条件。

[Delay] （延迟）： 设置延迟周期计数；可以指定 D'1 到 D'262143 之间的值。

[Clock] （时钟）： 为延迟测量设置一个周期。

[100ns] （100 纳秒）： 指定 100 纳秒为一个周期。

[number of trace information] （跟踪信息量）： 将一组 AUD 跟踪信息指定为一个

周期。
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(7) [Action] （操作）页

设置满足条件后的操作。

图 5.39   [Chx (Reset)] （通道 x （复位））对话框 （[Action] （操作）页）

注意：1. 对于 AUD 性能测量，使用两个 AUD 事件通道来开始和停止测量。为性能测量指定事件通道
后，还必须指定相关的通道 （通道 1 到 2、通道 3 到 4、通道 5 到 6 及通道 7 到 8）。

2. 只为 AUD 事件通道 1、 3、 5 和 7 显示 [Performance option] （性能选项）。

[Break] （暂停）： 在满足条件后暂停。

[Trace] （跟踪）： 允许 [Trace option] （跟踪选项）并设置 AUD 跟踪操作。

[Trace start] （跟踪开始）：在满足条件后开始 AUD 跟踪。

[Trace stop] （跟踪停止）：在满足条件后停止 AUD 跟踪。

[Trace get] （跟踪获取）：在满足条件后截获 AUD 跟踪。

[Performance start]
（性能开始）：

在满足条件后开始或结束 AUD 性能测量。选择此选项时，[Performance option]
（性能选项）被允许，并且可以指定性能测量的时间间隔。

Sampling time （采样时间）：将 AUD 性能测量的时间间隔指定为下列任意

值：20 ns、 100 ns、 400 ns 或 1.6 µs

[Enable output trigger]
（允许输出触发器）：

指定在满足条件后是否输出触发器。



SH-2A、 SH-2 E200F 仿真器 第 5 章   调试

Rev.1.00  2007.09.21  Page 151 of 279
RCJ10J0048-0100

(8) [Sequential AUD Event] （顺序 AUD 事件）对话框

按指定顺序满足所有 AUD 事件点条件后，便会发生顺序 AUD 事件。

可以将 AUD 事件通道 1 被指定为复位点。通过复位点时，满足的事件点条件被禁止，开始检查第一个事
件点条件。

图 5.40   [Sequential AUD Event] （顺序 AUD 事件）对话框
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注意：如果设置了顺序 AUD 事件条件，且使用 [Channel select] （通道选择）中选择的 AUD 事件通道编
辑了事件点条件，则无法修改 [Action] （操作）页。要修改 [Action] （操作）页的设置，请取消顺
序 AUD 事件条件。

[Don't care] （忽略）： 不设置顺序 AUD 事件条件。

[Channel select]
（通道选择）：

指定满足顺序 AUD 事件的顺序。

[Channel 3 -> 2] （通道 3 -> 2）：

按 AUD 事件通道 3 -> 2 的顺序满足条件后，便会发生顺序 AUD 事件。

[Channel 4 -> 3 -> 2] （通道 4 -> 3 -> 2）：

按 AUD 事件通道 4 -> 3 -> 2 的顺序满足条件后，便会发生顺序 AUD 事件。

[Channel 5 -> 4 -> 3 -> 2] （通道 5 -> 4 -> 3 -> 2）：

按 AUD 事件通道 5 -> 4 -> 3 -> 2 的顺序满足条件后，便会发生顺序 AUD 
事件。

[Channel 6 -> 5 -> 4 -> 3 -> 2] （通道 6 -> 5 -> 4 -> 3 -> 2）：

按 AUD 事件通道 6 -> 5 -> 4 -> 3 -> 2 的顺序满足条件后，便会发生顺序 
AUD 事件。

[Channel 7 -> 6 -> 5 -> 4 -> 3 -> 2] （通道 7 -> 6 -> 5 -> 4 -> 3 -> 2）：

按 AUD 事件通道 7 -> 6 -> 5 -> 4 -> 3 -> 2 的顺序满足条件后，便会发生顺序 
AUD 事件。

[Channel 8 -> 7 -> 6 -> 5 -> 4 -> 3 -> 2] （通道 8 -> 7 -> 6 -> 5 -> 4 -> 3 -> 2）：

按 AUD 事件通道 8 -> 7 -> 6 -> 5 -> 4 -> 3 -> 2 的顺序满足条件后，便会发生

顺序 AUD 事件。

[Sequential reset]
（顺序复位）：

选择是否将 AUD 事件通道 1 用作复位点。

[Disable] （禁止）：不用作复位点。

[Enable] （允许）：用作复位点。

[Action] （操作）： 指定检测到顺序 AUD 事件后的操作。

[Break] （暂停）：检测到顺序 AUD 事件后暂停。

[Trace stop] （跟踪停止）：检测到顺序 AUD 事件后停止 AUD 跟踪。
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5.8.7 设置 BUS 事件点

在 [BUS Event] （BUS 事件）页上，可显示和修改 BUS 事件点的设置。

图 5.41   [Event] （事件）窗口 （[BUS Event] （BUS 事件）页）

使用六个事件检测通道可设置六个事件点。

注意：1. 外部总线跟踪单元未连接至仿真器时，不支持该功能。

2. 再次设置外部总线跟踪单元的调试功能时，事件检测通道的数目将发生变化。

下面列出了此页中可以显示的项目。

在此窗口中双击或选择事件通道并从弹出菜单中选择 [Edit...] （编辑…）后，会显示 [Chx] （通道 x）对话框。

[Chx]（通道 x）对话框包含 [Address]（地址）、 [Data]（数据）、 [Interrupt]（中断）、 [Count]（计数）、
[Delay] （延迟）和 [Action] （操作）页。

在每页中设置的条件的组合被设置为事件点的检测条件。

[Type] （类型） 外部总线事件通道编号和类型

Normal （普通）：标准事件通道

Delay （延迟）：可以设置延迟条件的事件通道

Reset （复位）：可以设置为外部总线顺序事件的复位点的事件通道

[State] （状态） 允许还是禁止事件点

Enable （允许）：有效

Disable （禁止）：无效

[Condition] （条件） 满足事件点的条件。显示的内容因具体的通道而异。

[Action] （操作） 满足事件点条件时仿真器执行的操作。显示的内容因具体的通道而异。
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(1) [Address] （地址）页

指定地址条件。

图 5.42   [Chx (Delay)] （通道 x （延迟））对话框 （[Address] （地址）页）

[Address] （地址）：

[Don't care] （忽略）：

[Address] （地址）：

[Range] （范围）：

[Start] （起始）：

[End] （结束）：

[Outside] （外部）：

设置地址条件。

不设置地址条件。

设置单个地址。

设置地址范围。

设置单个地址或者地址范围的起始地址 （可以输入屏蔽地址）。

设置地址范围的结束地址 （可以输入屏蔽地址）。

将单个地址或地址范围以外的值设置为条件。
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(2) [Data] （数据）页

指定数据总线条件。

图 5.43   [Chx (Delay)] （通道 x （延迟））对话框 （[Data] （数据）页）

[Data] （数据）：

[Don't care] （忽略）：

[Read/Write] （读 /写）：

[Read] （读）：

[Write] （写）：

[Value] （值）：

[Outside] （外部）：

设置数据条件。

不设置数据条件。

将读 /写周期设置为条件。

将读周期设置为条件。

将写周期设置为条件。

设置数据总线值 （可以输入屏蔽数据）。

将 [Value] （值）中已设置的值以外的值设置为条件。
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(3) [Interrupt] （中断）页

指定 NMI 和外部中断的信号条件。

图 5.44   [Chx (Delay)] （通道 x （延迟））对话框 （[Interrupt] （中断）页）

注意：外部中断信号随支持的 MCU 而异。有关详细信息，请参阅在线帮助。

[Don't care] （忽略）： 不设置信号条件。

[High]： 当信号为 high 时满足条件。

[Low]： 当信号为 Low 时满足条件。
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(4) [Count] （计数）页

指定满足计数条件。

图 5.45   [Chx (Delay)] （通道 x （延迟））对话框 （[Count] （计数）页）

注意：如果在 [Action] （操作）页上选择 [Trace get] （跟踪获取），则不会显示此页。

[Don't care] （忽略）： 不设置满足计数。

[numbers] （数字）： 设置一个值作为满足计数条件；可以指定 D'1 到 D'65535 之间的值。
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(5) [Delay] （延迟）页

设置从事件检测到外部总线跟踪停止之间的延迟周期。

图 5.46   [Chx (Delay)] （通道 x （延迟））对话框 （[Delay] （延迟）页）

注意：只有在 [Action] （操作）页上选择外部总线事件通道 2 并指定 [Trace stop] （跟踪停止）后，才会
显示此页。

[Don't care] （忽略）： 不设置延迟条件。

[Delay] （延迟）： 设置延迟周期计数；可以指定 D'1 到 D'262143 之间的值。
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(6)  [Action] （操作）页

设置满足条件后的操作。

图 5.47   [Chx (Delay)] （通道 x （延迟））对话框 （[Action] （操作）页）

[Break] （暂停）： 在满足条件后暂停。

[Trace] （跟踪）： 允许 [Trace option] （跟踪选项）并设置外部总线跟踪操作。

[Trace start] （跟踪开始）：在满足条件后开始外部总线跟踪。

[Trace stop] （跟踪停止）：在满足条件后停止外部总线跟踪。

[Trace get] （跟踪获取）：在满足条件后截获外部总线跟踪。
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(7) [Sequential BUS Event] （顺序 BUS 事件）对话框

按指定顺序满足所有 BUS 事件点条件后，便会发生顺序总线事件。

可以将总线事件通道 1 指定为复位点。通过复位点时，满足的事件点条件被禁止，开始检查第一个事件点
条件。

图 5.48   [Sequential BUS Event] （顺序 BUS 事件）对话框

[Don't care] （忽略）： 不设置顺序 BUS 事件条件。

[Channel select]
（通道选择）：

指定满足顺序 BUS 事件的顺序。

[Channel 3 -> 2] （通道 3 -> 2）：

按总线事件通道 3 -> 2 的顺序满足条件后，便会发生顺序 BUS 事件。

[Channel 4 -> 3 -> 2] （通道 4 -> 3 -> 2）：

按总线事件通道 4 -> 3 -> 2 的顺序满足条件后，便会发生顺序 BUS 事件。

[Channel 5 -> 4 -> 3 -> 2] （通道 5 -> 4 -> 3 -> 2）：

按总线事件通道 5 -> 4 -> 3 -> 2 的顺序满足条件后，便会发生顺序 BUS 事件。

[Channel 6 -> 5 -> 4 -> 3 -> 2] （通道 6 -> 5 -> 4 -> 3 -> 2）：

按总线事件通道 6 -> 5 -> 4 -> 3 -> 2 的顺序满足条件后，便会发生顺序 BUS 
事件。
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注意：如果设置了顺序 BUS 事件条件，且使用 [Channel select] （通道选择）中选择的总线事件通道编
辑了事件点条件，则无法修改 [Action] （操作）页。要修改 [Action] （操作）页的设置，请取消顺
序 BUS 事件条件。

5.8.8 设置其他事件点

在 [Other Event] （其他事件）页上，可显示和修改其他事件点的设置。

图 5.49   [Event] （事件）窗口 （[Other Event] （其他事件）页）

下面列出了此页中可以显示的项目。将根据所用的可选单元的状态添加显示内容。

在此窗口中双击或选择事件通道并从弹出菜单中选择 [Edit...] （编辑…）后，会显示设置条件的对话框。
此对话框的显示内容因事件通道而异。

[Sequential reset]
（顺序复位）：

选择是否将总线事件通道 1 用作复位点。

[Disable] （禁止）：不用作复位点。

[Enable] （允许）：用作复位点。

[Action] （操作）： 指定检测到顺序 BUS 事件后的操作。

[Break] （暂停）：检测到顺序 BUS 事件后暂停。

[Trace stop] （跟踪停止）：检测到顺序 BUS 事件后停止外部总线跟踪。

[Type] （类型） 其他事件通道

Probe （探针）：外部探针事件通道

Runtime Count （运行时计数）：执行时事件通道

[State] （状态） 允许还是禁止事件点

Enable （允许）：有效

Disable （禁止）：无效

[Condition] （条件） 满足事件点的条件。显示的内容因具体的通道而异。

[Action] （操作） 满足事件点条件时仿真器执行的操作。显示的内容因具体的通道而异。
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(1) [Probe] （探针）对话框

双击 [Probe] （探针）事件通道可显示此对话框。可以在 [Condition] （条件）和 [Action] （操作）页上设
置事件点的条件。

(a) [Condition] （条件）页：

指定通过外部探针电缆的四个外部探针信号条件。

图 5.50   [Probe] （探针）对话框 （[Condition] （条件）页）

[Operation] （操作）： 指定如何组合探针信号条件。

[AND] （与）：确定是否通过探针信号条件的 “与”操作满足条件。

[OR] （或）：确定是否通过探针信号条件的 “或”操作满足条件。

[Probe 1 to 4] （探针 1 到 4）： 指定探针信号条件。

[Don't care] （忽略）：不指定探针信号条件。

[High]：当探针信号为 high 时满足条件。

[Low]：当探针信号为 low 时满足条件。
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(b)  [Action] （操作）页：

设置满足条件后的操作。

图 5.51   [Probe] （探针）对话框 （[Action] （操作）页）

[Break] （暂停）： 在满足条件后暂停。

[Trace] （跟踪）： 允许 [AUD trace option] （AUD 跟踪选项）并设置 AUD 跟踪操作。

[Trace start] （跟踪开始）：在满足条件后开始 AUD 跟踪。

[Trace stop] （跟踪停止）：在满足条件后停止 AUD 跟踪。

[Trace filter] （跟踪过滤器）：设置在满足条件后截获 AUD 跟踪的过滤器

条件。
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(2) [Runtime Count] （运行时计数）对话框

双击 [Runtime Count] （运行时计数）事件通道显示此对话框。可以在 [Condition] （条件）和 [Action]
（操作）页上设置事件点的条件。

(a) [Condition] （条件）页：

指定用户程序的执行时间。

图 5.52   [Runtime Count] （运行时计数）对话框 （[Condition] （条件）页）

[The minimum time to be 
measured]
（测量的最短时间）：

将执行时间测量定时器的分辨率指定为下列任意值：20 ns、100 ns、400 ns 
或 1.6 µs

[Runtime count]
（运行时计数）：

指定执行时间条件。

[Don't care] （忽略）：不指定执行时间条件。

[Cycle] （周期）：输入测量周期计数；可以为 D'0 到 D'1099511627775 之间

的值。
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(b) [Action] （操作）页：

设置满足条件后的操作。

图 5.53   [Runtime Count] （运行时计数）对话框 （[Action] （操作）页）

[Break] （暂停）： 在满足条件后暂停。
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5.8.9 编辑断点或事件点

选择要修改的断点条件，从弹出菜单中选择 [Edit...] （编辑…）打开该点的对话框，用户可以使用此对话
框修改断点或事件点。只有选择一个断点或事件点后， [Edit...] （编辑…）菜单才可用。

5.8.10 允许断点或事件点

选择断点或事件点，然后从弹出菜单中选择 [Enable] （允许）以允许选定的断点或事件点。

5.8.11 禁止断点或事件点

选择断点或事件点，然后从弹出菜单中选择 [Disable] （允许）以禁止选定的断点或事件点。禁止断点或事
件点后，即使符合指定条件也无法满足该条件。

5.8.12 删除断点或事件点

选择断点或事件点，然后从弹出菜单中选择 [Delete] （删除）以删除选定的断点或事件点。要保留断点条
件，但又不希望它在满足条件时引发事件，请使用 [Disable] （禁止）选项 （请参见第 5.8.11 节 “禁止断点或
事件点”）。

5.8.13 删除所有断点或事件点

从弹出菜单中选择 [Delete All] （全部删除）可删除所有断点或事件点。

5.8.14 查看断点或事件点的源代码行

选择断点或事件点，然后从弹出菜单中选择 [Go to Source] （转至源代码），在该断点或事件点的地址处
打开 [Editor] （编辑器）或 [Disassembly] （反汇编）窗口。仅当选择的断点或事件点具有对应的源文件时，
[Go to Source] （转至源代码）菜单才可用。
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5.9 查看跟踪信息

仿真器具备跟踪截获 MCU 内部和外部信息的功能。仿真器可截获三种类型的跟踪信息：内部跟踪 
(Internal trace)、 AUD 跟踪 (AUD trace) 和外部总线跟踪 (BUS trace)。

[Internal/AUD] （内部 /AUD）窗口中显示了有关内部跟踪和 AUD 跟踪的信息。 [BUS trace] （BUS 跟踪）
窗口中显示了有关 BUS 跟踪的信息。

有关跟踪功能的说明，请参阅第 6.19 节 “跟踪功能”。

5.9.1 打开 [Internal/AUD] （内部 /AUD）窗口

要显示 [Trace Window Type]（跟踪窗口类型）对话框，请选择 [View -> Code -> Trace]（视图 -> 代码 -> 跟

踪）或单击 [Trace] （跟踪）工具栏按钮 (  )。

图 5.54   [Trace Window Type] （跟踪窗口类型）对话框

选择 [Internal/AUD] （内部 /AUD）并单击 [OK] （确定）按钮，将显示 [Internal/AUD] （内部 /AUD）窗口。

(1) 截获内部跟踪信息 (Internal trace)

在 [Internal/AUD] （内部 /AUD）窗口的弹出菜单中选择 [Set...] （设置…）菜单，将显示 [I-Trace/AUD-
Trace acquisition] （I 跟踪 /AUD 跟踪截获）对话框。如果在该对话框内的 [Trace Type] （跟踪类型）中选择 
[Internal trace] （内部跟踪），则使用内部跟踪功能来截获跟踪信息。

如果仿真器未设置跟踪信息的截获条件，则默认使用内部跟踪功能来截获跟踪信息。

截获的跟踪信息在 [Internal/AUD] （内部 /AUD）窗口中显示。

图 5.55   [Internal/AUD] （内部 /AUD）窗口 （类型 1）（内部跟踪）

某些待调试的 MCU 显示下面所列的项目。有关各产品规格的详细信息，请参阅补充文件 “有关使用 
SHxxxx 的补充信息”或在线帮助。
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[PTR] 跟踪缓冲器指针 （+0 代表上次执行的指令）

[IP] 截获的跟踪信息的数量

[Master] （主控器）
（总线主控器）

存取的总线主控器的类型

[Type] （类型） 跟踪信息的类型：

BRANCH：转移源

DESTINATION：转移目标

MEMORY：存储器存取

S_TRACE：已执行的 Trace(x) 函数

LOST：丢失的跟踪信息 （仅在实时模式中显示）

[Branch Type] （转移类型） 转移类型 （仅在截获转移跟踪时显示）：

GENERAL：常规转移

SUBROUTINE：子程序转移

EXCEPTION：异常转移

[Bus] （总线） 正在存取的总线

[R/W] 生成的数据与读或写存取是否关联

[Address] （地址） 地址

[Data] （数据） 生成的数据存取的数据。如果 [Type] （类型）为 S_TRACE，则显示值 x
（函数 Trace(x) 的变量）。

[Instruction] （指令） 指令助记符

[Source] （源） C/C++ 或汇编语言源程序

[Label] （标签） 标签信息
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(2) 截获 AUD 跟踪信息 (AUD trace)

在 [Internal/AUD] （内部 /AUD）窗口的弹出菜单中选择 [Set...] （设置…）菜单，将显示 [I-Trace/AUD-
Trace acquisition] （I 跟踪 /AUD 跟踪截获）对话框。如果在该对话框内的 [Trace Type] （跟踪类型）中选择 
[AUD trace] （AUD 跟踪），则使用 AUD 跟踪功能来截获跟踪信息。

图 5.56   [Internal/AUD] （内部 /AUD）窗口 （类型 2）（AUD 跟踪）

此窗口显示下列跟踪信息项目 （某些产品中不显示其中某些信息）：

注意：不同产品显示的内容有所不同，因此请参阅各个产品的在线帮助。某些支持的 MCU 可能不具备 
AUD 跟踪功能。

[PTR] AUD 跟踪缓冲器指针 （+0 代表上次执行的指令）

[IP] 截获的跟踪信息的数量

[Type] （类型） 跟踪信息的类型：

BRANCH：转移源

DESTINATION：转移目标

MEMORY：存储器存取

S_TRACE：已执行的 Trace(x) 函数

LOST：丢失的跟踪信息 （仅在实时模式中显示）

[Bus] （总线） 正在存取的总线

[R/W] 生成的数据与读或写存取是否关联

[Address] （地址） 地址

[Data] （数据） 生成的数据存取的数据。如果 [Type] （类型）为 S_TRACE，则显示值 x
（函数 Trace(x) 的变量）。

[Instruction] （指令） 指令助记符

[Timestamp] （时戳） 时戳值

[Source] （源） C/C++ 或汇编语言源程序

[Label] （标签） 标签信息

[Timestamp-Difference]
（时戳差）

时戳的差值
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(3) 指定截获跟踪信息的条件或模式

跟踪缓冲器的容量是有限的。当缓冲器容量已满时，将盖写最旧的跟踪信息。设置跟踪截获条件后，便可
截获有用的跟踪信息，并有效使用跟踪缓冲器。

可通过事件点实现跟踪信息截获条件，并控制截获开始、截获结束和截获操作。有关设置事件点的详细信
息，请参阅第 5.8 节 “使用事件点”。

从弹出菜单中选择 [Set...] （设置…）后将显示 [I-Trace/AUD-Trace acquisition] （I 跟踪 /AUD 跟踪截获）
对话框，使用该对话框可设置跟踪信息截获模式。

图 5.57   [I-Trace/AUD-Trace acquisition] （I 跟踪 /AUD 跟踪截获）对话框
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[Trace type] （跟踪类型）：

[I-Trace] （I 跟踪）

[AUD function]
（AUD 功能）

选择跟踪功能的类型。

选择内部跟踪功能。

选择 AUD 跟踪功能。

[I-Trace mode] （I 跟踪模式）：

[Type] （类型）

[Acquisition] （截获）

[When trace buffer full]
（当跟踪缓冲器已满时）

设置使用内部跟踪功能时的模式。

选中该选项将同时选中总线和转移，并将其设置为截获跟踪的条件。

当选中这些框时，仅截获与选中条件匹配的内部信息。

选择当跟踪缓冲器变满时执行的操作。

[Trace continue] （跟踪继续） 盖写旧的跟踪信息，以截获最新

的跟踪信息。

[Trace stop] （跟踪停止） 不截获信息。

[Break] （暂停） 出现暂停。

[AUD mode] （AUD 模式）：

[Branch trace]
（转移跟踪）

[Window trace]
（窗口跟踪）

[AUD mode 1]
（AUD 模式 1）

[AUD mode 2]
（AUD 模式 2）

[AUD mode 3]
（AUD 模式 3）

[AUD trace display range]
（AUD 跟踪显示范围）：

设置使用 AUD 跟踪功能时的模式。

选中此框后，将转移源和目标地址设置为条件。

使用窗口跟踪功能。选中此框后，将截获指定范围内的存储器存取信息。

选择此操作模式可以进行连续跟踪截获。

[Realtime trace] （实时跟踪）  不截获某些跟踪信息。

[Non realtime trace] （非实时跟踪）  完成截获后 CPU 才会停止操作。

选择当跟踪缓冲器变满时执行的操作。

[Trace continue] （跟踪继续） 盖写旧的跟踪信息，

以截获最新的跟踪信息。

[Trace stop] （跟踪停止） 不截获信息。

[Break] （暂停） 出现暂停。

设置使用 AUD 跟踪功能时的模式。

[Enable free trace] （允许自由跟踪） 选中此项后，将忽略 AUD 事件

点的设置，并截获全部跟踪信息。

[Time stamp clock] （时戳时钟） 将时戳定时器的分辨率指定为下

列任意值：20 ns、100 ns、400 ns 
或 1.6 µs

设置使用 AUD 跟踪功能时的跟踪显示范围。

[Start pointer] （起始指针） 输入显示范围的数字起始指针值。

[End pointer] （结束指针） 输入显示范围的数字结束指针值。
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注意：1. 选择 [Internal trace] （内部跟踪）后， [AUD MODE] （AUD 模式）、 [AUD mode 1] （AUD 模
式 1）、 [AUD mode 2]（AUD 模式 2）、 [AUD mode 3]（AUD 模式 3）和 [AUD trace display 
range] （AUD 跟踪显示范围）处于禁止状态。

2. 仅在选择 [AUD trace] （AUD 跟踪）后，才会允许 [AUD MODE] （AUD 模式）、 [AUD mode 1]
（AUD 模式 1）、 [AUD mode 2] （AUD 模式 2）、 [AUD mode 3] （AUD 模式 3）和 [AUD 
trace display range] （AUD 跟踪显示范围）。

3. 不同产品的可用跟踪截获条件也有所不同，因此请参阅各产品的在线帮助。

4. 某些 MCU 不具备 AUD 跟踪功能。

单击 [OK] （保存）按钮存储这些设置。单击 [Cancel] （取消）按钮关闭此对话框，不修改设置。

5.9.2 打开 [BUS trace] （BUS 跟踪）窗口

要显示 [Trace Window Type]（跟踪窗口类型）对话框，请选择 [View -> Code -> Trace]（视图 -> 代码 -> 跟

踪）或单击 [Trace] （跟踪）工具栏按钮 ( )。

图 5.58   [Trace Window Type] （跟踪窗口类型）对话框

选择 [BUS trace] （BUS 跟踪）并单击 [OK] （确定）按钮，将显示 [BUS trace] （BUS 跟踪）窗口。

注意：1. 如果外部总线跟踪单元未连接至仿真器，则不支持外部总线跟踪功能。

2. 外部总线跟踪单元的功能改变时，外部总线跟踪可以截获的总线周期数也会发生改变。有关详
细信息，请参阅第 5.1.5 节 “[Bus Board] （总线板）页面”。

3. 此窗口不仅能够显示 BUS 跟踪功能，还能显示其他跟踪功能，这取决于您所使用的产品。有关
各产品规格的详细信息，请参阅在线帮助。
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5.9.3 截获外部总线跟踪信息 (BUS trace)

在 [BUS trace] （BUS 跟踪）窗口的弹出菜单中选择 [Set...] （设置…）菜单，将显示 [BUS acquisition]
（BUS 截获）对话框。如果在该对话框内的 [Trace Type] （跟踪类型）中选择 [BUS trace] （BUS 跟踪），则使
用外部总线跟踪功能来截获跟踪信息。

如果仿真器未设置跟踪信息的截获条件，则默认使用外部总线跟踪功能来截获跟踪信息。

截获的跟踪信息在 [BUS trace] （BUS 跟踪）窗口中显示。

图 5.59   [BUS trace] （BUS 跟踪）窗口 （类型 1）（BUS 跟踪）

下面列出了此窗口中可以显示的项目。有关各产品规格的详细信息，请参阅在线帮助。

[PTR] 总线跟踪缓冲器指针 （+0 代表上次执行的指令）

[IP] 截获的跟踪信息的数量

[R/W] 生成的数据与读或写存取是否关联

[Address] （地址） 地址

[Data] （数据） 数据总线值

[Timestamp] （时戳） 总线周期的时戳

[Source] （源） C/C++ 或汇编语言源程序

[Label] （标签） 标签信息

[Timestamp-Difference]
（时戳差）

时戳的差值
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5.9.4 指定截获跟踪信息的条件或模式

跟踪缓冲器的容量是有限的。当缓冲器容量已满时，将盖写最旧的跟踪信息。设置跟踪截获条件后，便可
截获有用的跟踪信息，并有效使用跟踪缓冲器。

可通过事件点实现跟踪信息截获条件，并控制截获开始、截获结束和截获操作。有关设置事件点的详细信
息，请参阅第 5.8 节 “使用事件点”。

从弹出菜单中选择 [Set...] （设置…）后将显示 [BUS acquisition] （BUS 截获）对话框，使用该对话框可设
置跟踪信息截获模式。

图 5.60   [BUS acquisition] （BUS 截获）对话框
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注意：在某些产品中，除总线跟踪功能外，还可在此窗口中设置其他跟踪功能。有关各产品的规格，请参
阅在线帮助。

5.9.5 隐藏 [Trace] （跟踪）列

可以在 [Trace] （跟踪）窗口中隐藏任何不需要的列。用鼠标右键单击标题列，从显示的弹出菜单中选择
要隐藏的列，便可隐藏该列。要显示隐藏的列，请从上述弹出菜单中重新选择该列。使用鼠标拖动该列可更改
显示顺序。

5.9.6 搜索跟踪记录

使用 [Trace Find] （跟踪查找）对话框可以搜索跟踪记录。要打开此对话框，请从弹出的菜单中选择 
[Find...] （查找…）。

[Trace Find] （跟踪查找）对话框包含下列选项：

注意：[General] （常规）和 [Address] （地址）以外的项目因所用仿真器的不同而不同。有关详细信息，
请参阅在线帮助。

[Trace type] （跟踪类型）： 选择跟踪截获的类型。

[BUS buffer over flow]
（BUS 缓冲器溢出）：

[Trace continue] （跟踪继续）

[Trace stop] （跟踪停止）

[Break] （暂停）

指定当仿真器的外部总线跟踪缓冲器变满时执行的操作。

最新信息将盖写最旧的跟踪信息。

当跟踪缓冲器容量已满时，不再截获跟踪信息。

出现暂停。

[BUS trace mode]
（BUS 跟踪模式）：

[Enable free trace]（允许自由跟踪）

[Time stamp clock] （时戳时钟）

设置使用外部总线跟踪功能时的模式。

允许外部总线自由跟踪。

将时戳定时器的分辨率指定为下列任意值：20 ns、 100 ns 或 
400 ns

[Trace display range]
（跟踪显示范围）：

[Start pointer] （起始指针）

[End pointer] （结束指针）

设置跟踪显示范围。

输入显示范围的数字起始指针值。

输入显示范围的数字结束指针值。

表 5.1   [Trace Find] （跟踪查找）对话框页

Page （页） Description （说明）

[General] （常规） 设置搜索范围。

[Address] （地址） 设置地址条件。

[Data] （数据） 设置数据条件。

[Type] （类型） 选择跟踪信息的类型。

[Bus] （总线） 选择总线类型。

[R/W] 选择存取周期的类型。
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在上述页中设置条件后，单击 [OK] （确定）按钮存储设置并开始搜索。单击 [Cancel] （取消）按钮关闭
此对话框，不设置条件。

如果找到与搜索条件匹配的跟踪记录，则突出显示该跟踪记录所在的行。如果未找到任何匹配的跟踪记录，
则显示一个信息对话框。

仅搜索满足上述页面中所设的所有条件的跟踪信息。

如果搜索操作成功，则选择弹出菜单中的 [Find Next] （查找下一个）将移动到下一个找到的项。

(1) [General] （常规）页

设置搜索范围。

图 5.61   [Trace Find] （跟踪查找）对话框 （[General] （常规）页）

注意：设置搜索范围时，可在 [Start PTR] （起始 PTR）和 [End PTR] （结束 PTR）选项中分别设置用以
开始和结束搜索的 PTR 值。

[Trace search range]
（跟踪搜索范围）：

[Not designation] （未指定）：

[Upward search] （向上搜索）：

[Start PTR] （起始 PTR）：

[End PTR] （结束 PTR）：

设置搜索范围。

选中此复选框后，将搜索与其他页中设置的条件不匹配的信息。

选中此复选框后将向上搜索。

输入用以开始搜索的 PTR 值。

输入用以结束搜索的 PTR 值。
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(2) [Address] （地址）页

设置地址条件。

图 5.62   [Trace Find] （跟踪查找）对话框 （[Address] （地址）页）

(3) [Data] （数据）页

设置数据条件。

图 5.63   [Trace Find] （跟踪查找）对话框 （[data] （数据）页）

[Don't care] （忽略）： 选中此框后将不检测任何地址。

[Setting] （设置）：

[Value] （值）：

检测指定的地址。

输入地址值 （选中 [Don't care] （忽略）后不可用）。

[Don't care] （忽略）： 选中此框后将不检测任何数据。

[Setting] （设置）：

[Value] （值）：

检测指定的数据。

输入数据值 （选中 [Don't care] （忽略）后不可用）。
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(4) [R/W] 页

选择存取周期的类型。

图 5.64   [Trace Find] （跟踪查找）对话框 （[R/W] 页）

(5) [Type] （类型）页

选择存取的类型。截获时戳后此选项不可用。

图 5.65   [Trace Find] （跟踪查找）对话框 （[Type] （类型）页）

[Don't care] （忽略）： 选中此框后不检测任何读 / 写条件。

[Setting] （设置）：

[String] （字符串）：

检测指定的读 / 写条件。

选择读 /写条件 （选中 [Don't care] （忽略）后不可用）。

READ：读周期

WRITE：写周期

[Don't care] （忽略）： 选中此框后将不检测任何类型条件。

[Setting] （设置）：

[String] （字符串）：

检测指定的类型条件。

选择类型条件 （选中 [Don't care] （忽略）后不可用）。
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(6) [Bus] （总线）页

选择总线状态。

图 5.66   [Trace Find] （跟踪查找）对话框 （[Bus] （总线）页）

5.9.7 清除跟踪信息

从弹出菜单中选择 [Clear] （清除）后，用于存储跟踪信息的跟踪缓冲器将清空。

5.9.8 在文件中保存跟踪信息

从弹出菜单中选择 [Save...] （保存…）会打开 [Save As] （另存为）文件对话框，用户使用该对话框可以将 
[Trace] （跟踪）窗口中显示的信息保存为文本文件。可以基于 [PTR] 编号指定范围（保存完整的缓冲器可能需
要几分钟时间）。请注意此文件无法再装入到 [Trace] （跟踪）窗口。

注意：在过滤跟踪信息时，不能选择保存的范围。过滤后 [Trace] （跟踪）窗口中显示的所有跟踪信息将
得以保存。如果希望保存选定的范围，请在 [Trace Filter] （跟踪过滤器）对话框中的 [General]
（常规）页中选择过滤范围。有关过滤功能的详细信息，请参阅第 5.9.13 节 “从截获的信息中提
取记录”。

5.9.9 查看 [Editor] （编辑器）窗口

可以通过以下两种方式显示所选跟踪记录相应的 [Editor] （编辑器）窗口：

· 选择跟踪记录，并从弹出菜单中选择 [View Source] （查看源代码）。

· 双击跟踪记录。

此时打开 [Editor] （编辑器）或 [Disassembly] （反汇编）窗口，并将光标置于选定的行上。

[Don't care] （忽略）： 选中此框后将不检测任何总线条件。

[Setting] （设置）：

[String] （字符串）：

检测指定的总线条件。

选择总线条件 （选中 [Don't care] （忽略）后不可用）。
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5.9.10 微调源代码

从弹出菜单中选择 [Trim Source] （微调源代码）可移除源代码左侧的空白。

移除空白后， [Trim Source] （移除源代码）菜单的左侧将显示复选标记。要还原空白，请在出现复选标记
时选择 [Trim Source] （移除源代码）。

5.9.11 暂时停止跟踪截获

要在用户程序执行期间暂时停止跟踪截获，请从弹出菜单中选择 [Halt] （暂停）。此时将停止跟踪截获，
并更新跟踪显示。使用此方法可以在不停止用户程序执行的情况下检查跟踪信息。

5.9.12 重新启动跟踪截获

要在用户程序执行期间重新启动停止的跟踪截获，请从弹出菜单中选择 [Restart] （重新启动）。

5.9.13 从截获的信息中提取记录

使用过滤功能可以从截获的跟踪信息中提取所需的记录。使用过滤功能，可以通过软件来过滤由硬件截获
的跟踪信息。在 [Trace Acquisition] （跟踪截获）对话框中进行设置后可根据不同的条件来截获跟踪信息，与此
不同，通过多次更改过滤设置来过滤所截获的跟踪信息，可以轻松提取必需信息，这对于数据分析非常有用。
即便使用过滤功能，跟踪缓冲器的内容也不会更改。跟踪缓冲器的容量有限，因此，通过 [Trace Acquisition]
（跟踪截获）设置尽可能更多地截获有用的信息以提高数据分析的效率。

使用 [Trace Filter] （跟踪过滤器）对话框中的过滤功能。要打开 [Trace Filter] （跟踪过滤器）对话框，请
从弹出的菜单中选择 [Filter...] （过滤器…）。

[Trace Filter] （跟踪过滤器）对话框包含下列页：

注意：[General] （常规）和 [Address] （地址）以外的项目因所用仿真器的不同而不同。有关详细信息，
请参阅在线帮助。

设置过滤条件，然后按 [OK] （确定）按钮。这样可根据条件启动过滤。单击 [Cancel] （取消）按钮关闭 
[Trace Filter] （跟踪过滤器）对话框，保留该对话框打开时的设置。

过滤时， [Trace] （跟踪）窗口仅显示满足上述页面所设置的一个或多个过滤条件的跟踪信息。

由于过滤不会更改跟踪缓冲器的内容，因此在分析数据时可多次更改过滤条件。

表 5.2   [Trace Filter] （跟踪过滤器）对话框页

Page （页） Description （说明）

[General] （常规） 选择过滤范围。

[Address] （地址） 设置地址条件。

[Data] （数据） 设置数据条件。

[Type] （类型） 选择跟踪信息的类型。

[Bus] （总线） 选择总线类型。

[R/W] 选择存取周期的类型。
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(1) [General] （常规）页

设置过滤范围。

图 5.67   [Trace Filter] （跟踪过滤器）对话框 （[General] （常规）页）

注意：设置过滤范围时，可在 [Start PTR] （起始 PTR）和 [End PTR] （结束 PTR）选项中分别设置用以
开始和结束过滤的 PTR 值。

[Don't care other pages]
（忽略其他页）：

仅在选中此框的情况下选择周期编号。其他选项将无效。

[Enable Filter]
（允许过滤器）：

选中此框时将允许过滤器。

[Not designation] （未指定）： 选中此复选框后，将过滤与上述页中设置的条件不匹配的信息。

[Trace display range]
（跟踪显示范围）：

[Start PTR] （起始 PTR）：

[End PTR] （结束 PTR）：

设置过滤范围。

输入用以开始过滤的 PTR 值。

输入用以结束过滤的 PTR 值。
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(2) [Address] （地址）页

设置地址条件。

图 5.68   [Trace Filter] （跟踪过滤器）对话框 （[Address] （地址）页）

注意：设置地址范围时，可以在 [From] （从）和 [To] （到）选项中分别设置地址范围的起始和结束点。

[Don't care] （忽略）： 选中此框后将不检测任何地址。

[Setting] （设置）：

[Point] （点）：

[Range] （范围）：

[From] （从）：

[To] （到）：

检测指定的地址。

指定单一地址 （选中 [Don't care] （忽略）后不可用）。

指定地址范围 （选中 [Don't care] （忽略）后不可用）。

输入单一地址或地址范围的起始点 （选中 [Don't care] （忽略）后

不可用）。

输入单一地址或地址范围的结束点 （仅在选择 [Range] （范围）时

可用）。
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(3) [Data] （数据）页

设置数据条件。

图 5.69   [Trace Filter] （跟踪过滤器）对话框 （[data] （数据）页）

注意：设置数据范围时，可以在 [From] （从）和 [To] （到）选项中分别设置最小值和最大值。

[Don't care] （忽略）： 选中此框后将不检测任何数据。

[Setting] （设置）：

[Point] （点）：

[Range] （范围）：

[From] （从）：

[To] （到）：

检测指定的数据。

指定单一数据 （选中 [Don't care] （忽略）后不可用）。

指定数据范围 （选中 [Don't care] （忽略）后不可用）。

输入单一数据或数据范围的最小值 （选中 [Don't care] （忽略）后不

可用）。

输入数据范围的最大值 （仅在选择 [Range] （范围）后才可用）。
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(4) [R/W] 页

选择存取周期的类型。

图 5.70   [Trace Filter] （跟踪过滤器）对话框 （[R/W] 页）

(5) [Type] （类型）页

选择存取的类型。截获时戳后此选项不可用。

图 5.71   [Trace Filter] （跟踪过滤器）对话框 （[Type] （类型）页）

[Don't care] （忽略）： 选中此框后不检测任何读 / 写条件。

[Setting] （设置）： 检测指定的读 / 写条件。

READ：选中此框后检测读周期（选中 [Don't care] （忽略）后不可用）。

WRITE：选中此框后检测写周期（选中 [Don't care] （忽略）后不可用）。

[Don't care] （忽略）： 选中此框后将不检测任何类型条件。

[Setting] （设置）： 检测指定的类型条件 （选中 [Don't care] （忽略）后不可用）。
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(6) [Bus] （总线）页

选择总线状态。截获时戳后，该选项不可用。

图 5.72   [Trace Filter] （跟踪过滤器）对话框 （[Bus] （总线）页）

[Don't care] （忽略）： 选中此框后将不检测任何总线条件。

[Setting] （设置）： 检测指定的总线条件 （选中 [Don't care] （忽略）后不可用）。
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5.9.14 分析统计信息

从弹出菜单中选择 [Statistic...] （统计…），将打开 [Statistic] （统计）对话框，并按指定条件分析统计信息。

图 5.73   [Statistic] （统计）对话框

[Statistic Analysis]
（统计分析）：

[Default] （默认）：

[Range] （范围）：

[Item] （项目）：

[Start] （起始）：

[End] （结束）：

[Set] （设置）：

[New] （新建）：

[Result] （结果）按钮：

[Clear] （清除）：

[Result] （结果）列表框：

[Close] （关闭）：

分析统计信息所必需的设置。

设置单个输入值或字符串。

将输入值或字符串设置为范围。

设置分析项目。

设置输入值或字符串。要设置范围，必须在此处指定起始值。

如果已设置范围，则指定结束值（仅在选择 [Range] （范围）时可用）。

将新条件添加到当前条件。

创建新条件。

获取统计信息分析的结果。

初始化设置。

清除所有条件和统计信息分析的结果。

关闭此对话框。将清除 [Result] （结果）列表中显示的所有结果。
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用户使用此对话框可以分析有关跟踪信息的统计信息。在 [Item] （项目）中设置分析目标，并通过 [Start]
（开始）和 [End] （结束）设置输入值或字符串。按 [New] （新建）或 [Add] （添加）按钮设置条件后，单击 
[Result] （结果）按钮分析统计信息并在 [Result] （结果）列表中显示结果。

注意：在仿真器中，仅 [PTR] 可以设置为范围。其他各项必须指定为字符串。分析统计信息的过程中，会
将字符串与 [Trace] （跟踪）窗口中显示的字符串相比较。只对完全匹配的字符串进行计数。不过
请注意，此测试不区分大小写。空格数量也将忽略。

5.9.15 从截获的跟踪信息中提取函数调用

要从截获的跟踪信息中提取函数调用，请从弹出菜单中选择 [Function Call...] （函数调用…）。此时显示 
[Function Call Display] （函数调用显示）对话框。

图 5.74   [Function Call Display] （函数调用显示）对话框

如果选择 [Enable] （允许），则仅从截获的跟踪信息中提取包括函数调用的周期并显示。提取函数调用不
会更改跟踪缓冲器的内容。对包含函数调用的跟踪信息执行此功能可以让用户了解函数调用的顺序。

[Setting] （设置）：

[Enable] （允许）：

[Disable] （禁止）：

选择是否提取函数调用。

提取函数调用。

不提取函数调用。



SH-2A、 SH-2 E200F 仿真器 第 5 章   调试

Rev.1.00  2007.09.21  Page 188 of 279
RCJ10J0048-0100

5.10 查看高速缓存内容

[Cache] （高速缓存）窗口用于显示带高速缓存的 MCU 中的高速缓存内容。不同的 MCU 有不同的 
[Cache] （高速缓存）窗口。请阅读与各个 MCU 对应的说明。

5.10.1 打开 [Cache] （高速缓存）窗口

图 5.75   [Cache] （高速缓存）窗口

选择 [View -> CPU -> Cache] （视图 -> CPU -> 高速缓存）或者单击 [Cache] （高速缓存）工具栏按钮 [  ] 
打开 [Select Cache] （选择高速缓存）对话框 （图 5.76），以选择要显示的高速缓存窗口类型。

图 5.76   [Select Cache] （选择高速缓存）对话框

此对话框用于选择要显示的高速缓存。选择下列高速缓存类型之一：

单击 [OK] （确定）按钮显示选定的高速缓存窗口。单击 [Cancel] （取消）按钮关闭该对话框，不打开 
[Cache] （高速缓存）窗口。

[Instruction cache]
（指令高速缓存）

打开指令高速缓存窗口。

[Operand cache]
（操作数高速缓存）

打开操作数高速缓存窗口。
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[Instruction Cache] （指令高速缓存）窗口中显示下列项目：

5.10.2 修改高速缓存内容

在选择高速缓存项目后从弹出菜单中选择 [Modify...] （修改…），将打开用于修改选定高速缓存项目的对
话框。

请注意，在指令执行期间， [Modify...] （修改…）菜单处于禁止状态，无法修改高速缓存项目。

图 5.77   [Set Tag Address] （设置标记符地址）对话框

使用此对话框可以修改当前选定的高速缓存项目。选定的高速缓存项目和条目编号显示在对话框的标题中。
还为多路高速缓存显示了路编号。对话框中的项目名称显示了选定的高速缓存项目。

单击 [OK] （确定）按钮在高速缓存中存储新输入的内容。单击 [Cancel] （取消）按钮关闭该对话框，不在
高速缓存中存储新输入的内容。

可以直接在该窗口中输入值。

5.10.3 清除高速缓存内容

从弹出菜单中选择 [Flush] （清除）可清除高速缓存。所有 V、 U 和 LRU 位都将清零，所有高速缓存条目
都将无效。

请注意，在指令执行期间， [Flush] （清除）菜单处于禁止状态，无法清除高速缓存。

[Entry] （条目） 指令高速缓存中的条目编号 （取决于高速缓存容量）

[V] 验证位。当此位为 1 时，条目有效。

[U] 更新位。当此位为 1 时，表示对条目进行了写入。

[Tag Address] （标记符地址） 标记符地址

[Longword0] 到 [Longword4] 设置为操作数高速缓存条目的长字数据 0 到 4
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5.10.4 搜索高速缓存项目

从弹出菜单中选择 [Find...] （查找…）可打开 [Find Cache] （查找高速缓存）对话框，通过该对话框可以
在列单元中搜索高速缓存项目。

请注意，在指令执行期间， [Find...] （查找…）菜单处于禁止状态，无法搜索高速缓存项目。

图 5.78   [Find Cache] （查找高速缓存）对话框

此对话框用于搜索高速缓存项目。可以指定下列搜索条件：

设置搜索条件后，单击 [OK] （确定）按钮便可开始搜索。搜索完成后将突出显示匹配的条目。

单击 [Cancel] （取消）按钮可关闭该对话框，不搜索高速缓存项目。

5.10.5 继续高速缓存搜索

可以用已设置的搜索条件搜索下一个匹配的高速缓存项目。如果在前面的搜索中找到了匹配的高速缓存项
目，则可以从弹出菜单中选择 [Find Next] （查找下一个）。

请注意，在指令执行期间， [Find Next] （查找下一个）菜单处于禁止状态，无法搜索下一个匹配的高速缓
存项目。

5.10.6 保存当前显示的内容

窗口中当前显示的内容可保存在文本文件中。从弹出菜单选择 [Save to File...] （保存到文件…）。

[Find Column] （查找列） 要搜索的项目

[Find Value] （查找值） 要搜索的值
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5.11 分析性能

使用性能分析功能可以测量执行性能。

仿真器具备两种类型的性能分析功能：on-chip 性能分析 (Onchip Performance Analysis) 和 AUD 性能分析 
(AUD Performance Analysis)。

5.11.1 打开 [Onchip Performance Analysis] （Onchip 性能分析）窗口

要打开 [Onchip Performance Analysis] （Onchip 性能分析）窗口，请选择 [View -> Performance -> 

Performance Analysis] （视图 -> 性能 -> 性能分析），或者单击 [PA] （性能分析）工具栏按钮 ( ) 打开 

[Select Performance Analysis Type] （选择性能分析类型）对话框。

图 5.79   [Select Performance Analysis Type] （选择性能分析类型）对话框

选择 [Onchip Performance] （Onchip 性能），然后单击 [OK] （确定）按钮打开 [Performance Analysis] （性
能分析）窗口。

图 5.80   [Performance Analysis] （性能分析）窗口 （Onchip 性能）

Onchip 性能分析功能使用 MCU 中的性能测量功能，因此不影响实时操作。

注意：on-chip 性能分析功能的测量条件和通道数因产品而异。有关详细信息，请参阅各产品的在线帮助。
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在此窗口中双击或选择测量通道，并从弹出菜单中选择 [Set...] （设置…）后，将打开 [Performance Analysis]
（性能分析）对话框，可以在其中修改测量条件。

图 5.81   [Performance Analysis] （性能分析）对话框

有关 [Performance Analysis] （性能分析）对话框的详细信息，请参阅各产品的在线帮助。

5.11.2 打开 [AUD Performance Analysis] （AUD 性能分析）窗口

要打开 [AUD Performance Analysis] （AUD 性能分析）窗口，请选择 [View -> Performance -> Performance 

Analysis] （视图 -> 性能 -> 性能分析），或者单击 [PA] （性能分析）工具栏按钮 ( ) 打开 [Select 

Performance Analysis Type] （选择性能分析类型）对话框。

图 5.82   [Select Performance Analysis Type] （选择性能分析类型）对话框

选择 [AUD Performance] （AUD 性能），单击 [OK] （确定）按钮打开 [Performance Analysis] （性能分析）
窗口。
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图 5.83   [Performance Analysis] （性能分析）窗口 （AUD 性能）

AUD 性能分析功能不影响实时操作，因为它使用仿真器主部件壳体中的硬件性能测量电路来测量指定范
围内的执行性能。

AUD 性能分析测量通道的开始和结束条件分别使用一个 AUD 事件通道。四个测量通道使用八个 AUD 事
件通道。

注意：由于 AUD 性能功能是根据从 MCU 的 AUD 引脚输出的信息实现的，因此必须设置 AUD 跟踪信息
截获条件。设置 AUD 跟踪信息截获条件。

在此窗口中双击或选择某个测量通道，并从弹出菜单中选择 [Set...] （设置…）后，将打开 [Performance 
Analysis AUD Channel x] （性能分析 AUD 通道 x）对话框，可以在其中修改测量条件。

图 5.84   [Performance Analysis AUD Channel x] （性能分析 AUD 通道 x）对话框

[Start Point [aud event chx]]
（开始点 [aud 事件通道 x]）：

显示测量通道的开始指针条件。

[End Point [aud event chx]]
（结束点 [aud 事件通道 x]）：

显示测量通道的结束指针条件。

[Set] （设置）： 显示为开始或结束指针设置 AUD 事件通道的对话框。

[Sampling time] （采样时间）： 将测量定时器的分辨率指定为下列任意值：20 ns、100 ns、400 ns 或 1.6 µs
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单击 [Set] （设置）按钮打开用于设置相应 AUD 事件通道的对话框，以修改测量开始或结束条件。

图 5.85   编辑 AUD 性能分析测量条件 （用于设置 AUD 事件的对话框）

注意：1. 当使用 AUD 性能分析功能时，需要在每个通道的 [Action] （操作）页上设置 [Performance 
start/stop] （性能开始 / 停止）。

2. 修改测量条件后，内容会反映在 [Event] （事件）窗口的 [AUD Event] （AUD 事件）页中。

5.11.3 隐藏列

可以在 [Performance Analysis] （性能分析）窗口中隐藏任何不需要的列。用鼠标右键单击标题列，从显示
的弹出菜单中选择要隐藏的列，便可隐藏该列。要显示隐藏的列，请从上述弹出菜单中重新选择该列。

5.11.4 开始性能数据截获

执行用户程序会清除以前的测量结果，并自动根据已设置的条件开始测量执行性能。停止用户程序后，将
在 [Performance Analysis] （性能分析）窗口中显示测量结果。

5.11.5 删除测量条件

选定测量条件后，从弹出菜单中选择 [Reset] （复位）可删除该条件。

5.11.6 删除所有测量条件

从弹出菜单中选择 [Reset All] （全部复位）可删除已设置的所有条件。
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5.12 查看剖析信息

使用剖析功能，可以对正在执行的应用程序的各个函数进行性能测量。这样，就可以确定应用程序中导致
应用程序性能降低的部分，以及性能降低的原因。

根据剖析数据的查看方法和查看目的， HEW 在三个窗口中显示测量结果。

5.12.1 堆栈信息文件

剖析功能使 HEW 可以读取由优化连接程序 （7.0 版或更高版本）输出的堆栈信息文件 （扩展名为
“.SNI”）。其中每个文件都包含在对应源文件中调用静态函数的相关信息。读取堆栈信息文件后， HEW 不必
执行用户应用程序，也就是在测量剖析数据之前即可显示这些信息来处理函数调用。但是，如果在 [Profile]
（剖析）窗口的弹出菜单中选中了 [Setting->Only Executed Functions] （设置 -> 仅限执行的函数），此功能便不
可用。

如果 HEW 未读取任何堆栈信息文件，则剖析功能将显示测量期间执行的函数的相关数据。

要让连接器创建堆栈信息文件，请选择 [Options -> SuperH Risc engine Standard Toolchain...]（选项 -> SuperH 
Risc engine 标准工具链…），然后在 [Standard Toolchain] （标准工具链）对话框的 [Link/Library] （链接 / 库）
页面中，从 [Category] （类别）列表框中选择 [Other] （其他），并选中 [Stack information output] （堆栈信息输
出）框。

图 5.86   [Standard Toolchain] （标准工具链）对话框 (1)
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5.12.2 剖析信息文件

要创建剖析信息文件，则在测量应用程序的剖析数据后，从 [Profile] （剖析）窗口的弹出菜单中选择 
[Output Profile Information Files...] （输出剖析信息文件…）菜单选项，然后指定文件名。

该文件包含函数调用次数和全局变量存取次数的信息。优化连接程序 （7.0 版或更高版本） 能够读取剖析
信息文件，并根据程序实际操作的状态优化函数和变量的分配。

要将剖析程序信息文件输入到连接器，请在 [Standard Toolchain] （标准工具链）对话框的 [Link/Library]
（链接 / 库）页上，从 [Category] （类别）列表框中选择 [Optimize] （优化），并选中 [Include Profile] （包括剖
析）框，同时指定剖析信息文件的名称。

图 5.87   [Standard Toolchain] （标准工具链）对话框 (2)

要允许 [Include Profile] （包括剖析）框中的设置，请在 [Optimize] （优化）列表框中指定 [None] （无）
之外的某个设置。
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5.12.3 装入堆栈信息文件

您可以在装入某装入模块时显示的确认信息框中选择是否读取堆栈信息文件。单击该信息框的 [OK] （确
定）按钮将装入堆栈信息文件。在以下情况下，会显示确认信息框：

· 存在堆栈信息文件 （扩展名 为 “*.SNI”）。

· 从主菜单选择 [Tools -> Options...] （工具 -> 选项…）打开 [Options] （选项）对话框后，从该对话框
的 [Confirmation] （确认）页面 （图5.88）中，选中了 [Load Stack Information Files (SNI files)] （装入
堆栈信息文件 （SNI 文件））复选框。

图 5.88   [Options] （选项）对话框
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5.12.4 允许剖析

选择 [View->Performance->Profile] （视图 -> 性能 -> 剖析）打开 [Profile] （剖析）窗口。

从 [Profile] （剖析）窗口的弹出菜单中选择 [Enable Profiler] （允许剖析器）。将对菜单中的项目进行检查。

5.12.5 指定测量模式

您可以指定是否在截获剖析数据时跟踪函数调用。跟踪函数调用时，用户程序执行期间的函数调用关系会
显示为一个树状图。不跟踪时，不能显示函数调用的关系，但可以减少截获剖析数据的时间。

要停止跟踪函数调用，请从 [Profile] （剖析）窗口的弹出菜单中选择 [Disable Tree (Not traces function call)]
（禁止树 （不跟踪函数调用））（菜单项左侧将显示复选标记）。

当截获以特殊方式调用函数（例如，操作系统中的任务切换）的程序的剖析数据时，将停止跟踪函数调用。

5.12.6 执行程序和检查结果

执行用户程序并暂停执行后， [Profile] （剖析）窗口中会显示测量结果。

[Profile] （剖析）窗口有两页：[List] （列表）页和 [Tree] （树）页。

5.12.7 [List] （列表）页

此页列出函数和全局变量，并显示每个函数和变量的剖析数据。

图 5.89   [List] （列表）页

单击列标题可以按字母顺序或升序对项目进行排序。双击 [Function/Variable] （函数 / 变量）或 [Address]
（地址）列将显示与行中的地址对应的源程序。

在窗口中单击鼠标右键将显示一个弹出菜单。有关此弹出菜单的详细信息，请参阅第 5.12.8 节 “[Tree]
（树）页”。
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5.12.8 [Tree] （树）页

此页显示函数调用的关系以及调用函数时作为值的剖析数据。未从 [Profile] （剖析）窗口的弹出菜单中选
择 [Disable Tree (Not traces function call)] （禁止树 （不跟踪函数调用））时，会显示此页。

图 5.90   [Tree] （树）页

双击 [Function] （函数）列中的函数可展开或收缩树结构显示。也可以通过 “+”或 “-”键来展开或收缩
树。双击 [Address] （地址）列将显示与特定地址对应的源程序。

在窗口中单击鼠标右键将显示一个弹出菜单。下面介绍了支持的菜单选项：

· View Source （查看源）

显示选定行中地址的源程序或反汇编存储器内容。

· View Profile-Chart （查看剖析图）

显示针对指定行中函数的 [Profile-Chart] （剖析图）窗口。

· Enable Profiler （允许剖析器）

切换剖析数据截获。当剖析数据截获处于活动状态时，会在菜单文本左侧显示一个复选标记。

· Not trace the function call （不跟踪函数调用） 

在截获剖析数据时停止跟踪函数调用。当截获以特殊方式调用函数 （例如，操作系统中的任务切换）
的程序的剖析数据时，将使用此菜单。

要在 [Profile] （剖析）窗口的 [Tree] （树）页中显示函数调用的关系，请截获剖析数据，而不选择此
菜单。另外，在使用截获的剖析信息文件通过优化连接编辑程序来优化程序时，不要选择此菜单。

· Find... （查找…）

显示 [Find Text] （查找文本）对话框以便在 [Function] （函数）列中查找字符串。在编辑框中输入要
查找的字符串并单击 [Find Next] （查找下一个）或按 Enter 键便可开始搜索。

· Find Data... （查找数据…）

显示 [Find Data] （查找数据）对话框。
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图 5.91   [Find Data] （查找数据）对话框

在 [Column] （列）组合框中选择要搜索的列，在 [Find Data] （查找数据）组中选择搜索类型，并按 [Find 
Next] （搜索下一个）按钮或 Enter 键，便可开始搜索。如果反复按 [Find Next] （查找下一个）按钮或 Enter 键，
则会搜索第二大的数据 （当指定 Minimum （最小值）时，则搜索第二小的数据）。

· Clear Data （清除数据）

清除调用函数的次数和剖析数据。 [Profile] （剖析）窗口 [List] （列表）页中的数据以及 [Profile-Chart]
（剖析图）窗口中的数据也会被清除。

· Output Profile Information Files... （输出剖析信息文件…）

显示 [Save Profile Information Files] （保存剖析信息文件）对话框。剖析结果保存在剖析信息文件
（扩展名为 .pro）中。优化连接编辑程序根据此文件中的剖析信息来优化用户程序。有关使用剖析信
息进行优化的详细信息，请参阅优化连接编辑程序手册。

注意：如果通过选择 [Not trace the function call] （不跟踪函数调用）菜单截获了剖析信息，则不能通过
优化连接编辑器来优化程序。

· Output Text File... （输出文本文件…）

显示 [Save Text of Profile Data] （保存剖析数据的文本）对话框。显示的内容保存在文本文件中。

· Setting （设置）

此菜单具有下列子菜单 （还包括只在 [List] （列表）页中可用的菜单）。

— Show Functions/Variables （显示函数 /变量）
在 [Function/Variable] （函数 /变量）列中显示函数和全局变量。

— Show Functions （显示函数）
只在 [Function/Variable] （函数 /变量）列中显示函数。

— Show Variables （显示变量）
只在 [Function/Variable] （函数 /变量）列中显示全局变量。

— Only Executed Functions （仅限执行的函数）
仅显示执行的函数。如果装入模块所在的目录中不存在优化连接编辑程序输出的堆栈信息文件

（扩展名为 .sni），则即使未选中此复选框，也只显示执行的函数。

— Include Data of Child Functions （包括子函数的数据）
设置是否将函数中调用的子函数的信息显示为剖析数据。

· Properties... （属性…）

设置要测量的项目。
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5.12.9 [Profile-Chart] （剖析图）窗口

[Profile-Chart] （剖析图）窗口显示特定函数的调用关系。此窗口在中间位置显示特定函数，在左侧显示函
数的调用方，在右侧显示函数的被调用方。此窗口中还显示了该函数调用被调用函数的次数，或者该函数被调
用函数调用的次数。

图 5.92   [Profile-Chart] （剖析图）窗口

5.12.10 显示数据的类型和目的

剖析功能可以截获以下信息：

地址 可以查看函数在存储器中的分配位置。函数和全局变量的列表按照地址顺序进行排序，用
户可以查看项目在存储空间中的分配方式。

大小 按照大小排序，以方便查找被频繁调用的小函数。将此类函数设置为直接插入函数，可减
少函数调用产生的开销。如果执行较大函数，则需更新更多高速缓存。使用此信息可以检
查是否频繁调用了此类可能导致高速缓存未命中的函数。

堆栈大小 当函数调用存在深度嵌套时，可以追踪函数调用的路线，并获取该路线上所有函数的总堆
栈大小，以估计正在使用的堆栈量。

次数 按调用或存取次数排序可以轻松识别经常调用的函数和经常存取的全局变量。

剖析数据 提供对各种 MCU 专用数据的测量情况，以及可使用性能测量功能测量的项目。有关详细
信息，请参阅在线帮助。
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5.12.11 创建剖析信息文件

要创建剖析信息文件，请从弹出菜单中选择 [Output Profile Information Files...] （输出剖析信息文件…）菜
单选项。将显示 [Save Profile Information Files] （保存剖析信息文件）对话框。在选择文件名后按 [Save] （保存）
按钮可将剖析信息写入选定的文件。按 [Save All] （全部保存）按钮可将剖析信息写入所有剖析信息文件。

图 5.93   [Save Profile Information Files] （保存剖析信息文件）对话框
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5.12.12 说明

1. 容差

剖析功能在内部暂停用户程序的执行，收集测量的数据，然后重新执行用户程序。

由于在暂停或重新执行期间生成测量项目时该功能也会计数，因此将在测量的剖析值中包含容差。

此功能的测量值应作为参考。

2. 使用剖析功能时不能使用的功能

(a) On-chip 性能分析功能

在允许剖析功能的情况下，不能使用 on-chip 性能分析功能。

(b) 单步执行功能

在允许剖析功能的情况下，不要使用单步执行功能。否则无法正确测量剖析数据。

(c) 内部跟踪功能

在允许剖析功能的情况下，选择内部跟踪模式是无效的，因为内部跟踪模式的所有项目都是在内

部选择的。在允许剖析功能的情况下，不要使用内部跟踪。

(d) 连续跟踪功能 （仅适用于支持的器件）

在允许剖析功能的情况下，不要使用在内部跟踪功能中使用的连续跟踪功能。否则无法正确测量

剖析数据。

(e) 暂停功能

在允许剖析功能的情况下，不要使用内部跟踪、 AUD 跟踪和外部总线跟踪的暂停功能。

(f) 用户程序执行期间的存储器存取

在允许剖析功能的情况下，将在用户程序执行期间禁止存储器存取。

(g) 使用剖析功能时，如果生成转移指令，则发生暂停。因此，不执行实时仿真。另外，由于在产生
暂停时仿真器固件受到控制，因此，当执行点从仿真器固件返回到用户程序时，可能会在 
[Internal/AUD/Usermemory trace] （内部 /AUD/用户存储器跟踪）窗口中显示转移指令的执行结
果。在这种情况下，将显示 **EML**。

3. 其他

(a) 在使用剖析功能的情况下，执行用户程序时会发生内部暂停。因此，AUD 性能分析的测量结果将
包含错误。

(b) 使用剖析功能时，将删除在 on-chip 性能测量功能中设置的内容或已测量的数据。

(c) 由于剖析功能是依赖内部暂停实现的，因此需要较长时间才能开始和结束用户程序的执行。
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5.13 查看实时剖析信息

实时剖析功能用于测量功能单元上应用程序中指定范围的执行性能。该功能在调查应用程序中性能低下部
分的位置及其原因时非常有效。

实时剖析功能使用仿真器主部件壳体和扩展剖析单元上的剖析程序测量电路来测量性能，所以不会影响到
实时操作。

实时剖析测量具备以下模式：

· 函数模式

该功能在显示函数执行时间的积累值时，不包括子程序的执行时间。

· 嵌套模式

该功能在显示函数执行时间的积累值时，包括子程序的执行时间。

确定在 [Function select] （功能选择）对话框 （激活仿真器时显示）中使用何种模式。

注意：实时剖析功能存在以下限制。

(1) 对所有实时剖析功能的限制

(i) 要测量的区域

在仿真器中，每 512 KB 被看作一个单元，最多可对 24 块区域上的所有函数执行剖析信息截获。

仿真器的硬件最多具备三种类型的存储器，可测量八块区域，以执行实时剖析功能。

请注意，可在每个块中设置相邻的地址区域，但不能设置地址范围跨越八块边界的函数。如果设

置了这种函数，则会显示一条警告信息，并且无法执行正确的测量。

(ii) 直接插入展开

如果函数根据编译器优化成为直接插入函数，则不会在 [Realtime Profile] （实时剖析）窗口中显示。

(iii) 递归函数

可正确测量递归函数的执行时间，但执行计数仅为一。

(iv) AUD 跟踪

实时剖析功能需使用 AUD 跟踪期间输出的数据。因此，在实时跟踪模式中使用该功能时，可能会

丢失跟踪数据，且无法执行正确的测量。如果遇到这种情况，建议使用非实时跟踪模式。
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(2) 使用函数模式的限制

(i) 尾部调用

对如下所示的函数使用尾部调用时，被调用函数的返回值将成为调用函数的返回地址。在这种情

况下，不能正确测量被调用函数的执行时间或执行计数。

图 5.94   尾部调用 （函数模式）

(ii) 运行起始地址、暂停地址和可测量范围之间的关系

图 5.95   可测量范围 （函数模式）

在黑圈位置出现暂停时的可测量范围：

· 函数 h 和 k 的执行时间和计数

在红圈位置出现暂停时的可测量范围：

· 函数 h 和 k 的执行时间和计数

在蓝圈位置出现暂停时的可测量范围：

· 函数 h 和 k 的执行时间和计数

· 函数 g 的执行时间；无法测量计数。

建议在函数内部执行开始位置出现暂停。当执行返回到上级函数时，无法测量函数的执行计数。

f( ){
 

}
g( ){

 

}
 

g( );  

NOP
 

RTS
 

f( ){

g( ){

h( ){

 g 

k( ){

} }
 

} }

g( );
 

h( );  

k( );  
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(3) 使用嵌套模式的限制

(i) 尾部调用

—  对如下所示的函数使用尾部调用时，被调用函数的返回值将成为调用函数的返回地址。在这种情
况下，无法正确测量被调用函数的执行时间，但可测量执行计数

图 5.96   尾部调用 （嵌套模式）

— 使用尾部调用从已被尾部调用所调用的函数中调用另一个函数时，存在一个限制。尾部调用连续
出现时，可以正确执行三级调用的测量。

图 5.97   调用的限制

f( ){
 

}
g( ){

 

}
 

g( );  

NOP
 

RTS
 

f( ){
g( ){

 1  2  3 

}

g( );

h( );

}

h( ){

k( );
 

}

k( ){

}
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(ii) 嵌套函数

在要测量的范围内，从顶级函数产生 32 级或更多级调用时，将无法执行正确的测量。此时会显示

一条警告信息。

(iii) 来自测量范围外的函数调用

测量范围外的函数调用要测量的函数时，无法执行正确的测量，且被调用函数无法正确返回到调

用函数。

即使被调用函数正确返回到调用函数，如果从返回地址开始的三条指令内又调用了其他函数，那

么还是无法执行正确的测量

(iv) 运行起始地址、暂停地址和可测量范围之间的关系

图 5.98   可测量范围 （嵌套模式）

在黑圈位置出现暂停时的可测量范围：

· 函数 h 的执行时间和计数

在红圈位置出现暂停时的可测量范围：

· 函数 h 和 k 的执行时间和计数

在蓝圈位置出现暂停时的可测量范围：

· 函数 h 和 k 的执行时间和计数

建议在函数内部执行开始位置出现暂停。当执行返回到上级函数时，无法测量函数的执行计数。

f( ){

g( ){

h( ){

 g 

k( ){

} }
 

} }

g( );
 

h( );  

k( );  
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5.13.1 打开 [Realtime Profile] （实时剖析）窗口

选择 [View -> Performance -> Realtime Profile] （视图 -> 性能 -> 实时剖析），打开 [Realtime Profile] （实时
剖析）窗口。单击列标头可升序或降序显示项目。

图 5.99   [Realtime Profile] （实时剖析）窗口

可截获以下信息：

Address （地址） 可以查看函数在存储器中的分配位置。

Size （大小） 按照大小排序，以方便查找被频繁调用的小函数。将此类函数设置为直接
插入函数，可减少函数调用产生的开销。如果执行较大函数，则需更新更
多高速缓存。该信息可以让您确定那些可能导致高速缓存缺失的函数是否
会被频繁调用。

Count （计数） 显示调用函数的次数。

Times （时间） 显示总执行时间。
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5.13.2 指定测量范围

在窗口上单击鼠标右键显示弹出菜单。选择弹出菜单中的 [Add Range] （添加范围），打开 [EDIT] （编辑）
对话框，以指定实时剖析的测量范围。

图 5.100   [EDIT] （编辑）对话框

当扩展剖析单元连接至仿真器时，总共可测量 6 MB 范围内的剖析信息。扩展剖析单元未连接至仿真器时，
总共可测量 2 MB 范围内的剖析信息。

在仿真器中，每 512 kb 被看作一个单元，可对八块区域上的所有函数执行剖析信息截获。为每个块指定的
地址不必相连。当扩展剖析单元连接至仿真器时，可多测量 16 块 512 kb，总共可测量 24 块区域。

各块中的测量数据显示在 [Realtime Profile] （实时剖析）窗口的各个页面上。若要切换要显示的页，请选
择该页并单击 [Select Page] （选择页面）对话框 （从 [Realtime Profile] （实时剖析）窗口的弹出菜单中选择 
[Select Page] （选择页面）打开）中的 [OK] （确定）按钮。

图 5.101   [Select Page] （选择页面）对话框

5.13.3 开始测量

执行用户程序时，开始测量。

暂停用户程序时，测量结果显示在 [Realtime Profile] （实时剖析）窗口中。

5.13.4 清除测量结果

选择弹出菜单中的 [Clear Data] （清除数据）可清除 [Column] （列）和 [Time] （时间）列的测量结果。

5.13.5 删除测量范围

选择弹出菜单中的 [Delete] （删除）可删除所有指定的测量范围，并清除测量结果。
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5.13.6 设置测量时间的最小单位

在仿真器中，可以将测量时间的最小单位改为 20 ns、 100 ns、 400 ns 或 1.6 µs 中的任意值。

当最小单位设置为 20 ns 时，可测量的最长时间大约是 3 小时。

当最小单位设置为 100 ns 时，可测量的最长时间大约是 15 小时。

当最小单位设置为 400 ns 时，可测量的最长时间大约是 61 小时。

当最小单位设置为 1.6 µs 时，可测量的最长时间大约是 244 小时。

要更改最小单位，请从 [Realtime Profile] （实时剖析）窗口的弹出菜单中选择 [Set] （设置），打开 [Properties]
（属性）对话框。

图 5.102   [Properties] （属性）对话框

注意：在使用实时剖析功能时，请务必设置以下项：

· 从 [Trace] （跟踪）窗口的弹出菜单中选择 [Set] （设置）而打开的 [I-Trace/AUD-Trace acquisition]
（内部跟踪 /AUD 跟踪截获）对话框：

[Trace mode] （跟踪模式）页

          [Trace type] （跟踪类型）：选择 [AUD Trace] （AUD 跟踪）。

          [AUD mode] （AUD 模式）：选中 [Branch trace] （转移跟踪）复选框。

[AUD Branch trace] （AUD 转移跟踪）页

          [Acquire normal branch instruction trace] （截获普通转移指令跟踪）：选中此复选框。

          [Acquire subroutine branch instruction trace] （截获子程序转移指令跟踪）：选中此复选框。

          [Acquire exception branch instruction trace] （截获异常转移指令跟踪）：选中此复选框。
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5.14 同步多个调试平台

在 HEW 中可同时操作多个调试平台。从一个 HEW 启动另一个 HEW 可同步多个调试平台。启动其他 HEW 
的 HEW 称为主 HEW，被启动的 HEW 称为从属 HEW。选择 [Tools -> Launch Slave HEW...]（工具 -> 启动从属 

HEW…）或单击 [Launch Slave HEW] （启动从属 HEW）工具栏按钮 (  ) 会启动从属 HEW。

从属 HEW 与主 HEW 具有相同的功能。

在主 HEW 中执行以下操作后，会通知从属 HEW，以确保从属 HEW 与主 HEW 同步。

· 复位开始

· 开始

· 停止调试

注意：主 HEW 可以启动多个从属 HEW 应用软件，但从属 HEW 应用软件不能嵌套 （即一个从属 HEW 
不能启动另一个从属 HEW）。

从 [Start] （中文系统：[ 开始 ]）菜单的 [Programs] （中文系统：[ 程序 ]）中选择 [Renesas High-performance 
Embedded Workshop] （瑞萨高性能嵌入式工作区） -> [High-performance Embedded Workshop] （高性能嵌入式
工作区）启动另一个 HEW 时，可分别使用两个仿真器进行调试。

5.14.1 区分两个仿真器

将两个仿真器连接到 USB 连接器。然后，使用教程工作区启动 HEW。将显示以下信息。

图 5.103   驱动程序选择信息
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单击 [OK] （确定）按钮。此时显示以下对话框。

图 5.104   [Driver Details] （驱动程序详细信息）对话框 (1)

从 [Driver] （驱动程序）下拉列表框中选择 [E7/E10 Emulator USB Driver] （E7/E10 仿真器 USB 驱动程
序），打开 [Channel] （通道）下拉列表框。两个仿真器的通道信息显示在 [Channel] （通道）下拉列表框中，
如下所示。

图 5.105   [Driver Details] （驱动程序详细信息）对话框 (2)

图 5.105 中显示的信息是连接仿真器的 USB 连接器的信息。

注意：显示的信息字符串随主机环境的不同而不同。
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查看显示仿真器的信息字符串。

在 [Driver] （驱动程序）下拉列表框中选择 [<no driver selected>] （< 未选择驱动程序 >），并断开一个仿真
器与 USB 连接器的连接。然后在 [Driver] （驱动程序）下拉列表框中选择 [E7/E10 Emulator USB Driver] （E7/
E10 仿真器 USB 驱动程序）。 [Channel] （通道）下拉列表框中仅显示连接仿真器的 USB 连接器的相关信息。

上述步骤用于辨别 [Channel] （通道）下拉列表框中显示的信息字符串指示的是哪台仿真器。

启动 HEW 时，在 [Channel]（通道）下拉列表框中选择连接至主 CPU 的仿真器的 USB 连接器的相关信息。
遵循正常步骤启动 HEW。

启动从属 HEW 时，在 [Channel] （通道）下拉列表框中，选择连接从 CPU 的仿真器的 USB 连接器的信息。
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5.15 截获代码覆盖率

仿真器从用户指定的地址范围截获代码覆盖率信息 （C0 覆盖率）并显示结果。

注意：测量代码覆盖率时，请务必设置以下项：

· 从 [Trace] （跟踪）窗口的弹出菜单中选择 [Set] （设置）而打开的 [I-Trace/AUD-Trace acquisition]
（内部跟踪 /AUD 跟踪截获）对话框：

      [Trace mode] （跟踪模式）页

          [Trace mode] （跟踪模式）：选择 [AUD Trace] （AUD 跟踪）。

          [AUD mode] （AUD 模式）：选中 [Branch trace] （转移跟踪）复选框。

      [AUD Branch trace] （AUD 转移跟踪）页

          [Acquire normal branch instruction trace] （截获普通转移指令跟踪）：选中此复选框。

          [Acquire subroutine branch instruction trace] （截获子程序转移指令跟踪）：选中此复选框。

          [Acquire exception branch instruction trace] （截获异常转移指令跟踪）：选中此复选框。

5.15.1 打开 [Code Coverage] （代码覆盖率）窗口

选择 [View -> Code -> Code Coverage...] （视图 -> 代码 -> 代码覆盖率…），或者单击 [Code Coverage] （代

码覆盖率）工具栏按钮 (  )。初始化仿真器后第一次使用覆盖率功能时，会打开以下对话框。

图 5.106   [Coverage Acquisition Range Setting] （覆盖率截获范围设置）对话框

[Enable] （允许）： 选中此复选框可截获代码覆盖率信息。

[Coverage acquisition start address (Mainboard, 4M)]
（覆盖率截获起始地址 （主板， 4M））：

仿真器指定 4 MB 范围内的测量起始地址。

[Coverage acquisition start address (Optionboard, 8M)]
（覆盖率截获起始地址 （可选板， 8M））：

仿真器指定 8 MB 范围内的测量起始地址。仅当扩
展剖析单元连接到仿真器时，此功能才可用。

[OK] （确定）： 设置指定条件并关闭对话框。

[Cancel] （取消）： 关闭对话框，不设置指定条件。
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仿真器初始化之后，该对话框仅显示一次。要打开此对话框，请从 [Code Coverage] （代码覆盖率）窗口的
弹出菜单中选择 [Hardware Settings...] （硬件设置…）。当 [Coverage Acquisition Range Setting] （覆盖率截获范
围设置）对话框关闭时， [Open Coverage] （打开覆盖率）对话框出现。

图 5.107   [Open Coverage] （打开覆盖率）对话框

在此对话框中，指定要在 [Code Coverage] （代码覆盖率）窗口中显示的范围。

单击该对话框中的 [OK] （确定）按钮，打开 [Code Coverage] （代码覆盖率）窗口。指定地址范围和指定
源文件时的显示格式不同。

[New Window] （新窗口）：

[Start address] （起始地址）：

[End address] （结束地址）：

指定新的覆盖率范围。

输入要显示的覆盖率信息的起始地址（省略前缀时，使用十六进制）。

输入要显示的覆盖率信息的结束地址（省略前缀时，使用十六进制）。

[File] （文件）： 指定当前工程中文件类型名为 “.C”或 “.CPP”的源文件。这样便可将
指定文件中包括的函数设置为覆盖率范围。如果省略文件类型名称，则
自动指定 “.C”。此处只能指定类型名称为 “.C”或 “.CPP”的文件。
可以使用占位符或 [Browse...] （浏览…）按钮。

[Open a recent coverage file]
（打开最近使用过的覆盖率
文件）：

列出最多四个最近保存的文件。从列表中选择一个。

[Browse to another coverage file]
（浏览其他覆盖率文件）：

允许指定未包含在列表中的文件。
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[Code Coverage] （代码覆盖率）窗口 （指定地址）

图 5.108   [Code Coverage] （代码覆盖率）窗口 （指定地址）

[Code Coverage] （代码覆盖率）窗口被分割条一分为二。

• 左窗口

显示覆盖率范围和覆盖率的统计信息。显示以下项目：

如果从左窗口的弹出菜单中选择 [Percentage] （百分比），则在 [Statistic] （统计）列中显示百分比。

图 5.109   [Code Coverage] （代码覆盖率）窗口中显示的百分比

• 右窗口

显示 C/C++ 或汇编语言级的覆盖率信息。显示以下项目：

[Range] （范围）： 地址范围

[Statistic] （统计）： C0 覆盖率值 （百分比）

[Executed] （已执行）： 1 （指令已执行）或 0 （指令未执行）

[Address] （地址）： 指令地址

[Assembler] （汇编程序）： 反汇编的程序

[Source] （源）： C/C++ 或汇编源程序
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[Code Coverage] （代码覆盖率）窗口 （指定源文件）

图 5.110   [Code Coverage] （代码覆盖率）窗口 （指定源文件）

该窗口被分割条一分为二。

• 左窗口

显示覆盖率范围和覆盖率的统计信息。显示以下项目：

如果从左窗口的弹出菜单中选择 [Percentage] （百分比），则在 [Statistic] （统计）列中显示百分比。单击
列标签可以降序或升序排列要列出的函数名称或 C0 覆盖率值。

• 右窗口

显示 C/C++ 或汇编语言级别的函数 （通过在左窗口中双击选择）的覆盖率信息。显示以下项目：

5.15.2 显示源文件

选择弹出菜单中的 [Display a Source File] （显示源文件），打开 [Editor] （编辑器）窗口，该窗口显示 
[Code Coverage] （代码覆盖率）窗口上光标所在地址对应的源文件。

[Functions] （函数）： 选定进行覆盖的函数

[Statistic] （统计）： C0 覆盖率值 （百分比）

[Executed] （已执行）： 1 （指令已执行）或 0 （指令未执行）

[Address] （地址）： 指令地址

[Assembler] （汇编程序）： 反汇编的程序

[Source] （源）： C/C++ 或汇编源程序
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5.15.3 更改要显示的地址

选择弹出菜单中的 [Go To Address...] （转至地址…），打开 [Go To Address] （转至地址）对话框，用户可
通过该对话框更改要在 [Code Coverage] （代码覆盖率）窗口中显示的地址。

图 5.111   [Go To Address] （转至地址）对话框

5.15.4 更改要显示的覆盖率范围

• 已通过地址指定了显示的覆盖率范围

选择弹出菜单中的 [Set Range...] （设置范围…），打开 [Coverage Display Range] （覆盖率显示范围）对话
框，用户可以通过该对话框更改已执行指令相关信息的截获条件。

图 5.112   [Coverage Display Range] （覆盖率显示范围）对话框

可指定以下项目。

单击 [OK] （确定）按钮更改要显示的覆盖率范围。

[Start Address] （起始地址）： 起始地址 （如果省略前缀，则采用十六进制）

[End Address] （结束地址）： 结束地址 （如果省略前缀，则采用十六进制）
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• 已通过源文件指定了显示的覆盖率范围

选择弹出菜单中的 [Set Range...] （设置范围…），打开 [Coverage Display Range] （覆盖率显示范围）对话
框，用户可以通过该对话框更改已执行指令相关信息的截获条件。

图 5.113   [Coverage Display Range] （覆盖率显示范围）对话框 （指定源文件）

可指定以下项目。

单击 [OK] （确定）按钮更改要显示的覆盖率范围。

5.15.5 清除覆盖率信息

• 清除指定范围内的覆盖率信息

选择弹出菜单中的 [Clear Coverage Range...] （清除覆盖率范围…），打开 [Clear Coverage Range] （清除覆
盖率范围）对话框。

图 5.114   [Clear Coverage Range] （清除覆盖率范围）对话框

输入要清除范围的起始地址和结束地址。单击 [OK] （确定）按钮清除选定范围的覆盖率信息。

• 清除所有覆盖率信息

选择弹出菜单中的 [Clear the Entire Coverage] （清除全部覆盖率）可清除所有覆盖率信息。

[File] （文件）： 指定当前工程中文件类型名为 “.C”或 “.CPP”的源文件。这样便可将指定文件中包
括的函数设置为覆盖率范围。如果省略文件类型名称，则指定 “.C”。此处只能指定类
型名称为 “.C”或 “.CPP”的文件。可以使用占位符或 [Browse...] （浏览…）按钮。
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5.15.6 将覆盖率信息保存至文件

选择弹出菜单中的 [Save Data...] （保存数据…），打开 [Save Coverage Data] （保存覆盖率数据）对话框。

图 5.115   [Save Coverage Data] （保存覆盖率数据）对话框

指定要保存的覆盖率信息文件的位置和名称。可以使用占位符或 [Browse...] （浏览…）按钮。如果省略文
件扩展名，则自动添加 “.COV”作为文件扩展名。如果输入 “.COV”或 “.TXT”以外的文件扩展名，则会
显示错误信息。

5.15.7 从文件装入覆盖率信息

选择弹出菜单中的 [Load Data...] （装入数据…），打开 [Load Data] （装入数据）对话框。

图 5.116   [Load Data] （装入数据）对话框

指定要装入的覆盖率信息文件的位置。可以使用占位符或 [Browse...] （浏览…）按钮。唯一可用的文件扩
展名是 “.COV”。如果输入任何其他文件扩展名，则会显示错误信息。

注意：如果已通过源文件指定了覆盖率范围，则无法装入保存的 “.COV”文件。

5.15.8 更新覆盖率信息

选择弹出菜单中的 [Refresh] （刷新）可更新 [Code Coverage] （代码覆盖率）窗口的内容。

5.15.9 阻止覆盖率信息更新

选择弹出菜单中的 [Lock Refresh] （锁定刷新）可阻止 [Code Coverage] （代码覆盖率）窗口在用户程序执
行停止期间更新。这样也可避免通过存取仿真器来截获覆盖率信息。
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5.15.10 [Confirmation Request] （确认请求）对话框

• 清除代码覆盖率信息或关闭 [Code Coverage] （代码覆盖率）窗口

清除代码覆盖率信息或关闭 [Code Coverage] （代码覆盖率）窗口前，会显示确认对话框。

图 5.117   [Confirmation Request] （确认请求）对话框

如果选中 [Save Coverage Data] （保存覆盖率数据）选项，则在清除覆盖率数据前可以将其保存为文件。
单击 [OK] （确定）按钮清除覆盖率信息。

• 已选择 [File -> Save Session] （文件 -> 保存会话）

打开一个或多个 [Code Coverage] （代码覆盖率）窗口时，要打开的 [Save Code Coverage] （保存代码覆盖
率）对话框的数量与 [Code Coverage] （代码覆盖率）窗口的数量相同。窗口数据既可单独保存，也可一起保存。

图 5.118   [Save Code Coverage] （保存代码覆盖率）对话框

单击 [No To All] （全否）关闭对话框，不保存任何覆盖率信息。单击 [Yes To All] （全是）将 [Code Coverage]
（代码覆盖率）窗口的所有数据保存为一个文件。
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5.15.11 在 [Editor] （编辑器）窗口中显示代码覆盖率信息

突出显示与源代码行（指令已执行）对应的代码覆盖率列可在 [Editor] （编辑器）窗口中显示覆盖率信息。
如果用户更改了有关 [Code Coverage] （代码覆盖率）窗口中覆盖率信息的任何设置，则对应的代码覆盖率列的
内容亦随之更新。

图 5.119   [Code Coverage] （代码覆盖率）列
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第 6 章 教程

6.1 简介

本章使用教程程序来介绍仿真器的主要功能。

此教程程序基于对十个随机数据项进行升序或降序排序的 C++ 程序。此教程程序执行下列操作：

· main 函数生成要排序的随机数据。

· sort 函数按升序对生成的随机数据进行排序。

· 然后 change 函数按降序对这些数据进行排序

文件 tutorial.cpp 包含教程程序的源代码。文件 Tutorial.abs 是经过编译的 Dwarf2 格式的装入
模块。

注意：1. Tutorial.abs 的操作属于大端法。要实现小端法操作，必须重新编译 Tutorial.abs。重
新编译后的地址可能与本章所述的地址不同。

2. 本章介绍仿真器的常规用法示例。有关特定产品的规格，请参阅补充文件 “有关使用 SHxxxx 
的补充信息”或在线帮助。

3. 每个产品附送的 Tutorial.abs 的操作地址因产品而异。

6.2 运行 HEW

要运行 HEW，请参阅第 4.1 节 “系统检查”。

6.3 设置仿真器

· AUD 时钟

截获 AUD 跟踪时使用的时钟。

如果它的频率设置过低，则在实时跟踪过程中可能无法截获完整的数据。

不要将频率设置为超出 MCU 的 AUD 时钟的上限。

只有在使用具有 AUD 跟踪功能的仿真器时，才需要 AUD 时钟。

· JTAG (H-UDI) 时钟 (TCK)
除用于截获 AUD 跟踪的时钟以外的通信时钟。

如果它的频率设置得过低，则下载速度将降低。

不要将频率设置为超出 MCU 的可保证 TCK 范围的上限。

有关两种时钟的限制的详细信息，请参阅补充文档 “有关使用 SHxxxx 的补充信息”中 “关于使用 JTAG 
(H-UDI) 时钟 (TCK) 和 AUD 时钟 (AUDCK) 的说明”一节。下文介绍了时钟设置过程。
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6.4 设置 [Configuration] （配置）对话框

· 从 [Options] （选项）菜单中依次选择 [Emulator] （仿真器）和 [Systems...] （系统）来设置通信时钟。
此时显示 [Configuration] （配置）对话框。

图 6.1   [Configuration] （配置）对话框

· 在 [AUD clock] （AUD 时钟）和 [JTAG clock] （JTAG 时钟）组合框中设置适当的值。该时钟还以默
认值工作。

注意：可在该对话框中设置的项目因产品而异。有关各产品的设置的详细信息，请参阅在线帮助。

· 单击 [OK] （确定）按钮设置配置。
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6.5 检查用于下载的目标存储器的操作情况

检查用于下载的目标存储区是否正常操作。

当目标存储器是 SDRAM 或 DRAM 时，必须在下载之前设置目标单片机的总线控制器中的寄存器。根据
要使用的存储器类型，在 [IO] 窗口中正确设置总线控制器。

完成必需的设置 （如总线控制器的设置）后，在 [Memory] （存储器）窗口中显示和编辑目标存储器的内
容，以检查该存储器是否正常操作。

注意：上述检查存储器工作情况的方法可能不适当。建议创建一个检查存储器的程序。

· 从 [View] （视图）菜单的 [CPU] 子菜单中选择 [Memory...] （存储器…），在 [Display Address] （显示
地址）编辑框中输入 H'00000000 。

图 6.2   [Format] （格式）对话框

· 单击 [OK] （确定）按钮。此时显示 [Memory] （存储器）窗口，窗口中显示指定的存储区。

图 6.3   [Memory] （存储器）窗口

· 将鼠标光标放在 [Memory] （存储器）窗口中数据显示区的某个点，然后双击即可更改该点处的值。
还可直接编辑文本光标当前位置周围的数据。
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6.6 下载教程程序

6.6.1 下载教程程序

下载要调试的目标程序。

· 从 [Download modules] （下载模块）下的 [Tutorial.abs] 中选择 [Download module] （下载模块）。

图 6.4   下载教程程序
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6.6.2 显示源程序

用户可使用 HEW 在源代码级别调试用户程序。

· 双击 [C++ source file] （C++ 源文件）下的 [tutorial.cpp]。

图 6.5   [Editor] （编辑器）窗口 （显示源程序）

· 必要时，从 [Setup] （设置）菜单中的 [Format...] （格式…）选项中选择显示清晰的字体和字号。

最初 [Editor] （编辑器）窗口显示用户程序的起始部分，但用户可使用滚动条查看用户程序中的其他语句。
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6.7 设置软件断点

软件断点是一种简单的调试功能。

通过 [Editor] （编辑器）窗口，可在程序中的任意位置轻松设置软件断点。例如，要在 sort 函数调用处设
置软件断点，请执行以下操作：

· 双击 sort 函数调用所在的行上的 [S/W Breakpoints] （软件断点）列，以进行选择。

图 6.6   [Editor] （编辑器）窗口 （设置软件断点）

sort 函数所在的行上将出现 ● 符号。这表示软件断点设置完毕。

注意：不能在 ROM 区设置软件断点。
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6.8 设置寄存器

在执行程序前设置程序计数器和堆栈指针的值。

· 从 [View] （视图）菜单的 [CPU] 子菜单中选择 [Registers] （寄存器）。此时显示 [Register] （寄存器）
窗口。

图 6.7   [Register] （寄存器）窗口
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· 要更改程序计数器 (PC) 的值，请用鼠标双击 [Register] （寄存器）窗口中的值区域。此时显示以下对
话框，可在对话框中对值进行更改。在本教程程序中将程序计数器设置为 H'00000800，然后单击 [OK]
（确定）按钮。

图 6.8   [Register] （寄存器）窗口

· 以同样的方法更改堆栈指针 (SP) 的值。在本教程程序中将堆栈指针的值设置为 H'FF9F000。

图 6.9   [Register] （寄存器）对话框 (R15)
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6.9 执行程序

按以下过程执行程序：

· 要执行程序，请从 [Debug] （调试）菜单中选择 [Go] （执行），或者单击工具栏上的 [Go] （执行）
按钮。

图 6.10   [Go] （执行）按钮

开始执行程序后，状态栏上会显示 “**RUNNING”（** 正在运行），然后执行的 PC 地址会显示在支持 
MCU 状态截获功能的产品中。程序将一直执行到所设置的断点处， [S/W Breakpoints] （软件断点）列中将显
示一个箭头，指示程序暂停的位置，并在状态栏中显示信息 [BREAKPOINT] （断点）。

注意：1. 暂停之后显示源文件时，可能会查询源文件的路径。源文件的位置如下：
<Directory where the OS has been installed>\WorkSpace\Tutorial\E200\xxxx\Tutorial。

2. 如果程序执行失败，则从 [Debug] （调试）菜单中选择 [Reset CPU] （复位 CPU），复位器件，
然后重新执行从图 6.8 开始的步骤。

图 6.11   [Editor] （编辑器）窗口 （暂停状态）
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用户可在 [Status] （状态）窗口中看到上次发生暂停的原因。

· 从 [View]（视图）菜单的 [CPU] 子菜单中选择 [Status]（状态）。显示 [Status]（状态）窗口后，打开 
[Platform] （平台）页，检查 Cause of last break（上次暂停的原因）的 Status （状态）。

图 6.12   [Status] （状态）窗口

注意：可在该窗口中显示的项目因产品而异。有关可显示的项目，请参阅在线帮助。
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6.10 检查断点

用户可在 [Event] （事件）窗口中看到程序中设置的所有断点。

· 从 [View] （视图）菜单的 [Code] （代码）子菜单中选择 [Eventpoints] （事件点）。此时显示 [Event]
（事件）窗口。选择 [Breakpoint] （断点）页。

图 6.13   [Event] （事件）窗口

在用鼠标右键单击 [Event] （事件）窗口打开的弹出菜单中，用户可设置或更改断点，定义新断点，
以及删除、允许或禁止断点。
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6.11 了解符号

使用 [Label] （标签）窗口可显示与模块中的符号相关的信息。

从 [View] （视图）菜单的 [Symbol] （符号）子菜单中选择 [Label] （标签）。此时显示 [Label] （标签）窗
口，用户可从中了解模块中符号的地址。

图 6.14   [Label] （标签）窗口
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6.12 查看存储器

指定标签名称后，用户可在 [Memory] （存储器）窗口中查看该标签注册的存储器内容。例如，要查看与 
_main 对应的、字大小的存储器内容：

· 从 [View] （视图）菜单的 [CPU] 子菜单中选择 [Memory...] （存储器…），在 [Display Address] （显示
地址）编辑框中输入 _main 。

图 6.15   [Format] （格式）对话框

· 单击 [OK] （确定）按钮。此时显示 [Memory] （存储器）窗口，窗口中显示指定的存储区。

图 6.16   [Memory] （存储器）窗口
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6.13 监视变量

用户逐句执行程序时，可能会看到用户程序中所用变量的值发生改变。例如，执行以下过程，便可在程序
开头声明的长类型数组 a 上设置监视：

· 单击 [Editor] （编辑器）窗口中显示的数组 a 的左侧以定位光标。

· 用鼠标右键选择 [Instant Watch...] （即时监视…）。

此时显示以下对话框。

图 6.17   [Instant Watch] （即时监视）对话框

· 单击 [Add] （添加）按钮向 [Watch] （监视）窗口中添加一个变量。

图 6.18   [Watch] （监视）窗口 （显示数组）

用户还可通过指定变量的名称向 [Watch] （监视）窗口中添加变量。

· 用鼠标右键单击 [Watch] （监视）窗口，从弹出菜单中选择 [Add Watch...] （添加监视…）。

此时显示以下对话框。输入变量 i。

图 6.19   [Add Watch] （添加监视）对话框
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· 单击 [OK] （确定）按钮。

[Watch] （监视）窗口现在也将显示变量 i。

图 6.20   [Watch] （监视）窗口 （显示变量）

用户可单击 [Watch] （监视）窗口中数组 a 左侧的 “+”标记来监视所有元素。

图 6.21   [Watch] （监视）窗口 （显示数组元素）
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6.14 显示局部变量

用户可使用 [Locals] （局部变量）窗口显示函数中的局部变量。例如，我们将检查 main 函数中的局部变
量，该函数声明四个局部变量：a、 j、 i 和 p_sam。

· 从 [View] （视图）菜单的 [Symbol] （符号）子菜单中选择 [Locals] （局部变量）。此时显示 [Locals]
（局部变量）窗口。

[Locals] （局部变量）窗口显示程序计数器当前所指向的函数中的局部变量及其值。但是，请注意，
[Locals] （局部变量）窗口最初是空的，因为还未声明局部变量。

图 6.22   [Locals] （局部变量）窗口

· 单击 [Locals] （局部变量）窗口中数组 a 左侧的 “+”标记可显示元素。

· 执行 sort 函数前后检查数组 a 的元素，并确认随机数据以降序排序。
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6.15 单步执行程序

HEW 提供了一系列步进菜单命令，可有效调试程序。

6.15.1 执行 [Step In] （跳入）命令

[Step In] （跳入）命令跳入被调用函数，并在被调用函数的第一个语句处停止。

· 要单步执行 sort 函数，请从 [Debug] （调试）菜单中选择 [Step In] （跳入），或者单击工具栏上的 
[Step In] （跳入）按钮。

图 6.23   [Step In] （跳入）按钮

表 6.1   步进选项

Menu Command （菜单命令） Description （说明）

Step In （跳入） 执行每个语句，包括函数内的语句。

Step Over （跳过） 以单步执行一个函数调用。

Step Out （跳出） 跳出函数，并在程序中调用该函数的语句后的语句处停止。

Step... （单步执行…） 以指定的速率和次数重复单步执行。
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图 6.24   [Editor] （编辑器）窗口 （跳入）

· 突出显示的行移至 [Editor] （编辑器）窗口中的 sort 函数的第一个语句。
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6.15.2 执行 [Step Out] （跳出）命令

[Step Out] （跳出）命令跳出被调用函数，并在主函数中调用语句的下一语句处停止。

· 要跳出 sort 函数，请从 [Debug] （调试）菜单中选择 [Step Out] （跳出），或者单击工具栏上的 
[Step Out] （跳出）按钮。

注意：执行此函数需要一些时间。查明调用源后，使用 [Go To Cursor] （转至光标）。

图 6.25   [Step Out] （跳出）按钮

图 6.26   [HEW] 窗口 （跳出）

[Watch] （监视）窗口中显示的变量 a 的数据以升序排序。
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6.15.3 执行 [Step Over] （跳过）命令

[Step Over] （跳过）命令在单步中执行函数调用，并在主程序的下一语句处停止。

· 按照第 6.15.1 节 “执行 [Step In] （跳入）命令”所述的过程移至 change 函数。

· 要在单步中执行 change 函数中的所有语句，请从 [Debug] （调试）菜单中选择 [Step Over] （跳过），
或者单击工具栏上的 [Step Over] （跳过）按钮。

图 6.27   [Step Over] （跳过）按钮

图 6.28   [HEW] 窗口 （跳过）
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6.16 强制暂停程序执行

HEW 可在执行程序时强制暂停。

· 取消所有暂停。

· 要执行 main 函数的余下部分，请从 [Debug] （调试）菜单中选择 [Go] （执行），或者单击工具栏上
的 [Go] （执行）按钮。

图 6.29   [Go] （执行）按钮

· 程序进入死循环。要强制暂停执行，请从 [Debug] （调试）菜单中选择 [Halt] （暂停），或者单击工
具栏上的 [Stop] （停止）按钮。

图 6.30   [Stop] （停止）按钮

6.17 断点功能

仿真器具有软件断点功能和通过事件点实现的断点功能。在 HEW 中，可使用 [Event] （事件）窗口的 
[Breakpoint] （断点）页设置软件断点。可使用 [Onchip Event] （Onchip 事件）、 [AUD Event] （AUD 事件）、
[Other Event] （其他事件）和 [BUS Event] （BUS 事件）页按事件类型设置事件点条件设置。

下文简单介绍了断点功能及其设置。
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6.17.1 软件断点功能

仿真器可设置软件断点。下文介绍了第 6.7 节“设置软件断点”所述的软件断点设置方法之外的其他方法。

· 从 [View] （视图）菜单的 [Code] （代码）子菜单中选择 [Eventpoints] （事件点）。此时显示 [Event]
（事件）窗口。

· 选择 [Breakpoint] （断点）页。

图 6.31   [Event] （事件）窗口 （设置软件断点之前）



SH-2A、 SH-2 E200F 仿真器 第 6 章   教程

Rev.1.00  2007.09.21  Page 245 of 279
RCJ10J0048-0100

· 用鼠标右键单击 [Event] （事件）窗口，从弹出菜单中选择 [Add...] （添加…）。

· 在 [Address] （地址）编辑框中输入具有 “p_sam->s0=a[0];”的一行的地址。

图 6.32   [Breakpoint] （断点）对话框

注意：此对话框因产品而异。有关各产品的此对话框中的项目，请参阅在线帮助。

· 单击 [OK] （确定）按钮。

已设置的软件断点显示在 [Event] （事件）窗口中。

图 6.33   [Event] （事件）窗口 （软件断点设置）
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注意：可在该窗口中显示的项目因产品而异。有关可显示的项目，请参阅在线帮助。

要在软件断点处停止教程程序，必须执行以下过程：

· 在 [Registers] （寄存器）窗口中设置第 6.8 节 “设置寄存器”中设置的程序计数器和堆栈指针值
（PC = H'00000800， R15 = H'FF9F000）。单击 [Go] （执行）按钮。

· 如果程序执行失败，请复位器件，然后再次执行上述过程。

此时程序开始运行，并在设置的软件断点处停止。

图 6.34   执行停止时的 [Editor] （编辑器）窗口 （软件断点）
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[Status] （状态）窗口显示以下内容。

图 6.35   [Status] （状态）窗口的显示内容 （软件断点）

注意：可在该窗口中显示的项目因产品而异。有关可显示的项目，请参阅在线帮助。

6.18 通过事件点实现的断点功能

使用仿真器，可设置 Onchip Eventpoint （Onchip 事件点）、 AUD Eventpoint （AUD 事件点）、 Other 
Eventpoint （其他事件点）和 BUS Eventpoint （BUS 事件点）。以下示例介绍如何使用 Onchip 事件点设置断
点。有关其他事件点设置方法，请参阅第 5.8 节 “使用事件点”。

6.18.1 通过 Onchip 事件点设置断点

在下文所述的方法中，地址总线条件是在 Onchip 事件点的事件通道 1 下设置的。

· 从 [View] （视图）菜单的 [Code] （代码）子菜单中选择 [Eventpoints] （事件点）。此时显示 [Event]
（事件）窗口。

· 以前设置的软件断点将被删除。用鼠标右键单击 [Event] （事件）窗口，然后从弹出菜单中选择 
[Delete All] （全部删除），取消已设置的所有软件断点。

· 要设置 Onchip 事件点，请单击 [Onchip Eventpoint] （Onchip 事件点）。此处，设置了事件通道 1。

注意：Onchip 事件点的事件通道数量因产品而异。有关可为每个产品指定的数目，请参阅在线帮助。
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· 在 [Event] （事件）窗口中选择 Ch1 （通道 1）所在的行。该行突出显示后，双击该行。

图 6.36   [Event] （事件）窗口 （[Onchip Event] （Onchip 事件）页）

· 此时显示 [Event condition 1] （事件条件 1）对话框。

· 清除 [Address] （地址）页面中的 [Don't care] （忽略）复选框。

· 选择 [Only program fetched address after] （仅在程序访问该地址之后），输入 main 函数的 
p_sam->sort(a);  所在列的地址。

图 6.37   [Address] （地址）页面 （[Event condition 1] （事件条件 1）对话框）
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注意：可在该对话框中设置的项目因产品而异。有关各产品的设置的详细信息，请参阅在线帮助。

· 单击 [OK] （确定）按钮。

· State （状态）行中第一项的显示从 Disable （禁止）改为 Enable （允许）。

· Condition （条件）行中第一项的显示从 None （无）改为 Address = H'xxxxxxxx pc Break
（地址 = H'xxxxxxxx pc 暂停）。

· 在 [Registers] （寄存器）窗口中设置第 6.8 节 “设置寄存器”中设置的程序计数器和堆栈指针值
（PC = H'00000800， R15 = H'FFF9F000）。单击 [Go] （执行）按钮。

· 如果程序执行失败，请复位器件，然后再次执行上述过程。

此时开始运行程序，并在满足事件通道 1 下指定的条件时停止。

图 6.38   执行停止时的 [Editor] （编辑器）窗口 （Onchip 事件点通道 1）
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[Status] （状态）窗口显示以下内容。

图 6.39   [Status] （状态）窗口的显示内容 （Onchip 事件通道 1）

注意：可在该窗口中显示的项目因产品而异。有关可显示的项目，请参阅在线帮助。

6.18.2 设置顺序 Onchip 事件点

顺序断点由 Onchip 事件点组合允许。

按如下所述设置 Onchip 事件点的满足条件：

按照上一节所述的方法进行设置。

要将这些事件点设置为顺序事件点，请执行以下操作：

· 用鼠标右键单击 [Event] （事件）窗口打开弹出菜单，从中选择 [Combination action] （组合操作）。
此时打开 [Combination action] （组合操作）对话框。

图 6.40   [Combination action] （组合操作）对话框

注意：可在该对话框中显示的项目因产品而异。有关可显示的项目，请参阅在线帮助。

Ch1(IA_OA)： 在读周期中访问 main 函数的 p_sam->sort(a); 所在的列的地址时，
即满足断点条件。

Ch2(IA_OA_DT_CT)： 在读周期中访问 main 函数的 a[i]=j; 所在的列的地址时，即满足断点
条件。
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· 选择 [Ch1,2,3] （通道 1、 2、 3）中的 [Break:Ch2-1] （断点：通道 2-1），然后单击 [OK] （确定）
按钮。

· 用鼠标右键单击 [Event Condition] （事件条件）页打开弹出菜单，从中激活 Event Condition 1 （事件
条件 1）的条件。

设置完毕后， [Event] （事件）窗口将如图 6.41 所示。

图 6.41   [Onchip Event] （Onchip 事件）页

注意：可在该对话框中显示的项目因产品而异。有关可显示的项目，请参阅在线帮助。

· 在 [Registers] （寄存器）窗口中设置第 6.8 节 “设置寄存器”中设置的程序计数器和堆栈指针值
（PC = H'00000800， R15 = H'FFF9F000）。单击 [Go] （执行）按钮。

· 如果程序执行失败，请复位器件，然后再次执行上述过程。
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此时开始运行程序，并在满足事件通道 1 下指定的条件时停止。

图 6.42   执行停止时的 [Editor] （编辑器）窗口 （顺序断点）
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[Status] （状态）窗口显示以下内容。

图 6.43   [Status] （状态）窗口的显示内容 （顺序断点）

注意：可在该窗口中显示的项目因产品而异。有关可显示的项目，请参阅在线帮助。

· 以前设置的顺序断点条件被删除。用鼠标右键单击 [Event] （事件）窗口，然后从弹出菜单中选择 
[Delete All] （全部删除），取消已设置的所有事件点条件。

· 用鼠标右键单击 [Event] （事件）窗口打开弹出菜单，从中选择 [Combination action] （组合操作）。
此时打开 [Combination action] （组合操作）对话框 （图6.40）。

· 选择 [Don't care] （忽略）单选按钮，然后单击 [OK] （确定）按钮。
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6.19 跟踪功能

仿真器具有以下五种跟踪功能。

· 内部跟踪功能

该功能使用 MCU 中内置的跟踪缓冲区，因此可截获实时跟踪。

可截获以下信息：

· 各种类型的跟踪信息：Trace Rn 指令执行过程中的转移信息、 CPU 中的存储器存取信息以及 PC 或 
Rn 值

· 跟踪截获地址值

· 数据值

· 助记符

· 操作数

· 源代码行

注意：1. 跟踪可截获的转移指令的数目因产品而异。有关可为每个产品指定的数目，请参阅在线帮助。

2. 并非所有产品都支持内部跟踪功能。有关各产品规格的详细信息，请参阅在线帮助。

3. 内部跟踪功能并非可扩展用于所有产品。有关各产品规格的详细信息，请参阅在线帮助。

· AUD 跟踪功能

这是一种大范围跟踪功能，在 AUD 引脚连接到仿真器时可用。如果将一组转移源和转移目标指令看
作是一个转移，则跟踪可截获的最大信息量为 262,144。

可截获以下信息：

· 各种类型的跟踪信息：Trace Rn 指令执行过程中的转移信息、 CPU 中的存储器存取信息以及 PC 或 
Rn 值

· 跟踪截获地址值

· 数据值

· 外部探针引脚状态

· 时戳值

· 助记符

· 操作数

· 源代码行

注意：1. 并非所有产品都支持 AUD 跟踪功能。有关各产品规格的详细信息，请参阅在线帮助。

2. AUD 跟踪功能可截获的跟踪信息的类型因产品而异。有关各产品的规格或截获的转移的数目的
详细信息，请参阅在线帮助。

3. 执行多个循环来减少 AUD 跟踪显示的数目时，只有 IP 计数随产品而更新。
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· 存储器输出跟踪功能

该功能用于将跟踪结果写入指定的存储器范围。从 [Trace] （跟踪）窗口中写入的存储器范围中读取
数据，然后显示结果。这是一种大范围跟踪功能，在器件的 AUD 引脚未连接到仿真器时有效。

注意：一些产品不支持存储器输出跟踪信息。有关各产品规格的详细信息，请参阅在线帮助。

· 外部总线跟踪单元

这是一种大范围跟踪功能，在 MCU 的外部总线引脚连接到仿真器时有效。

外部总线跟踪功能每个总线周期最多可截获 262,144 个周期的信息。

可截获以下信息：

· 外部总线地址值

· 外部总线数据值

· 中断信号状态

· 时戳值

· 助记符

· 操作数

· 源代码行

注意：可截获的跟踪信息的类型因产品而异。有关规格的详细信息，请参阅在线帮助。

6.19.1 显示 [Internal/AUD] （内部 /AUD）窗口

从 [View] （视图）菜单的 [Code] （代码）子菜单中选择 [Trace] （跟踪）。此时显示 [Trace Window Type]
（跟踪窗口类型）对话框。

图 6.44   [Trace Window Type] （跟踪窗口类型）对话框

选择 [Internal/AUD] （内部 /AUD），然后单击 [OK] （确定）按钮。此时显示 [Internal/AUD] （内部 /
AUD）窗口。

(1) 内部跟踪功能

下文介绍内部跟踪的截获方法。

(a) 设置跟踪截获模式

用鼠标右键单击 [Internal/AUD] （内部 /AUD）窗口，然后从弹出菜单中选择 [Settings...] （设置…），显
示 [I-Trace/AUD-Trace acquisition] （内部跟踪 /AUD 跟踪截获）对话框。
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图 6.45   [I-Trace/AUD-Trace acquisition] （内部跟踪 /AUD 跟踪截获）对话框

在 [Trace Type] （跟踪类型）中选择 [I-Trace] （内部跟踪），然后单击 [OK] （确定）按钮。
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(b) 设置跟踪截获条件

在 [I-Trace/AUD-Trace acquisition] （内部跟踪 /AUD 跟踪截获）对话框中选择转移源或转移目标中的
信息截获。在 [Acquisition] （截获）中选择要截获的条件后，单击 [I-Trace/AUD-Trace acquisition]
（内部跟踪 /AUD 跟踪截获）对话框中的 [OK] （确定）按钮。

图 6.46   [I-Trace/AUD-Trace acquisition] （内部跟踪 /AUD 跟踪截获）对话框

注意：可在该对话框中设置的项目因产品而异。有关各产品的设置的详细信息，请参阅在线帮助。
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(c) 显示跟踪结果

运行第 6.17.1 节 “软件断点功能”的示例中所示的程序。程序执行完毕后，内部跟踪结果显示在 [Internal/
AUD] （内部 /AUD）窗口中。

图 6.47   [Internal/AUD] （内部 /AUD）窗口

· 如有必要，请拖动标头栏 （紧挨在标题栏下面）中的边框来调整列宽。

注意：跟踪可截获的信息的类型和数量因产品而异。有关各产品规格的详细信息，请参阅在线帮助。

(2) AUD 跟踪功能

当 MCU 的 AUD 引脚连接到仿真器时，该功能可用。

以下示例截获从地址 H'1000 到 H'10FF 的存储器存取信息。

以下介绍设置 AUD 跟踪功能的过程。

(a) 设置 AUD 跟踪条件

设置条件，以便 AUD 跟踪条件可设置为 MCU 上从 AUD 引脚输出的执行信息。

· 在 [I-Trace/AUD-Trace acquisition] （内部跟踪 /AUD 跟踪截获）对话框中的 [Trace type] （跟踪类型）
中设置 [AUD function] （AUD 功能）。

· 选中 [Window trace] （窗口跟踪）和 [Channel A] （通道 A）复选框。

· 选择 [Window trace] （窗口跟踪）页面。在 [Channel A] （通道 A）分组框中，为 [Read/Write] （读 /
写）设置 Read/Write （读 /写），为 [Start address] （起始地址）设置 H'1000，为 [End address] （结束
地址）设置 H'10FF，并为 [Bus state] （总线状态）设置 M-BUS。

· 在 [I-Trace/AUD-Trace acquisition] （内部跟踪 /AUD 跟踪截获）对话框中单击 [OK] （确定）按钮。
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图 6.48   设置 [I-Trace/AUD-Trace acquisition] （内部跟踪 /AUD 跟踪截获）对话框

（[Window trace] （窗口跟踪）页面）
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(b) 设置跟踪截获模式

选择 [I-Trace/AUD-Trace acquisition] （内部跟踪 /AUD 跟踪截获）对话框的 [Trace mode] （跟踪模式）页
面。用鼠标右键单击此对话框，然后从弹出菜单中选择 [Settings...] （设置…），显示 [I-Trace/AUD-Trace 
acquisition] （内部跟踪 /AUD 跟踪截获）对话框。

AUD 跟踪截获条件设置完毕。

图 6.49   设置 [I-Trace/AUD-Trace acquisition] （内部跟踪 /AUD 跟踪截获）对话框

（[Trace mode] （跟踪模式）页面）

注意：可在该窗口中设置的项目因产品而异。有关各产品的设置的详细信息，请参阅在线帮助。
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(c) 显示跟踪结果

运行第 6.17.1 节 “软件断点功能”的示例中所示的程序。程序执行完毕后，跟踪结果显示在 [Internal/
AUD] （内部 /AUD）窗口中。

图 6.50   [Internal/AUD] （内部 /AUD）窗口 （示例）

6.19.2 显示 [BUS trace] （BUS 跟踪）窗口

从 [View] （视图）菜单的 [Code] （代码）子菜单中选择 [Trace] （跟踪）。此时显示 [Trace Window Type]
（跟踪窗口类型）对话框。

图 6.51   [Trace Window Type] （跟踪窗口类型）对话框

选择 [Internal/AUD] （内部 /AUD），然后单击 [OK] （确定）按钮。此时显示 [Internal/AUD] （内部 /AUD）
窗口。

(1) 外部总线跟踪功能

当 MCU 的外部总线引脚连接到仿真器时，该功能可用。下文介绍外部总线跟踪的截获方法。

(a) 设置总线跟踪

参考第 2.5.2 节“在使用外部总线跟踪单元时更改功能”，设置总线引脚或连接的存储器的多路复用状态。

(b) 设置跟踪截获模式
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用鼠标右键单击 [BUS trace] （BUS 跟踪）窗口，然后从弹出菜单中选择 [Acquisition...] （截获…），显示 
[BUS acquisition] （BUS 截获）对话框。如图 6.52 所示为外部总线跟踪设置截获模式。

图 6.52   [BUS acquisition] （BUS 截获）对话框
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(c) 设置跟踪截获条件

以下是设置地址条件的示例。

如果要设置其他跟踪条件，请参阅第 5.8 节 “使用事件点”。

在 [Event] （事件）窗口的 [BUS Event] （BUS 事件）页上选择并双击 [Ch3 (Normal)] （通道 3 （普通））。
此时显示 [Ch3 (Normal)] （通道 3 （普通））对话框。

图 6.53   [Ch3 (Normal)] （通道 3 （普通））对话框 （[Address] （地址）页面）

· 选择 [Range] （范围）。

· 分别在 [Start] （起始）和 [End] （结束）中输入 H'2000 和 H'20FF。
· 在 [Action] （操作）页面中选择 [Trace get] （跟踪获取），然后单击 [OK] （确定）按钮。

· 截获存取外部存储器 H'2000 到 H'20FF 时的跟踪信息。
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(d) 显示跟踪结果

运行第 6.17.1 节“软件断点功能”的示例中所示的程序。程序执行完毕后，内部跟踪结果显示在 [BUS trace]
（BUS 跟踪）窗口中。

图 6.54   [BUS trace] （BUS 跟踪）窗口

· 如有必要，请拖动标头栏 （紧挨在标题栏下面）来调整列宽。

注意：跟踪可截获的信息的类型和数量因产品而异。有关各产品规格的详细信息，请参阅在线帮助。
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6.20 堆栈跟踪功能

仿真器使用堆栈信息来显示调用序列中的函数名称，此调用序列最终到达程序计数器当前所指向的函数。

注意：仅当装入模块已装入 Dwarf2 类型的调试信息后，才可使用该功能。SHC/C++ 编译器（包括 OEM 
和套装产品） V7.0 或以后版本支持此类装入模块。

· 双击 sort 函数中的 [S/W Breakpoints] （软件断点）列，设置软件断点。

图 6.55   [Editor] （编辑器）窗口 （软件断点设置）
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· 同样，使用 [Registers] （寄存器）窗口设置在第 6.8 节 “设置寄存器”中设置的程序计数器和堆栈指
针值 （PC = H'00000800， R15 = H'FFF9F000）。单击 [Go] （执行）按钮。

· 如果程序执行失败，请复位器件，然后再次执行上述过程。

· 程序执行暂停后，从 [View] （视图）菜单的 [Code] （代码）子菜单中选择 [Stack Trace] （堆栈跟踪）
打开 [Stack Trace] （堆栈跟踪）窗口。

图 6.56   [Stack Trace] （堆栈跟踪）窗口

图 6.56 显示出程序计数器的当前位置在 sort() 函数中的选定行，并且 sort() 函数是从 main() 函数
调用的。

要移除软件断点，请再次双击 sort 函数中的 [S/W breakpoints] （软件断点）列。

注意：有关此函数的详细信息，请参阅在线帮助。
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6.21 程序下载至闪存区域的功能

仿真器具有下载到闪存区域的功能。该功能需要一个用于写入闪存的程序 （在下文中称为写入模块）、一
个用于擦除闪存的程序 （在下文中称为擦除模块）以及用于下载和执行这些模块的 RAM 区。

注意：写入模块和擦除模块必须由用户准备。

· 与写入模块和擦除模块以及仿真器固件交互

写入模块和擦除模块必须是从仿真器固件转移的。要从仿真器固件转移到写入模块和擦除模块，或从
写入模块和擦除模块返回到仿真器固件，必须满足以下条件：

— 用汇编语言描述所有写入模块和擦除模块。

— 保存并返回所有常规寄存器值，并在调用写入模块或擦除模块前后控制寄存器值。

— 在处理后将写入模块或擦除模块返回到调用源。

— 写入模块和擦除模块必须是 Motorola 类型的文件。

模块接口必须符合以下规格，才能正确传递存取闪存所需的信息。

注意：(L) 表示长字大小。

表 6.2   模块接口

Module Name （模块名称） Argument （参数） Return Value （返回值）

写入模块 R4(L)：写入地址

R7(L)：验证选项

0 = 不验证，

1 = 验证

R5(L)：存取大小

0x4220 = 字节，

0x5720 = 字，

0x4C20 = 长字

R6(L)：写入数据

R0(L)：结束代码

正常结束 = 0，

异常结束 = 0 以外的值，

验证错误 = BT

擦除模块 R4(L)：存取大小

0x4220 = 字节，

0x5720 = 字，

0x4C20 = 长字

无
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注意：写入模块：存取大小的写入数据设置为 R6 寄存器。当存取大小是字或字节时， 0 设置为 R6 寄存
器的高位。

· 闪存下载方法

如果要下载到闪存，请从 [Options] （选项）菜单中依次选择 [System...] （系统…）和 [Emulator] （仿
真器），打开 [Configuration] （配置）对话框，在该对话框的 [Loading flash memory] （装入闪存）页
面上设置项目。

图 6.57   [Loading flash memory] （装入闪存）页面
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表 6.3 介绍了 [Loading flash memory] （装入闪存）页面中的选项。

注意： 尽管可设置 D'1 到 D'65535 之间的值，但可根据所设置的值来延长 TIMEOUT 时间段。因此，建议输入最小值时

考虑所使用的闪存的擦除时间。

· 关于使用闪存下载功能的说明

以下是下载到闪存的相关说明。

— 允许闪存下载功能后，不能下载到闪存区以外的区域。

— 只允许下载到闪存区。只允许对 RAM 区执行存储器写入或软件中断。

— 允许闪存擦除功能后， [Stop] （停止）按钮不能停止擦除。

· 下载到闪存的示例 ]

以下是下载到闪存的示例，该闪存由 Intel Corporation 生产，型号是 G28F640J5-150，并按图6.58 所示
连接。安装目标文件夹中的 \Fmtool 文件夹中提供了一个样例。参考该样例创建一个满足用户规格的
程序。

表 6.3   [Loading flash memory] （装入闪存）页面选项

Option （选项） Description （说明）

[Loading flash memory]
（装入闪存）单选按钮

若要进行闪存下载，需设置为 Enable （允许）。

选择 Enable （允许），并从 [File] （文件）菜单中选择 [File load] （文件装入）
进行下载时，总是会调用写入模块。

Enable （允许）：下载到闪存

禁止：不下载到闪存

[Erasing flash memory]
（擦除闪存）单选按钮

若要在写入闪存前先擦除，需设置为 Enable （允许）。

如果选择 Enable （允许），则在调用写入模块之前先调用擦除模块。

Enable （允许）：擦除闪存

禁止：不擦除闪存

[File name] （文件名）编辑框 设置 S 类型的装入模块（包括写入模块和擦除模块）的文件名。已设置的文件
在装入到闪存中之前会先装入到 RAM 中。

最多可为文件名输入 128 个字符。

[Bus width of flash memory]
（闪存的总线宽度）列表框

设置闪存的总线宽度。

[Flash memory erasing time]
（闪存擦除时间）编辑框 *

设置闪存擦除的 TIMEOUT 值。默认时间为三分钟，如果擦除操作需要更多时间，
请增加该值。输入值的基数应当是十进制数。添加 H' 后将变成十六进制值。

[Entry point] （输入点）分组框 设置写入模块和擦除模块的调用目标地址。

[All erasing module address] （所有擦除模块地址）编辑框：输入擦除模块的
调用目标地址。

[Writing module address] （写入模块地址）编辑框：输入写入模块的调用目标
地址。

[Access size] （存取大小）组合框：选择用于装入写入 / 擦除模块的 RAM 区域
的存取大小。
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图 6.58   闪存线路

表 6.4   芯片板规格

Item （项目） Contents （内容）

SDRAM 地址 H'0C000000 到 H'0FFFFFFF

闪存地址 H'00000000 到 H'01FFFFFF

闪存的总线宽度 32 位

操作环境                       Endian 大端法

(32 MB)

A0-A22

SHxxxx

CE0

CE1,2

OE

WE

D0-D7

D8-D15

D0-D7

D8-D15

D0-D7

D8-D15

D0-D7

D8-D15

FPGA

FIA 

FIA 

FD 

A2-A24

CS0

CS2

RD

WE0

D0-D31

GND

0-7

8-15

16-23

24-31
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· 由于使用了 SDRAM，因此必须设置总线控制器。

· 如下图所示，在 [Configuration] （配置）对话框的 [Loading flash memory] （装入闪存）页面上设置
选项：

图 6.59   [Loading flash memory] （装入闪存）页面

表 6.5   样例程序规格

Item （项目） Contents （内容）

要使用的 RAM 区 H'0C001000 到 H'0C0015BF

写入模块起始地址 H'0C001100

擦除模块起始地址 H'0C001000
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注意：1. 在闪存中写入数据后，请务必在 [Erasing flash memory] （擦除闪存）中选择 [Enable] （允
许）。如果选择 [Disable] （禁止），则会出现验证错误。

2. 选择 [Erasing flash memory] （擦除闪存）后，大约需要一分钟来擦除闪存 （对本示例而言）。

· 选择要下载到闪存区域的对象。

6.22 后续内容

本教程介绍了仿真器的主要功能和 HEW 的使用。

使用仿真器提供的仿真功能可执行复杂调试。通过准确隔离和识别发生硬件和软件问题的条件，它可以有
效调查此类问题。
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第 7 章 疑难解答

1. 我在编辑器中打开了一个文本文件，但却没有显示语法分色编码。

请确保您为文件指定了名称 （即保存了文件），并且设置了 “Options”（选项）对话框 （通过 [Setup -> 
Options...] （设置 -> 选项…）启动）中“Editor”（编辑器）选项卡上的“Syntax coloring”（语法分色显示）

复选框。 HEW 通过检查文件扩展名来确定文件所属的组，并且决定是否应该将分色显示功能应用到文件。

若要查看当前定义的文件扩展名和文件组，请选择 [Project -> File Extensions...] （项目 -> 文件扩展名 ...）
来启动 “File Extensions”（文件扩展名）对话框。若要查看分色显示信息，请选择 [Setup -> Format] （设

置 -> 格式）来显示 “Format”（格式）对话框的 “Color”（颜色）选项卡 （有关详细信息，请参阅 
HEW 手册第 4 章 “Using the Editor”（使用编辑器）的 “Syntax Coloring”（语法分色显示）一节）。

2. 我想更改工具的设置，但无法选择 [Tools->Administration...] （工具 -> 管理…）菜单选项。

某个工作区打开时，无法选择 [Tools->Administration...] （工具 -> 管理…）。若要打开“Tool Administration”
（工具管理）对话框，请关闭当前工作区。

3. 我从我的 PC 打开了一个工作区，而我的一个同事同时从另一台 PC 打开了同一个工作区。我更改了工作

区的设置并且进行了保存。我的同事在我之后保存了工作区。我再次打开了工作区，发现工作区的设置与

我所做的设置不同。

最后保存的设置方为有效。在 HEW 中打开工作区时，对工作区的更新是在存储器中进行的。如果用户未

特意保存工作区，则设置不会保存在文件中。

除以上内容外，还可以在瑞萨网站 (www.renesas.com) 上查阅有关仿真器和 HEW 的常见问题解答。
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附录 A   菜单

表 A.1 显示了 GUI 菜单。
   

表 A.1    仿真器的功能

Menu
（菜单） Option （选项）

Shortcut
（快捷

方式）

Toolbar 
Button

（工具栏

按钮） Remarks （说明）

View
（视图）

Disassembly （反汇编） Ctrl + D 打开 [Disassembly] （反汇编）窗口。

Command Line （命令行） Ctrl + L 打开 [Command Line] （命令行）窗口。

TCL toolkit （TCL 工具包） Ctrl + 
Shift + L

打开 [Console] （控制台）窗口。

Workspace （工作区） Alt + K 打开 [Workspace] （工作区）窗口。

Output （输出） Alt + U 打开 [Output] （输出）窗口。

Difference （差异） 打开 [Difference] （差异）窗口。

CPU Registers （寄存器） Ctrl + R 打开 [Register] （寄存器）窗口。

Memory... （存储器…） Ctrl + M 打开 [Memory] （存储器）窗口。

IO Ctrl + I 打开 [IO] 窗口。

Status （状态） Ctrl + U 打开 [Status] （状态）窗口。

Cache （高速缓存） Shift + 
Ctrl + C

打开 [Cache] （高速缓存）窗口。

TLB Shift + 
Ctrl + X

打开 [TLB] 窗口。

Monitor
（监控器）

Monitor 
Setting...
（监控器
设置…）

Shift + 
Ctrl + E

打开 [Monitor Setting] （监控器设置）
对话框。

Window 
Select...
（窗口
选择…）

打开 [Window Select] （窗口选择）
对话框。

Extended Monitor
（扩展监控器）

打开 [Extended Monitor] （扩展监控器）
窗口。

Symbol
（符号）

Labels （标签） Shift + 
Ctrl + A

打开 [Labels] （标签）窗口。

Watch （监视） Ctrl + W 打开 [Watch] （监视）窗口。

Locals （局部变量） Shift + 
Ctrl + W

打开 [Locals] （局部变量）窗口。
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View
（视图）
（续）

Code
（代码）

Eventpoints （事件点） Ctrl + E 打开 [Event] （事件）窗口。

Trace （跟踪） Ctrl + T 打开 [Trace] （跟踪）窗口。

Code Coverage
（代码覆盖率）

Shift + 
Ctrl + H

打开 [Code Coverage] （代码覆盖率）窗口，
并显示此功能截获的结果。

Stack Trace （堆栈跟踪） Ctrl + K 打开 [Stack Trace] （堆栈跟踪）窗口。

Graphic
（图形）

Image... （图像…） Shift + 
Ctrl + G

打开 [Image] （图像）窗口。

Waveform... （波形 ...） Shift + 
Ctrl + V

打开 [Waveform] （波形）窗口。

Performance
（性能）

Performance Analysis
（性能分析）

Shift + 
Ctrl + P

打开 [Performance Analysis] （性能分析）
窗口。

Profile （剖析） Shift + 
Ctrl + F

打开 [Profile] （剖析）窗口。

Realtime Profile
（实时剖析）

Shift + 
Ctrl + Q

打开 [Realtime Profile] （实时剖析）窗口。

Setup
（设置）

Radix
（基数）

Hexadecimal （十六进制） 使用十六进制来显示基数，默认情况下在基数
中显示和输入数字值。

Decimal （十进制） 使用十进制来显示基数，默认情况下在基数中
显示和输入数字值。

Octal （八进制） 使用八进制来显示基数，默认情况下在基数中
显示和输入数字值。

Binary （二进制） 使用二进制来显示基数，默认情况下在基数中
显示和输入数字值。

Emulator
（仿真器）

System... （系统…） 打开 [Configuration Properties] （配置属性）
对话框，用户可以使用此对话框修改调试平台
设置。

Memory Resource...
（存储器资源…）

打开 [Memory Mapping] （存储器映像）对话
框来设置存储器映像。

Debug
（调试）

Debug Sessions... （调试会话…） 打开 [Debug Sessions] （调试会话）对话框
来列出、添加或移除调试会话。

Debug Settings... （调试设置…） 打开 [Debug Settings] （调试设置）对话框来
设置调试条件或下载模块。

Reset CPU （复位 CPU） 复位目标硬件并将 PC 设置为复位向量
地址。

Go （执行） F5 开始在当前 PC 处执行用户程序。

Reset Go （复位执行） Shift + 
F5

复位目标单片机并从复位向量地址开始执行用
户程序。

表 A.1    仿真器的功能 （续）

Menu
（菜单） Option （选项）

Shortcut
（快捷

方式）

Toolbar 
Button

（工具栏

按钮） Remarks （说明）
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Debug
（调试）
（续）

Go To Cursor （转至光标） 在当前 PC 处开始执行用户程序，直到 PC 到
达当前文本光标位置所指示的地址。

Set PC To Cursor （将 PC 设置到光标） 将 PC 设置到文本光标所在行的地址。

Run... （运行…） 启动 [Run Program] （运行程序）对话框，使
用户可以在用户程序执行过程中输入 PC 或软
件断点。

Step In （跳入） F11 在暂停之前执行一个用户程序块。

Step Over （跳过） F10 在暂停之前执行一个用户程序块。如果到达子
程序调用，则不会进入子程序。

Step Out （跳出） Shift + 
F11

执行用户程序，直到到达当前函数的末尾。

Step... （单步执行…） 打开 [Step Program] （单步执行程序）对话
框，让用户可以修改单步执行的设置。

Step Mode
（步进模式）

Auto （自动） 当 [Editor] （编辑器）窗口处于活动状态时，仅
单步执行一个源代码行。当 [Disassembly]
（反汇编）窗口处于活动状态时，仅在汇编指
令单元中执行单步操作。

Assembly （汇编） 在汇编指令单元中执行单步操作。

Source （源代码） 仅单步执行一个源代码行。

Halt Program （暂停程序） Esc 停止用户程序的执行。

Connect （连接） 连接调试平台。

Initialize （初始化） 断开调试平台的连接，再重新连接它。

Disconnect （断开连接） 断开调试平台的连接。

Download Modules （下载模块） 下载目标程序。

Unload Modules （卸载模块） 卸载目标程序

表 A.1    仿真器的功能 （续）

Menu
（菜单） Option （选项）

Shortcut
（快捷

方式）

Toolbar 
Button

（工具栏

按钮） Remarks （说明）
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附录 B   命令行函数

仿真器支持可在命令行窗口中使用的命令。

有关详细信息，请参阅在线帮助。
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附录 C   关于 HEW 的说明

1. 关于在创建装入模块后移动源文件位置的说明

在创建装入模块后移动源文件时，可能会显示 [Open] （打开）对话框，用来指定调试创建的装入模

块时所用的源文件。选择对应的源文件，然后单击 [Open] （打开）按钮。

2. 源级执行

— 源文件

不显示与程序窗口中的装入模块不对应的源文件。如果某个文件与对应装入模块的源文件同名，

则仅将其地址显示在程序窗口中。不能在程序窗口中操作该文件。

— 单步执行

甚至会执行标准的 C 库。要返回到更高一级的函数，请使用 Step Out （跳出）。在 for 语句或 
while 语句中，执行单步指令不会使执行点移动到下一行。要移动到下一行，需执行两步。

3. 文件存取过程中的操作

下载装入模块、在 [Memory] （存储器）窗口中操作 [Verify Memory] （验证存储器）或 [Save Memory]
（保存存储器），或者在 [Trace] （跟踪）或 [Code Coverage] （代码覆盖率）窗口进行保存时，请不要

执行其他操作，否则无法执行正确的文件存取。

4. 监视

— 优化时的局部变量

在允许优化选项的情况下编译的 C 源文件中的局部变量可能不会正确显示，具体取决于所生成的

目标码。通过显示 [Disassembly] （反汇编）窗口来检查生成的目标码。

如果指定的局部变量的分配区不存在，将显示以下内容。

示例： 变量名称是 asc。

asc = ?  - target error 2010 (xxxx) （目标错误 2010 (xxxx)）

—  变量名称的指定

当指定变量名以外的名称 （如符号名称或函数名称）时，将不会显示任何数据。

示例： 函数名称是 main。

main = 

5. 行汇编

—  输入基数

无论基数设置如何，行汇编输入的默认基数都是十进制。将 H' 或 0x 指定为十六进制输入的基数。

6. 命令行界面

— 批处理文件

要在执行批处理文件时显示消息 “Not currently available”（当前不可用），请输入 sleep 命令。

根据操作环境调整睡眠时间长度。

示例： 在 memory_fill 执行过程中显示 “Not currently available”（当前不可用）：

sleep d'3000

memory_fill 0 ffff 0
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7. 通过命令指定文件

命令文件中指定的文件路径名可能会导致当前目录的更改。建议使用推荐用于在命令文件中指定文件

的绝对路径，以使当前目录不受影响。

示例： FILE_LOAD C:\HEW\Tools\Renesas\DebugComp\Platform\E200F

\Tutorial\Tutorial\Debug_SHxxxx_E200F_SYSTEM\tutorial.abs

8. 用户程序执行期间的存储器保存

在用户程序执行过程中不要执行存储器保存或验证。

9. 装入 Motorola S 类型的文件

本 HEW 不支持在每个记录的末尾只有 CR 代码 (H'0D) 的 Motorola S 类型的文件。只能装入在每个记

录的末尾有 CR 和 LF 代码 (H'0D0A) 的 Motorola S 类型的文件。

10. 关于程序执行过程中的 [Register] （寄存器）窗口操作的说明

在程序执行过程中，不能在 [Register] （寄存器）窗口中更改寄存器值。即使寄存器的实际内容有所

更改，也只是显示未更改前的值。

11. 断点功能

— 断点取消

在用户程序执行过程中修改断点地址的内容时，会在用户程序停止时显示以下信息：

BREAKPOINT IS DELETED A=xxxxxxxx （断点已删除 A=xxxxxxxx）
如果显示上述信息，请用 [Event] （事件）窗口中的 [Delete All] （全部删除）或 [Disable] （禁止）

按钮取消所有断点设置。

12. [Run...] （运行…）菜单中的断点和 [Stop At] （停止位置） 设置的数目

[Run...] （运行…）菜单中最多允许 1000 个断点和 [Stop At] （停止位置）设置。因此，设置 1000 个断

点后， [Run...] （运行）菜单中的 [Stop At] （停止位置）指定将变得无效。请确保 [Run...] （运行…）

菜单中的断点和 [Stop At] （停止位置）设置总共不超过 1000 个。

13. 关于 RUN-TIME （运行时间）显示的说明

显示在 [Status] （状态）窗口中的用户程序执行时间不是正确值，因为使用的是主机中的定时器。

14. 关于显示 Timeout error（超时错误）的说明

如果显示 Timeout error（超时错误），仿真器将无法与目标单片机通信。此时应将用户系统断

电，使用 HEW 再次连接仿真器的 USB 连接器。

15. 关于使用 [Run Program] （运行程序）对话框的说明

从 [Debug] （调试）菜单中选择 [Run...] （运行…）来指定停止地址时，有以下说明：

— 设置为 Disable （禁止）的断点被指定为停止地址时，请注意该断点在用户程序停止时将变为 
Enable （允许）。

16. SLEEP 指令的断点设置

当为 SLEEP 指令设置断点时，请使用断点条件 (Break Condition)，而不要使用断点。
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